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เคล็ดการเพิม่ผลงาน  
ลดความซบัซอ้นของงานดว้ย Excel VBA 

Excel VBA เป็นเครือ่งมอืสําคญัทีต่อ้งหาทางใชใ้หเ้ป็น เพราะ Excel VBA จะชว่ย

ควบคมุ Excel ใหทํ้างานเองตัง้แตต่น้จนจบไดอ้ยา่งรวดเร็วไมผ่ดิพลาดแมง้านนัน้ๆมี

หลายขัน้ตอนหรอืมลํีาดบัทีซ่บัซอ้น ทําใหม้นุษยเ์รามคีวามสขุในการทํางานมากขึน้ 

ชว่ยประหยดัเวลาทีเ่สยีไปกบัการน่ังอยูห่นา้จอคอมพวิเตอร ์ชว่ยเพิม่เวลาวา่งสําหรับใช ้

ชวีติสว่นตวั 

เมือ่ทราบประโยชนข์อง Excel VBA เชน่นีแ้ลว้ เราควรเรยีนรูห้าทางนํา Excel VBA มา

ใชอ้ยา่งเร็วทีส่ดุ ไมต่อ้งรอใหเ้กง่ Excel กอ่นก็ได ้ไมค่วรคดิวา่ Excel VBA เป็นเรือ่ง

ยากหรอืเป็นเครือ่งมอืขัน้สงูเก็บไวใ้หค้นทีเ่กง่ Excel หรอืตอ้งเป็นโปรแกรมเมอร์

เทา่นัน้ไวใ้ชก้นั 

อยา่งไรก็ตาม Excel VBA กลบักลายเป็นเครือ่งมอืทีใ่ชก้นันอ้ยมาก มกัตดิปัญหาตรง

ทีว่า่ ไมรู่จ้ะเริม่ตน้เรยีนรู ้Excel VBA กนัอยา่งไรด ีหนังสอืหนังหาทีเ่ป็นภาษาไทยก็มี

อยูแ่คไ่มก่ีเ่ลม่ ครัน้หยบิหนังสอืขึน้มาพลกิด ูพออา่นไดเ้พยีงไมก่ีห่นา้ก็ตอ้งปิดทิง้ รูส้กึ

หมดหวงั ยอมแพเ้พราะอา่นแลว้ไมรู่เ้รือ่ง รูส้กึวา่ Excel VBA ยากเหลอืเกนิ อะไรก็ไมรู่ ้

ทําไมตอ้งมรีหสัยากๆยาวๆเต็มไปหมด กวา่จะอา่นใหห้มดเลม่เราจะใชเ้วลาทีไ่หนมา

อา่นกนั เวลาทีม่อียูนั่น้ก็ตอ้งใชทํ้างานประจําเต็มวนัอยูแ่ลว้ แมรู้อ้ยูว่า่ Excel VBA 

สามารถชว่ยเพิม่เวลาวา่งใหช้วีติ แตต่อนนีเ้วลาทีม่อียูก่็เหลอืเวลาวา่งใหเ้รยีนรู ้Excel 

VBA ไดน้อ้ยเหลอืเกนิ 

เคล็ดการเพิม่ผลงาน ลดความซบัซอ้นของงานดว้ย Excel VBA เป็นเนือ้หาสัน้ๆ มุง่ให ้

คนทํางานซึง่ไมจํ่าเป็นตอ้งเป็นโปรแกรมเมอร ์สามารถใชเ้วลาวา่งทีม่อียูน่อ้ยนดินัน้ มา

เรยีนรูส้ ิง่ใหม่ๆ ทีจ่ะสรา้งประโยชนไ์ดคุ้ม้กบัคา่ของเวลาทีเ่สยีไป เคล็ดไมก่ีอ่ยา่งซึง่จะ

นํามาแนะนําตอ่ไปนัน้ จะชว่ยทําใหรู้ส้กึวา่ Excel VBA ไมใ่ชเ่รือ่งยากอกีตอ่ไป 

วธิใีช ้Excel VBA ในเคล็ดการเพิม่ผลงาน ลดความซบัซอ้นของงานดว้ย Excel VBA มี

หลายสว่นแตกตา่งจากทีท่ราบกนั หรอืแมแ้ตอ่าจถงึขัน้ขดัแยง้กบัวธิทีีย่ดึถอืกนัมา ก็

ตอ้งขอใหเ้ตรยีมตวัเตรยีมใจไวก้อ่น อะไรทีผู่อ้ ืน่บอกวา่สําคญั แตท่ีน่ีอ่าจเห็นวา่ไม่
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สําคญั ไมต่อ้งใชเ้ลยก็เป็นได ้เพราะถา้มวัใชเ้วลาไปกบัการเรยีนรู ้Excel VBA ทลีะขัน้ 

หรอืเสยีเวลาใสใ่จในทกุประเด็นตามแบบการเขยีนโปรแกรมทีด่ ีเห็นทงีานทีต่อ้งทําสง่

เจา้นายคงทําสง่ไมท่นัตามกําหนดเป็นแน่ 

VB vs VBA vs Excel VBA vs VBE vs Macro 

VB ยอ่มาจาก Visual Basic เป็นโปรแกรมหนึง่ซึง่ใชค้วบคมุการทํางานของ Windows 

VBA ยอ่มาจาก Visual Basic for Applications เป็นสว่นหนึง่ของ VB 

Excel VBA เป็นสว่นหนึง่ของ VBA ซึง่ใชก้บัโปรแกรม Microsoft Excel โดยเฉพาะ 

ถา้หนังสอืใชคํ้าวา่ VBA จะเป็นโปรแกรมทีใ่ชก้วา้งๆกบั Application ตา่งๆของ 

Microsoft Windows เชน่ Word, PowerPoint, Access, Excel ดงันัน้ถา้อยากหา

หนังสอื VBA มาศกึษาเพิม่เตมิ ตอ้งมคํีาวา่ Excel VBA เพือ่ใชเ้ฉพาะเจาะจงกบั Excel 

VBE เป็นตวัโปรแกรม Visual Basic Editor ซึง่ตดิมาใหใ้ชพ้รอ้มกบัโปรแกรม Excel 

เราใช ้VBE เป็นโปรแกรมสําหรับสรา้ง แกไ้ข และสามารถสัง่งานใหร้หสัคําสัง่ของ VBA 

ทํางาน 

Macro เป็นชือ่เกา่ใชก้นัมานานตัง้แตส่มยัโปรแกรม Lotus 1-2-3 และ Excel รุน่แรกๆ 

ซึง่ใช ้Macro เก็บรหสัคําสัง่ตามคําสัง่บนเมนู ซึง่พบวา่มขีอ้จํากดัอยูม่าก เพราะ Macro 

จะใชทํ้างานไดใ้นขอบเขตเทา่ทีม่คํีาสัง่บนเมนูใหใ้ชเ้ทา่นัน้ ตอ่มา Microsoft จงึ

ดดัแปลง VB เป็น VBA ใหส้ามารถทํางานไดม้ากกวา่ที ่Macro ทําได ้เชน่ การสัง่ให ้

Excel ทํางานทวนซํ้าหลายๆรอบ ตอ้งอาศยัคําสัง่ของ VBA 

โดยทัว่ไป Macro กบั VBA เป็นสิง่ทีส่รา้งผลงานไดเ้ชน่เดยีวกนั อาจถอืวา่ Macro เป็น

สว่นหนึง่ของ VBA ไปแลว้ก็ได ้ซึง่ในตวั Excel มคํีาสัง่เมนู Developer > Record  

Macro ทําหนา้ทีส่รา้งรหสั VBA บนัทกึตามลําดบัการสัง่งานจากเมาสแ์ละแป้นพมิพ ์

ในกรณีนีร้หสั Macro ทีไ่ดจ้ากการบนัทกึจงึกลายเป็นรหสั VBA น่ันเอง 

(เมนู Developer จะปรากฏใหเ้ห็นตอ่เมือ่สัง่ File > Options > Customize Ribbon 

แลว้กาเลอืกเมนูชือ่ Developer ใน Main Tab ทีแ่สดงดา้นขวาของจอ) 
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ขอ้ควรคาํนงึกอ่นใช ้Excel VBA 

ผูใ้ช ้Excel สว่นมากมกัคดิวา่ อะไรกต็าม ปัญหาใดก็ตามทีค่ดิไมอ่อก หาทางใช ้Excel 

แบบธรรมดาไมไ่ด ้ตอ้งใช ้Excel VBA ชว่ยหาคําตอบไดแ้น่ เชือ่กนัวา่ Excel VBA ตอ้ง

เป็นทางออกสดุทา้ย แตแ่ลว้พอใช ้Excel VBA ไดส้กัพัก กลบัพบวา่วธิกีารทีต่น

เลอืกใช ้กลายเป็นปัญหาตอ่เนือ่งไมรู่จ้บ ครัน้จะคดิถอยหลงั จะเลกิใช ้Excel VBA 

กลบัไปใชว้ธิกีารเหมอืนเดมิก็สายไปเสยีแลว้ ดงันัน้จงึขอใหคํ้านงึในประเด็นตอ่ไปนี้

กอ่นทีจ่ะคดิใช ้Excel VBA (จากนีไ้ปขอเรยีก Excel VBA ยอ่ๆวา่ VBA)  

รูจ้กั Excel ดพีอหรอืยงั 

กอ่นคดิจะหนัไปใช ้VBA เป็นเครือ่งมอืหาคําตอบวธิใีหม ่คณุควรรูจั้กตวัเครือ่งมอืทีม่ี

มากมายหลากหลายชนดิใหค้รบถว้นกอ่น ทัง้เครือ่งมอืทีเ่ป็นคําสัง่บนเมนู สตูรคํานวณ 

และวธิอีอกแบบตารางทีถ่กูตอ้ง โดยไมจํ่าเป็นตอ้งรูล้กึถงึขัน้ใชเ้ป็นทกุอยา่ง เพยีงแต่

ขอใหร้อบรูว้า่สิง่ที ่Excel มเีตรยีมไวใ้หใ้ชพ้รอ้มอยูแ่ลว้นัน้ สามารถนําไปใชก้บังาน

ประเภทใดไดบ้า้ง โดยเฉพาะคําสัง่บนเมนูประเภททีใ่ชทํ้างานไดอ้ตัโนมตั ิ

ขอ้ผดิพลาดทีพ่บเห็นเสมอ เกดิจากการขาดความรอบรูว้า่ Excel สามารถใชทํ้างาน

อะไรไดบ้า้ง ทําใหห้นัไปวุน่วายวางแผนใช ้VBA ซึง่กวา่จะสรา้งรหสั VBA ไดค้รบถว้น 

ก็ตอ้งลองผดิลองถกูเสยีเวลาและเหนือ่ยยากมใิชน่อ้ย โดยหารูไ้มว่า่แคค่ลกิเดยีวบน

เมนู หรอืแคจั่ดโครงสรา้งตารางใหมใ่หถ้กูตอ้ง ก็สามารถสรา้งงานทีต่อ้งการไดเ้ชน่กนั 

ขอใหพ้งึระลกึไวเ้สมอวา่ ถา้เป็นงานพืน้ๆทีเ่ป็นปัญหาประจําของทกุคน ทางบรษัิท 

Microsoft ไดจั้ดเตรยีมเครือ่งมอืใน Excel ไวเ้รยีบรอ้ยแลว้ โดยไมจํ่าเป็นตอ้ง

ขวนขวายไปใช ้VBA ใหเ้สยีเวลาหรอก เพยีงแตว่า่เราอาจตอ้งใชคํ้าสัง่บนเมนูหลาย

อยา่งนํามาใชร้ว่มกนัใหเ้ป็น  
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คุม้ไหม ใชซํ้า้บอ่ยไหม 

ในประเด็นเรือ่งคุม้นี ้ไมใ่ชแ่คคุ่ม้เรือ่งเงนิทอง ในแงป่ระโยชนท์ีส่ามารถประเมนิเป็นตวั

เงนิไดจ้ากงานทีใ่ช ้VBA เทา่นัน้ แตค่วรคํานึง่ถงึคา่เสยีเวลาของตวัคณุเองดว้ย ถา้ตอ้ง

ใชเ้วลาสกั 50 ชัว่โมง (สมมตวิา่ใชเ้วลาสรา้งงาน 25 วนั วนัละ 2 ชัว่โมง) แลว้คา่แรง

ของตวัคณุเองปาเขา้ไปชัว่โมงละ 1,000 บาท ดงันัน้แฟ้มงานทีใ่ช ้VBA ยอ่มมตีน้ทนุ

ถงึ 50,000 บาททเีดยีว จากนัน้ยงัตอ้งคอยกลบัมาเสยีเวลานับปีในการปรับปรงุแกไ้ข 

ซึง่ยอ่มตกีลบัเป็นตน้ทนุเพิม่เขา้ไปไดอ้กี บางแฟ้มกวา่จะเสร็จสมบรูณ์อาจมคีา่ทีน่กึไม่

ถงึสงูเป็นแสนเป็นลา้นบาท  

สิง่ทีนํ่ามาเปรยีบเทยีบกบัตน้ทนุทีเ่สยีไป ไดแ้ก ่ระบบงานงา่ยขึน้ ชว่ยลดความซบัซอ้น 

ลดความซํ้าซอ้น ลดโอกาสทีจ่ะเกดิขอ้ผดิพลาดไดไ้หม ถา้ตอ้งทํางานนัน้ซํ้าแลว้ซํ้าอกี 

จะชว่ยประหยดัเวลาทํางานไดว้นัละกีช่ัว่โมง ชว่ยลดความกงัวล ความเครยีด ความ

หว่งใย ความกลวัวา่ งานทีส่รา้งขึน้จะหมดขอ้ผดิพลาด สามารถสง่งานไดท้นักําหนด

แน่นอนหรอืไม ่ 

มเีวลาไหม ตามเทคโนโลยทีนัหรอืไม ่ 

กวา่จะเริม่ใช ้VBA เป็น คณุตอ้งลงทนุลงแรงเสยีเวลาอา่นหนังสอื แบง่เวลาทํางานมา

เขา้อบรม แตเ่วลาทีเ่สยีไปนีเ้ป็นเพยีงชว่ยใหค้ณุเริม่รูจั้กวา่ VBA เป็นอยา่งไร มี

ประโยชนอ์ยา่งไรไดเ้ทา่นัน้ ถา้อยากใช ้VBA ใหเ้ป็นชนดิทีเ่รยีกตนเองวา่ 

โปรแกรมเมอร ์จะตอ้งเสยีเวลาใหก้บั VBA อกีมากมาย เพราะยงัมหีนังสอืเลม่หนาให ้

อา่นอกีเป็นตัง้ ดงันัน้หากคณุมเีวลาเพยีงนอ้ยนดิในแตล่ะวนัใหก้บั VBA ก็ขอใหต้ัง้หลกั

ไวว้า่ รอใหเ้กดิปัญหาขึน้กอ่นเถอะแลว้คอ่ยนกึถงึ VBA ประเภททําไปแกไ้ขไปทลีะเล็ก

ทลีะนอ้ย ไมจํ่าเป็นตอ้งเสร็จแบบสมบรูณ์เพยีบพรอ้ม หรอืใชร้หสัทีส่ัน้กะทดัรัดทีส่ดุ 

หรอืจําเป็นตอ้งเสยีเวลาไปกบัการหาทางทําใหร้หัส VBA ทํางานเร็วทีส่ดุ  

นอกจากนัน้แมว้า่ตวัรหสั VBA ในวนันีส้ว่นใหญเ่ป็นตวัรหสัทีใ่ชก้นัมาตัง้แตต่น้ แตท่กุ

ครัง้ทีม่ ีExcel รุน่ใหม ่จะพบวา่มรีหสัใหมเ่พิม่ขึน้เสมอ บางครัง้ยงัปรับเปลีย่นวธิใีชร้หสั

หนึง่ๆตา่งไปจากเดมิ ซึง่ถอืเป็นหนา้ทีข่องผูใ้ช ้VBA จะตอ้งคอยตดิตามขา่วคราวการ

ปรับปรงุใหท้ันยคุทนัสมยั แลว้กลบัไปแกไ้ขรหสัเกา่ๆใหใ้ชทํ้างานตอ่ไปไดต้ลอด  
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มคีนแทนหรอืไม ่

จะไมเ่ป็นปัญหาเลยถา้งานทีค่ณุทํานัน้ไมเ่กีย่วขอ้งกบัคนอืน่ คณุจะหยดุหรอืคณุจะ

ลาออกไป ไมก่ระทบกบัระบบงานสว่นรวม แตถ่า้เกีย่วขอ้งกบังานสว่นรวม ยอ่มเกดิ

ปัญหาตอ่เนือ่งรา้ยแรงอยา่งมากตอ่บรษัิท 

ลองนกึดวูา่ ถา้แฟ้มงานทีใ่ช ้VBA ชว่ยนัน้เกดิไมทํ่างานตามเดมิขึน้มา แตไ่มส่ามารถ

หาใครมาชว่ยแกไ้ขไดท้นัเวลา ผูใ้ชง้านทีต่ดินสิยัทํางานแบบสบาย พอเปิดแฟ้มขึน้

มาแลว้กดปุ่ มเดยีวสัง่ให ้Excel ทํางานแบบอตัโนมตั ิกลบัพบวา่แฟ้มไมทํ่างานเอง

แบบเดมิเสยีแลว้ งานจะหยดุเดนิ ครัน้จะหนักลบัไปใชร้ะบบงานแบบเดมิก็ลมืกนัไป

หมดแลว้  

ผูบ้รหิารหรอืหวัหนา้ควรคํานงึถงึประเด็นตวัตายตวัแทนนีใ้หด้ ีกอ่นทีจ่ะยอมใหพ้นักงาน

หรอืลกูนอ้งคนใดใช ้VBA จะตอ้งหาตวัแทนเขา้ไปประกบ รว่มสรา้งงาน ยิง่ถา้งานใดมี

ความสําคญัตอ่ความอยูร่อดของบรษัิท จําตอ้งกําหนดใหเ้ขยีนคูม่อือธบิายรหสัทกุขัน้ที่

ใชไ้วเ้สมอ  

ระบบเร ิม่ตายตวั รูจ้กัปญัหาครบถว้นหรอืยงั 

ตวัโครงสรา้งของรหสั VBA และตวัรหสั VBA จะถกูแกไ้ขเปลีย่นแปลงไดโ้ดยมนุษยเ์ขา้

ไปเขยีนแกไ้ขใน VBE เทา่นัน้ ตวัรหสั VBA โดยทั่วไปไมส่ามารถปรับเปลีย่นตาม

โครงสรา้งตารางในชทีทีเ่ปลีย่นไป ดังนัน้กอ่นทีจ่ะคดิใช ้VBA ควรรอจนกวา่ระบบงาน

ตายตวั ชดัเจน และไมม่ปัีญหาใหมเ่กดิขึน้ตามมาอกี แลว้หาทางใชร้หสัทีไ่มต่อ้งแกไ้ข

อกีเลย เพราะหากตอ้งยอ้นกลบัไปแกไ้ขรหสัทีเ่ขยีนไวเ้มือ่ปีกอ่น คงยากทีใ่ครจะจําได ้

วา่ จะตอ้งกลบัไปแกไ้ขอะไรทีส่ว่นไหนของรหสันับรอ้ยนับพันบรรทดั 

จงจําไวว้า่ สกัวนัหนึง่คณุจะจํารหสั VBA ทีเ่ขยีนไวไ้มไ่ด ้ดงันัน้ขอใหแ้ยกรหสัออกเป็น

ชดุยอ่ยๆและใชส้ัง่ใหทํ้างานเพยีงขัน้เดยีว หรอืเป็นชดุคําสัง่ทีใ่ชค้วบคมุการทํางาน

เพยีงระบบเดยีวทีเ่กีย่วขอ้งกนัชดัเจนเทา่นัน้ เพือ่ชว่ยทําใหย้อ้นกลบัไปแกไ้ขไดง้า่ย 

และถา้เกดิขอ้ผดิพลาดขึน้มา ยอ่มถกูจํากดัใหส้ง่ผลกระทบกบัระบบงานหนึง่ๆเทา่นัน้  
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หมดทางอืน่แลว้หรอืยงั 

หากคณุคดิแลว้วา่ ยงัไงๆก็ตอ้งหาทางใช ้VBA ใหไ้ด ้ทัง้ๆทีต่วัเองไมไ่ดเ้กง่ Excel 

เทา่ใดนัก หน่วยงานก็เล็กๆ ไมม่ตีวัตายตวัแทนอยา่งทีเ่ตอืนไวข้า้งตน้นัน้หรอก ปัญหา

ก็ยงัไมแ่น่ไมน่อน อาจเกดิปัญหาตอ้งจัดระบบใหมอ่กีเมือ่ใดก็ได ้แตจ่ะขอใช ้VBA เพือ่

ชว่ยลดขัน้ตอนของงานลงบา้ง สิง่ใดทีต่อ้งทําซํ้าแลว้ซํ้าอกีจะไดใ้ช ้VBA ควบคมุให ้

ทํางานเองตัง้แตต่น้จนจบ หากคดิวา่หมดทางออกอืน่ๆแลว้ ก็ขอใหใ้ช ้VBA กนัอยา่ง

ฉลาด รหสัใดทีย่ากนักใหต้ดัทิง้ รหสัใดไมจํ่าเป็น ก็ไมต่อ้งใช ้เพือ่ทําใหง้า่ยตอ่การ

แกไ้ขในภายหลงั  

 

ขอ้พสิจูนว์า่ VBA ใชง้านไดจ้รงิ 

รหสั VBA จะใชง้านไดจ้รงิ ใชว่า่ขึน้กบัวา่คณุไดท้ดสอบแลว้วา่สามารถสัง่ใหร้หสั

ทํางานไดโ้ดยไมม่ปัีญหาเทา่นัน้ หากยงัตอ้งทดสอบโดยทดลองเปิดแฟ้มบนเครือ่ง

คอมพวิเตอรเ์ครือ่งอืน่และใชง้านโดยผูอ้ืน่ซึง่ไมเ่กีย่วขอ้งกบัการสรา้งรหสัอกีดว้ย 

ทดลองแกไ้ขตําแหน่งตาราง เปลีย่นชือ่ชทีหรอืชือ่แฟ้มใหต้า่งไปจากเดมิ หากรหสั

สามารถทํางานไดป้กตจิงึจะถอืวา่ใชง้านไดจ้รงิ 
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อยากเกง่ VBA..ตามประสาคนไมม่เีวลา.. 
จะเร ิม่อยา่งไร 

ขอ้จํากดัเรือ่งเวลาเป็นสิง่สําคญัทีส่ดุของคนทีวุ่น่อยูก่บังาน ทํางานตัง้แตเ่ชา้จนเย็นเลย

ไปจนถงึคํา่ กลบับา้นแลว้ยงัเอางานตดิตวักลบัไปทําตอ่เสยีอกี ไหนจะตอ้งแบง่เวลาไป

ประชมุในตอนกลางวนั เขยีนรายงานในตอนกลางคนื นานๆทีจ่ะไดใ้ชเ้วลาชว่งเสาร์

อาทติยไ์ปเทีย่วพักผอ่นกบัครอบครัว โอกาสทีจ่ะไดเ้รยีนรูส้ ิง่ใหม่ๆ มนีอ้ยมาก จะมชีว่ง

ทีไ่ดไ้ปฝึกอบรมน่ันแหละทีไ่ดเ้ปิดหเูปิดตากบัเขาบา้ง เรือ่งทีว่า่ใหอ้า่นหนังสอืตํารา

วธิใีช ้VBA เลม่โตตัง้แตห่นา้แรกจนหนา้สดุทา้ย ... เมนิเสยีเถอะ ...ไมม่เีวลา  

ปัญหาประเภทนีเ้ป็นปัญหาเหมอืนถามวา่ ไกก่บัไขอ่ะไรเกดิกอ่นกนั เพราะทีว่า่ไมม่ี

เวลาเรยีนรู ้VBA นัน้ เนือ่งจากทํางานจนหมดเวลาอยูแ่ลว้ แตถ่า้อยากมเีวลาเหลอื

เพิม่เตมิละ่ ตอ้งหาเวลาใช ้VBA ใหเ้ป็น ถา้ใช ้VBA เป็น งานจะเสร็จเร็วขึน้ ทําใหม้ี

เวลาวา่งไปทําอยา่งอืน่ ตดิอยูต่รงทีว่า่ตอนนีไ้มม่เีวลาเหลอื จะเริม่ตน้หาทางเกง่ VBA 

ไดอ้ยา่งไร  

ตนเป็นทีพ่ ึง่แหง่ตน 

จดุเริม่ตน้กอ่นทีจ่ะเกง่ VBA ได ้ตอ้งขึน้กบัตวัคณุเองตอ้งชว่ยตวัเองใหเ้ป็นกอ่น อยา่

คดิพึง่คนอืน่ใหย้กรหสั VBA มาใหค้ณุใช ้เพราะหากวนัหนึง่รหสั VBA นัน้เกดิหยดุไม่

ทํางานไดเ้ชน่เคย แลว้คณุหาทางแกไ้ขเองไมเ่ป็น คณุจะตอ้งกลบัไปงอ้ขอรอ้งใหค้น

อืน่ชว่ยแกไ้ขใหเ้รือ่ยไป 

ขอใหต้ัง้ใจสรา้งงานขึน้ดว้ยฝีมอืของตนเอง ไดแ้คไ่หนก็แคนั่น้ แคห่าทางทําให ้Excel 

ทํางานไดเ้ร็วกวา่เดมิก็ชืน่ใจแลว้ ถา้ทําไดเ้อง คณุจะเกดิความภาคภมูใิจ เกดิความ

มัน่ใจ แลว้จะหาทางพัฒนาฝีมอืตอ่ไปไดเ้อง 

เร ิม่จากงา่ยไปยาก 

กวา่จะหาทางทําให ้VBA ทํางานไดอ้ตัโนมตัดิงัใจ ไมใ่ชเ่รือ่งงา่ย ไมเ่หมอืนการใช ้

คําสัง่บนเมนูของ Excel ทีค่ลกิแลว้ก็จะทํางานไดท้นัท ีเนือ่งจากรหสั VBA ไมส่ามารถ
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เกดิขึน้ไดเ้อง แตต่อ้งอาศยัฝีมอืของคนสรา้งรหสั VBA ขึน้มาใช ้ซึง่ตวัรหสัอาจเกดิจาก

การใช ้Macro Recorder หรอืตอ้งเขยีนเอง 

ในชว่งเริม่ตน้ ขอแนะนําใหเ้รยีนรู ้VBA จากการใช ้Macro Recorder ชว่ยสรา้งรหสั 

VBA ขึน้มา แลว้เรยีนรูร้หสัคําสัง่ตา่งๆทีเ่กดิขึน้ โดยเริม่จากการใช ้Macro Recorder 

บนัทกึขัน้ตอนการทํางานงา่ยๆสัน้ๆขึน้มาแกะรหสั พอเริม่คุน้เคยและเห็นวา่รหสัสามารถ

ทํางานไดด้ังใจแลว้ จงึคอ่ยๆเขา้ไปแกไ้ขดดัแปลงรหสัใหต้า่งไปจากเดมิ ลองผดิลอง

ถกู ถา้ทําผดิก็ขอใหจํ้าไวว้า่ผดิเพราะอะไร แมร้หสั VBA ทีด่ดัแปลง จะทํางานตา่งจาก

ทีค่ดิไว ้ขอใหถ้อืเป็นบทเรยีนเพือ่จําไวเ้สมอ เพราะเราสามารถนํารหสันัน้กลบัมาใชใ้น

ตา่งวาระตา่งวตัถปุระสงค ์ซึง่ยอ่มเกดิประโยชนไ์ดเ้ชน่กนั 

อยา่ใจรอ้นสรา้งรหสัยาวๆ หรอืพถิพีถินักบัตวัโครงสรา้งรหสัใหต้รงกบัหลกัทีกํ่าหนดไว ้

ในหนังสอื แตข่อใหมุ้ง่สรา้งรหสัสัน้ๆทีส่ามารถทํางานเสร็จทนัเวลาตามตอ้งการใหไ้ด ้

กอ่น สว่นตวัโครงสรา้งรหสัยงัไมส่มบรูณ์นักก็อยา่งเพิง่ใสใ่จ 

เรยีนรูจ้าก VBA Help 

ทราบไหมวา่ หนังสอื VBA ทีเ่ห็นวางขายกนัเกลือ่นนัน้ มนีอ้ยเลม่ทีเ่ขยีนเองทกุ

ตวัอกัษร หนังสอืสว่นใหญใ่ชข้อ้มลูทีล่อกมาจาก VBA Help ซึง่ตดิมากบัโปรแกรม 

Microsoft Office แลว้นํามาดดัแปลงแกไ้ขขอ้ความ จัดเรยีงบทใหม ่แกต้วัอยา่งไมใ่ห ้

ซํา้กบั VBA Help 

ถา้อยากอา่น VBA Help ใหเ้ปิด Excel ขึน้มากอ่น จากนัน้กดปุ่ ม ALT+F11 หรอืใช ้

คําสัง่เมนู Developer > Visual Basic เพือ่เปิดโปรแกรม VBE ขึน้มา แลว้กดปุ่ ม 

F1 หรอืใชเ้มนู Help ขึน้มาศกึษา ซึง่ถา้สงสยัรหสัตวัใดก็ใหค้ลกิทีร่หสัตวัทีเ่ขยีนไว ้

นัน้ แลว้กดปุ่ ม F1 จะเปิด Help เฉพาะเรือ่งรหสันัน้ขึน้มาใหเ้ห็นโดยตรง 

นอกจากนีเ้รายงัสามารถคน้หาแฟ้ม Help ทีม่นีามสกลุ .chm โดยไมต่อ้งเปิดผา่น VBE 

ทัง้นีต้อ้งตดิตัง้ Office แบบสมบรูณ์กอ่นจงึจะพบแฟ้มดงักลา่ว ใหด้บัเบลิคลกิทีช่ ือ่

แฟ้มเพือ่เปิด Help  
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ซือ้หนงัสอืเก็บไวห้ลายเลม่ หรอืคน้หาจากเว็บ  

เนือ่งจากใน VBA Help มรีายละเอยีดเฉพาะงานทัว่ไป ไมไ่ดแ้สดงรหสัทีจํ่าเป็นตอ้ง

นํามาใชร้ว่มกนัในงานเฉพาะดา้น จงึแนะนําใหห้าซือ้หนังสอื Excel VBA เก็บไวห้ลายๆ

เลม่ หรอืใช ้Google คน้หาคําตอบยามทีต่อ้งการหรอืตดิปัญหา 

ควรเลอืกซือ้หนังสอืทีม่สีารบญั และดชันเีรือ่งทา้ยเลม่ อยา่งละเอยีดเพือ่สะดวกในการ

คน้หา หนังสอืบางเลม่จะขายพรอ้มกบัแผน่ CD เก็บรหสั VBA ทีใ่ชใ้นหนังสอื ชว่ยให ้

เราสามารถลอกรหสัมาใชไ้ดเ้ลยโดยไมต่อ้งเสยีเวลาเขยีนเอง  

ทีแ่นะนําใหซ้ือ้หนังสอืไวห้ลายๆเลม่นี ้ไมไ่ดใ้หซ้ือ้มาเพือ่มาเสยีเวลาเปิดอา่นทกุหนา้ 

ไมต่อ้งการใหจ้ดใหจํ้า แตใ่หม้หีนังสอืเก็บไวใ้ชค้น้หาคําตอบทีต่อ้งการ 

หากมขีอ้สงสยัอยากถามปัญหา สําหรับเว็บ Excel ภาษาไทย ไปที ่

www.XLSiam.com หรอื www.ExcelExpertTraining.com สําหรับภาษาองักฤษ ไปที ่

www.MrExcel.com 

เร ิม่ทดลอง อยา่รอชา้ 

คนจะเกง่ Excel หรอืเกง่ VBA ได ้ตอ้งลองผดิลองถกูมาเยอะ อยา่มวักลา้ๆกลวัๆให ้

เสยีเวลา ขอใหท้ดลองใช ้Macro Recorder ทดลองแกไ้ขรหสั ทดลองเขยีนรหสัดว้ย

ตนเอง ขอใหถ้อืวา่ ผดิเป็นคร ูเมือ่ทําผดิไปแลว้ จะรูว้า่ทําอยา่งนัน้อยา่งนีไ้มไ่ด ้ตอ่ไป

ยอ่มไมม่ทีางทําผดิเชน่นัน้อกี  

พอเริม่รูจั้กวา่ตอ้งระวงัอะไรบา้ง เริม่รูจั้กโครงสรา้งพืน้ฐานของชดุรหสัคําสัง่ พอใชง้าน

ไดโ้ดยไมลํ่าบากแลว้ จากนัน้ใหท้ดลองลอกรหสัของคนอืน่มาใชด้บูา้ง ใหเ้ปรยีบเทยีบ

กบัรหสัทีค่ณุเขยีนขึน้มาเอง วเิคราะหข์อ้ดขีอ้เสยี เรยีนรูว้า่รหสัแบบใดเหมาะกบัการใช ้

งานแบบใด 

ขอใหล้อกเก็บชดุรหสัทีท่ดลองวา่ใชง้านไดแ้ลว้เก็บไวใ้ช ้ในอนาคตจะไดไ้มต่อ้ง

เสยีเวลาพมิพเ์ขยีนรหสัมาใชเ้องทลีะตวั เพราะถา้ทกุครัง้ตอ้งยอ้นกลบัมาเริม่ตน้พมิพ์
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เอง ก็ตอ้งเสีย่งทกุครัง้อกีน่ันแหละวา่ รหสัทีเ่พิง่เขยีนเหลา่นัน้สามารถใชทํ้างานได ้

ถกูตอ้งหรอืไม ่ 
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ข ัน้ตอนสรา้งรหสั VBA โดยใช ้Macro Recorder 

สมมตวิา่ คณุตอ้งการจัดขนาดตวัอกัษรใหก้บัชือ่บรษัิททีบ่นัทกึลงในเซลล ์A1 เพือ่ใช ้

พมิพเ์ป็นหวักระดาษ ซึง่ถกูบงัคบัวา่ ตอ้งใชต้วัอกัษรขนาด 20 pixel เป็นมาตรฐาน

เสมอ เพือ่ชว่ยใหเ้วลาดบูนหนา้จอ หรอืเมือ่พมิพล์งกระดาษแลว้ จะเห็นชือ่บรษัิทมี

ขนาดเดยีวกนัไปตลอด 

คณุอาจเลอืกใช ้Macro Recorder หรอืจะเลอืกเขยีนรหสั VBA เองก็ได ้แตใ่นชว่งเริม่

เรยีนรูน้ี ้แนะนําใหใ้ช ้Macro Recorder จะชว่ยทําใหง้านนีง้า่ยขึน้ เพยีงเริม่จากคลกิ

เซลลช์ือ่บรษัิท แลว้สัง่ Developer > Record Macro  

 

ในชอ่ง Macro name ใหพ้มิพช์ือ่ซึง่สือ่ถงึงานทีต่อ้งการลงไป เชน่ คราวนีต้อ้งการ

บนัทกึการเปลีย่นขนาดตวัอกัษร จงึใชช้ือ่ Macro วา่ ChangeFontSize (ชือ่ Macro 

ใหใ้ชต้วัอกัษรตวัใหญผ่สมตวัเล็ก ไมเ่วน้ชอ่งวา่งระหวา่งตวัอกัษร ถา้ตอ้งการใชต้วัเลข 

ใหใ้สต่วัเลขตอ่ทา้ยตวัอกัษร) 

ในชอ่ง Shotcut key ใหพ้มิพต์วั q ลงไป เพือ่กําหนดวา่ เมือ่กดปุ่ ม Ctrl+q เป็นการ

สัง่ให ้Macro ทํางานซํ้า ซึง่ในตวัอยา่งนีเ้ป็นการสัง่ใหเ้ปลีย่นขนาดเป็น 20 pixel (จะ

ใชต้วัอกัษรตวัใดเป็น Shortcut key ก็ได ้แตไ่มค่วรใชต้วั c, x, v ซึง่ซํ้ากบัคําสัง่ในการ 

Copy, Cut, หรอื Paste เพราะ Shortcut key ทีกํ่าหนดลงไปจะทํางานแทนหนา้ที่

เดมิ) 
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จากนัน้กดปุ่ ม OK ซึง่จะพบวา่ เมนู Record Macro เปลีย่นคําแสดงเป็นปุ่ มคําสัง่ Stop 

Recording รอไวแ้ละดา้นลา่งซา้ยของจอจะมปีุ่ มสีเ่หลีย่มเตอืนใหท้ราบวา่ ขณะนี้

กําลงับนัทกึ Macro อยู ่และสามารถคลกิทีปุ่่ มนีเ้พือ่สัง่หยดุการบนัทกึ Macro 

 

พอถงึขัน้ระหวา่งการบนัทกึ Macro นีต้อ้งทําขัน้ตอนตอ่ไปอยา่งระมดัระวงั เพราะ 

Excel จะบนัทกึและสรา้งรหสั VBA ตามทีค่ณุใชเ้มาสห์รอืแป้นพมิพ ์ซึง่ถา้คลกิ

ผดิพลาดหรอืพมิพอ์ะไรผดิ จะสง่ผลใหเ้กดิรหสั VBA ทํางานตามทีผ่ดินัน้ดว้ย  

ในขัน้นีใ้หค้ลกิทีช่อ่งปรับขนาดตวัอกัษรแลว้เปลีย่นขนาดเป็น 20 จากนัน้ใหก้ดปุ่ ม 

Stop Recording แลว้จะเห็นวา่เมนูนีปิ้ดไป พรอ้มกบัไมม่ปีุ่ มสีเ่หลีย่มทีเ่คยแสดง

ดา้นลา่งซา้ยของจออกีตอ่ไป แสดงวา่ไดทํ้าการบนัทกึเสร็จเรยีบรอ้ยแลว้ 

จากนัน้เมือ่ตอ้งการปรับขนาดตวัอกัษรทีเ่ซลลใ์ด ใหค้ลกิทีเ่ซลลนั์น้ ตามดว้ยกดปุ่ ม 

Ctrl+q จะพบวา่ ขนาดตวัอกัษรถกูเปลีย่นเป็น 20 pixel ใหท้นัท ี

รหสั VBA ทีเ่กดิขึน้จะเก็บอยูภ่ายในตวัแฟ้มนัน้เอง เพยีงแตย่งัซอ่นไว ้จนกวา่จะกดปุ่ ม 

ALT+F11 หรอืสัง่ Developer > Visual Basic เพือ่เปิด VBE ขึน้มา จะพบวา่ 

รหสัถกูบนัทกึไวใ้นชทีชือ่ Module1 
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รหสั VBA ทีไ่ดจ้าการใช ้Macro Recorder เรยีกไดว้า่เป็นรหสั Macro และมกัพบวา่

รหสั Macro มโีครงสรา้งยาวกวา่ทีจํ่าเป็นอยูเ่สมอ ซึง่ในตวัอยา่งนีต้อ้งการบนัทกึเพยีง

ปรับขนาดตวัอกัษร แต ่Macro Recorder จะบนัทกึคา่ Default เดมิทัง้หมดตามไปดว้ย 

ถา้คณุแกไ้ขรหสั VBA เป็นจะสามารถแกไ้ขรหสัใหส้ัน้ลง จากโครงสรา้งชดุคําสัง่เดมิ 

Sub ChangeFontSize() 

' 

' ChangeFontSize Macro 

' Macro recorded 14/2/2012 by Somkiat Foongkiat  

'  

' Keyboard Shortcut: Ctrl+q  

'  

    With Selection.Font  

        .Name = "Tahoma"  

        .Size = 20  

        .Strikethrough = False  

        .Superscript = False  

        .Subscript = False  

        .OutlineFont = False  

        .Shadow = False  

        .Underline = xlUnderlineStyleNone  

         .ColorIndex = xlAutomatic  
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    End With  

End Sub  

ชดุรหสัใหมซ่ึง่แกไ้ขใหเ้หลอืเทา่ทีจํ่าเป็น 

Sub ChangeFontSize() 

    Selection.Font.Size = 20  

End Sub  

ทกุคนทีม่โีปรแกรม Microsoft Office จะสามารถเรยีกใชโ้ปรแกรม Visual Basic 

Editor (VBE) ไดโ้ดยไมจํ่าเป็นตอ้งซือ้มาตดิตัง้เพิม่เตมิ เราใช ้VBE สําหรับเปิดดรูหสั

หรอืเขยีนแกไ้ขรหสั หรอืถา้ใช ้Macro Recorder เป็นเครือ่งมอืบนัทกึขัน้ตอนการ

ทํางาน ตวั Recorder จะชว่ยสรา้งรหสั VBA ลงใน VBE ใหเ้องโดยทีเ่ราไมต่อ้งสนใจ

วา่ VBE นีห่นา้ตาเป็นยงัไงก็ยงัได ้

สิง่สําคญักอ่นทีจ่ะเปิดแฟ้มทีม่ ีMacro หรอื VBA เราจะตอ้งสัง่จัดเก็บแฟ้มทีม่รีหสั VBA 

โดยกําหนดใหใ้ชน้ามสกลุ xlsm หรอื xls และเมือ่เปิดแฟ้มขึน้มา ตอ้งกดปุ่ ม Enable 

เพือ่ยอมให ้Macro ทํางาน 

 

หากไมม่คํีาเตอืนดงักลา่ว ใหต้รวจสอบวา่คําสัง่ File > Excel Options > Trust 

Center > Trust Center Settings > Macro Settings > กาชอ่ง Disable 

all macro with notifications นีไ้วเ้ป็น default อยูก่อ่นแลว้หรอืไม ่
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โครงสรา้งชุดคาํส ัง่ VBA 

ชดุคําสัง่หรอืชดุรหสั VBA มาจากคําวา่ Procedure ซึง่ชดุคําสัง่แตล่ะชดุประกอบดว้ย

คําสัง่หลายบรรทดั แตล่ะบรรทดัมรีหสั VBA เพือ่สัง่ให ้Excel ทํางานทลีะขัน้ 

โดยทัว่ไปเราควรแยกใหช้ดุคําสัง่หนึง่ๆ ใหใ้ชค้วบคมุการทํางานทีเ่กีย่วขอ้งกนัชดัเจน 

ชดุคําสัง่ VBA ม ี2 ประเภท คอื 

1. Sub Procedure เป็นชดุคําสัง่ทําหนา้ทีค่วบคมุการทํางานทั่วไปของ 

Excel  

2. Function Procedure เป็นชดุคําสัง่ทําหนา้ทีคํ่านวณคนืคา่ผลลพัธ ์ใช ้

สําหรับสรา้งสตูรใหมม่าใชก้บังานเฉพาะดา้น นอกเหนอืจากสตูรสําเร็จรปู

ที ่Excel จัดเตรยีมไวใ้ห ้ 

ลกัษณะโดยทัว่ไปของชดุคําสัง่แตล่ะชดุ ถา้เป็น Sub Procedure จะอยูใ่นชว่งรหสั

ตัง้แตว่า่ Sub จนถงึคําวา่ End Sub สว่น Function Procedure ชดุหนึง่ๆ จะอยูใ่นชว่ง

รหสัตัง้แตว่า่ Function จนถงึคําวา่ End Function (ซึง่ชดุคําสัง่ที ่Macro Recorder 

สรา้งขึน้ จะเป็นชดุคําสัง่แบบ Sub Procedure เทา่นัน้) 

หมายเหต ุยงัมชีดุคําสัง่ประเภท Class Procedure ซึง่ยากเกนิกวา่จะนํามาอธบิายใน

ทีน่ี ้ 

โครงสรา้งชุดคาํส ัง่แบบ Sub Procedure 

Sub ชือ่ชดุคําสัง่() 

    'comment 

    รหสัคําสัง่แตล่ะบรรทัด 

    รหสัคําสัง่แตล่ะบรรทัด 

    รหสัคําสัง่แตล่ะบรรทัด 

End Sub 
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ลองเปรยีบเทยีบชดุคําสัง่ทีไ่ดจ้าก Macro Recorder ทีใ่ชเ้ปลีย่นขนาดตวัอกัษรเป็น 

20 pixel ดงันี ้

Sub ChangeFontSize() 

' 

' ChangeFontSize Macro 

' Macro recorded 14/2/2012 by Somkiat Foongkiat  

'  

' Keyboard Shortcut: Ctrl+q  

'  

    With Selection.Font  

        .Name = "Tahoma"  

        .Size = 20  

        .Strikethrough = False  

        .Superscript = False  

        .Subscript = False  

        .OutlineFont = False  

        .Shadow = False  

        .Underline = xlUnderlineStyleNone  

         .ColorIndex = xlAutomatic  

    End With  

End Sub 

สว่นทีร่ะบวุา่เป็นชุดคาํส ัง่ 

Sub ChangeFontSize() 

    xxxxxxxxxxxxxxx 

End Sub 

คําวา่ ChangeFontSize เป็นชือ่ของชดุคําสัง่นี ้ตอ้งตามดว้ยเครือ่งหมาย () เสมอ 

สว่นทีเ่ป็น Comment 

' 

' ChangeFontSize Macro 
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' Macro recorded 14/2/2012 by Somkiat Foongkiat  

'  

' Keyboard Shortcut: Ctrl+q  

'  

Comment เป็นบรรทดัทีไ่มไ่ดเ้กีย่วขอ้งกบัการทํางาน ใชสํ้าหรับบนัทกึคําอธบิาย

สือ่สารกบัมนุษย ์มกัใชเ้ขยีนคําอธบิายหนา้ทีข่องรหสั เพยีงพมิพเ์ครือ่งหมายฝนทอง ' 

นําหนา้ แลว้ตามดว้ยคําอธบิายทีต่อ้งการ  

แทนทีจ่ะลบรหสัทิง้ เราสามารถสัง่ใหร้หสับรรทดันัน้ไมทํ่างาน โดยพมิพเ์ครือ่งหมาย

ฝนทองนําหนา้บรรทดันัน้ หรอืถา้ตอ้งการสัง่หยดุรหสับางสว่นในบรรทดัใหห้ยดุทํางาน 

ใหพ้มิพเ์ครือ่งหมายฝนทอง นําหนา้สว่นของรหสัทีต่อ้งการหยดุทํางาน โดย VBA จะ

ถอืวา่เมือ่พบเครือ่งหมายฝนทอง จะแสดงวา่ ตัง้แตเ่ครือ่งหมายฝนทองนัน้ไปจนสดุ

บรรทดั ถอืเป็น Comment ไมต่อ้งนํามาเกีย่วขอ้งกบัการทํางาน 

สว่นของรหสั VBA 

    With Selection.Font  

        .Name = "Tahoma"  

        .Size = 20  

        .Strikethrough = False  

        .Superscript = False  

        .Subscript = False  

        .OutlineFont = False  

        .Shadow = False  

        .Underline = xlUnderlineStyleNone  

         .ColorIndex = xlAutomatic  

    End With 

สงัเกตวา่ ดา้นซา้ยของรหสัจะถกูยอ่หนา้ไว ้เพือ่ชว่ยใหม้นุษยอ์า่นงา่ยขึน้ และมี

เครือ่งหมายจดุ . แทรกอยูแ่ทบทกุบรรทดั โดย VBA จะใชเ้ครือ่งหมายจดุนี ้แบง่รหสั

ออกเป็นสว่นใหญต่ามดว้ยสว่นยอ่ย จากซา้ยไปขวา เชน่ Selection.Font มคีวามหมาย

วา่ ในสว่นทีเ่ลอืกนัน้.ตวัอกัษร 
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นอกจากนัน้สาเหตทุีม่คํีาวา่ With (ซึง่จบดว้ยคําวา่ End With) เป็นการชว่ยใหร้หสัลด

ความซํ้าซอ้นลง ทําใหไ้มจํ่าเป็นตอ้งเขยีนรหสัซํ้าๆกนั ในชว่งซา้ยมอืของรหสัทกุ

บรรทดั ดงันี ้

    Selection.Font.Name = "Tahoma" 

    Selection.Font.Size = 20 

    ..... 

จะเห็นไดว้า่ โครงสรา้งรหสั VBA นัน้ ใกลเ้คยีงกบัภาษาทีค่นเราใชส้ือ่สารกนัน่ันเอง 

แทนทีต่อ้งพดูสัง่กนัซํ้าๆวา่  

    ในสว่นทีเ่ลอืกน ัน้.ตวัอกัษร.ชือ่ตวัอกัษร ทําใหเ้ป็น Tahoma  

    ในสว่นทีเ่ลอืกน ัน้.ตวัอกัษร.ขนาดตวัอกัษร ทําใหเ้ป็น 20 

สามารถสัง่แบบสัน้ลงวา่ ในสว่นทีเ่ลอืกนัน้.ตวัอกัษร นัน้ ใหใ้ชต้วัอกัษรใด ขนาดใด ซึง่

งา่ยตอ่การเขยีน ประหยดัเวลา และยงัทําใหร้หสัทํางานเร็วขึน้ดว้ย 

ขอ้ควรสงัเกตและขอ้ควรระวงัในการเขยีนรหสั VBA  

 

1. เมือ่กดปุ่ ม ALT+F11 เพือ่เปิด VBE ขึน้มาแลว้ ไมม่จีอ Window ภายใน

แบง่เป็นสว่นๆ ใหใ้ชเ้มนูของ VBE สัง่ View > Project Explorer และ 
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View > Properties Window เพือ่แบง่จอดา้นซา้ยใหแ้สดงชือ่แฟ้ม

และโครงสรา้งของแฟ้ม ปรากฏใหเ้ห็นใน Project Explorer (สว่น 

Properties Window นัน้ ไมจํ่าเป็นตอ้งเปิดขึน้ก็ได)้  

2. ใหส้ัง่ปรับระบบภาษาทีใ่ชใ้หเ้ป็นภาษาไทย ในเมนูของ VBE ใหส้ัง่ Tools 

> Options > Editor Format > Font เลอืก Font ไทย (แนะนํา 

Tahoma Bold(Thai))  

3. ชดุคําสัง่ทีใ่ชง้านทัว่ไป ใหเ้ขยีนเก็บไวใ้นชทีชือ่ Module1, Module2, 

Module3 ...โดยใชเ้มนู Insert > Module ใน VBE จะชว่ยสรา้ง 

Module โดยเรยีงเลขตอ่ทา้ยใหเ้รือ่ยไป  

4. ใหส้งัเกตวา่ ในหนา้จอสว่นของ Project Explorer เมือ่ดบัเบลิคลกิทีช่ ือ่ 

Module1 จะมสีพีืน้ใตช้ือ่เป็นสเีทาจาง พรอ้มกนันัน้จอดา้นขวาจะเปิด 

Code Window เป็นพืน้ทีใ่ชเ้ก็บรหสัเปิดขึน้มาใหเ้ห็น และดา้นบนซา้ย

ของจอ จะแสดงชือ่แฟ้มตอ่ดว้ยชือ่ Module เชน่ Book1.xlsx 

[Module1(Code)] ทัง้นีเ้พือ่แสดงใหเ้ห็นชดัวา่ Code Window ทีกํ่าลงัใช ้

งานนัน้เป็นของ Module1 ชดัเจน (อยา่ดแูคส่ใีตช้ือ่ Module1 เพราะถา้

ลองคลกิทีช่ ือ่ Module1 จะเปลีย่นสพีืน้เป็นสเีขม้ ซึง่ตอ้งดบัเบลิคลกิจงึจะ

เป็นสเีทาจาง)  

5. ในขัน้ตน้ทีเ่พิง่เริม่เรยีนรู ้VBA นัน้ ใหต้รวจสอบ VBE วา่ Tools > 

Options > Editor ไมไ่ดก้าชอ่ง Require Variable Declaration 

(หากพบวา่เดมิกาไว ้ใหต้ดักาทิง้ไป ซึง่คําสัง่นีถ้า้กาไว ้จะทําใหท้กุครัง้ที ่

Insert > Module ใหม ่จะมคํีาสัง่ Option Explicit เขยีนไวใ้นบรรทดัแรก 

ดงันัน้ถา้พบคําวา่ Option Explicit ก็ใหล้บทิง้บรรทดันีอ้อกไปดว้ย)  

6. ควรแยกเก็บชดุคําสัง่ทีทํ่างานตา่งกนัโดยสิน้เชงิ ไวต้า่ง Module กนั  

7. หากใช ้Macro Recorder ชว่ยสรา้งรหสั ควรบนัทกึขัน้ตอนสัน้ๆแยกออก

จากกนัในแตล่ะครัง้ เพือ่ทําใหเ้กดิ Sub Procedure แยกเก็บรหสัแตล่ะชดุ

ออกจากกนั ซึง่ทกุครัง้ทีเ่ปิดแฟ้มขึน้มาบนัทกึ Macro ใหม ่จะพบวา่ VBE 

เปิด Module ใหมแ่ยกจาก Module เดมิเสมอ  

8. ถา้ตอ้งการกําหนด Shortcut Key ใหก้บัชดุคําสัง่ทีเ่ขยีนเอง หรอื

เปลีย่นแปลง Shortcut Key ชดุคําสัง่ทีใ่ช ้Macro Recorder ใหก้ลบัที ่
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Excel แลว้สัง่ Developer > Macros > คลกิเลอืกชือ่ชดุคําสัง่ แลว้กด

ปุ่ ม Options... จะเห็นชอ่งทีพ่มิพ ์Shortcut Key ลงไปได ้(สงัเกตวา่ 

Shortcut Key ทีเ่ขยีนไวใ้นสว่นของ Comment อาจไมต่รงกบั Shortcut 

Key ทีแ่กไ้ขใหมก่็ได ้เพราะ VBE ไมไ่ดต้ามแกส้ิง่ทีบ่นัทกึเดมิไปแลว้)  

9. ใหพ้มิพต์วัอกัษรตวัเล็กเสมอ เวน้เฉพาะชือ่ Sub หรอืชือ่ตวัแปรทีค่ณุตัง้

เองใหพ้มิพต์วัเล็กผสมตวัใหญต่ามตอ้งการ เมือ่กด Enter หรอืขึน้บรรทดั

ใหมจ่ะพบวา่ VBE ชว่ยแกไ้ขตวัอกัษรตวัเล็กทีค่ณุพมิพ ์หากเป็นคําสัง่ที ่

VBE รูจั้ก จะถกูแกใ้หเ้ป็นตวัอกัษรตวัใหญผ่สมตวัเล็กตอ่ใหเ้อง แตถ่า้เป็น

คําทีส่ะกดผดิหรอื VBE ไมรู่จั้ก ใหส้งัเกตวา่จะยงัคงเป็นตวัเล็กตามเดมิ  

10. เมือ่พมิพคํ์าวา่ Sub ตามดว้ยชือ่ของ Sub นัน้แลว้กดปุ่ ม Enter จะพบวา่ 

VBE จะพมิพเ์ครือ่งหมาย () ตอ่ทา้ยชือ่ Sub ใหเ้อง และเกดิคําวา่ End 

Sub พมิพใ์นบรรทดัตอ่ไปเพือ่แสดงใหเ้ห็นจดุสิน้สดุของ Sub  

11. VBE จะยอ้นไปแกไ้ขชือ่ตวัแปรทีส่ะกดตรงกนัใหเ้ป็นตวัใหญต่วัเล็ก ตาม

ชือ่ตวัแปรตวัลา่สดุทีพ่มิพล์งไปใหเ้สมอ เชน่ เดมิใชช้ือ่ตวัแปร myVar แต่

ตอ่มาคณุพมิพ ์MYVar จะพบวา่ VBE แกไ้ข myVar เดมิทกุตวัใหเ้ป็น 

MYVar  

12. ควรจัดยอ่หนา้รหสั VBA ในชดุคําสัง่ใหย้อ่หนา้ลดหลัน่กนัไป เพือ่ใชแ้นว

ยอ่หนา้ทีต่รงกนั แสดงถงึคําสัง่ระดบัเดยีวกนั  

13. ถา้รหสัแตล่ะบรรทดัยาวมาก สามารถจัดรหสัขึน้บรรทดัใหมไ่ด ้โดยเคาะ

วรรคแลว้พมิพเ์ครือ่งหมาย _ แลว้กดปุ่ ม Enter เพือ่พมิพต์อ่ในบรรทดัใหม ่ 

14. ใน VBE จะจดจําทกุขัน้ตอนเดมิทีค่ณุทําไวต้ลอด ชว่ยใหส้ามารถ Undo 

หรอืกดปุ่ ม Ctrl+z เพือ่ยอ้นกลบัไปใชร้หสัเดมิทีเ่ขยีนไวไ้ดท้กุขัน้ทีผ่า่น

ไปแลว้  

15. ควรสัง่ Save กอ่นทีจ่ะสัง่ Run รหสัเสมอ เพราะหากรหสัไมทํ่างาน ใน

บางครัง้อาจทําใหเ้ครือ่ง Hang และไมส่ามารถสัง่ Save เก็บรหสัที่

อตุสา่หเ์สยีแรงเสยีเวลาสรา้งเก็บไวไ้ด ้ 

16. สัง่รหสัใหทํ้างาน โดยคลกิในพืน้ทีร่ะหวา่ง Sub ถงึ End Sub ของ

ชดุคําสัง่ทีต่อ้งการ แลว้กดปุ่ ม F5 หรอื ใชเ้มนู Run > Run Sub หรอื
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คลกิทีปุ่่ ม Run (เป็นรปูลกูศรขวา) หากตอ้งการใหร้หสัทํางานทลีะบรรทดั 

ใหก้ดปุ่ ม F8 ตอ่กนัไปเรือ่ยๆ  

17. ถา้ตอ้งการสัง่รหสัใหทํ้างานโดยสัง่จาก Excel ใหใ้ชคํ้าสัง่บนเมนู 

Developer > Macros จากนัน้คลกิเลอืกชือ่ชดุคําสัง่ทีต่อ้งการ แลว้กด

ปุ่ ม Run เพือ่สัง่ใหทํ้างานตอ่เนือ่งกนัทัง้ชดุ หรอืกดปุ่ ม Step Into เพือ่สัง่

ใหทํ้างานทลีะบรรทดั (ซึง่ตอ้งกดปุ่ ม F8 ตอ่ไปเอง)  

18. ในกรณีรหสัหยดุทํางานทัง้ๆทีร่หสัยงัทํางานไมค่รบทัง้ชดุคําสัง่ จะเห็นวา่ 

VBE เปลีย่นสพีืน้บรรทดัของรหสัทีไ่มทํ่างานเป็นพืน้สเีหลอืง และจะทําให ้

ทัง้ VBE และ Excel หยดุคา้งตามไปดว้ย ใหส้ัง่ Run > Reset หรอืคลกิ

ทีปุ่่ ม Reset (เป็นรปูสีเ่หลีย่มจัตรัุส อยูต่ดิกบัปุ่ ม Run) กอ่น พืน้สเีหลอืง

จะหายไป จากนัน้จงึจะสามารถกลบัไปตรวจสอบแกไ้ขรหสัตอ่ไป  

19. เมือ่ทดสอบรหสัทัง้หมดวา่ทํางานถกูตอ้งสมบรูณ์แลว้ ควร Export 

Module ออกไปแลว้ Remove Module ตามไปดว้ย จากนัน้สัง่ Save แลว้

เปิดแฟ้มขึน้มาใหม ่แลว้จงึ Import Module กลบัเขา้มาเหมอืนเดมิ ทัง้นี้

เพือ่ชว่ยลบขยะทีต่วั Module เก็บไวต้ลอดชว่งทีค่ณุแกไ้ขรหสัทิง้ออกไป 

ทําใหแ้ฟ้มมขีนาดเล็กลง  

 

ขัน้ตอนนีใ้หค้ลกิขวาทีช่ ือ่ Module แลว้สัง่ Export File ออกไปเป็นแฟ้ม

ใหมม่นีามสกลุ bas แลว้คลกิขวา Remove Module จากนัน้คลกิขวาทีต่วั 

Module สัง่ Import File .bas เขา้มาใหม ่ 
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วธิใีช ้VBA ใหคุ้ม้คา่ 

หลายคนพอเริม่ใช ้Macro Recorder เป็น จะเห็นวา่วธิสีรา้งรหสั VBA ขึน้มาใชง้าน

ไมไ่ดย้ากอยา่งทีค่ดิ ทีแ่ทแ้คส่ัง่ Record Macro เทา่นัน้ จากนัน้อยากใชร้หัส VBA 

ทํางานอยา่งไร ขอใหใ้ชเ้มาสแ์ละแป้นพมิพทํ์างานตามแบบทีต่อ้งการ จะเกดิรหสั VBA 

ขึน้ตามตอ่มาใหโ้ดยเราไมต่อ้งเขยีน VBA เองแมแ้ตน่อ้ย  

จากขัน้ตอนงา่ยๆจากการใช ้Macro Recorder นีแ่หละ กลายเป็นตวักระตุน้ใหห้าทาง

ใช ้VBA ตอ่กนั บางคนพอสามารถใช ้VBA ควบคมุแฟ้ม Excel ใหทํ้างานไดด้ัง่ใจ ก็จะ

ยกแฟ้มทีส่รา้งดว้ยฝีมอืตนอวดใหค้นอืน่ดดูว้ยความภาคภมูใิจ โดยหารูไ้มว่า่ ผลงานที่

ตนชืน่ชมอยา่งยิง่นัน้ ไมไ่ดคุ้ม่คา่อยา่งทีค่ดิ  

คุม้คา่ คา่ของอะไร เทยีบกบัอะไร  

ลองนกึดซูวิา่ ถา้คณุเสยีเวลาสรา้งรหสั VBA นานนับชัว่โมง แตร่หสั VBA ทีใ่ชนั้น้

สามารถชว่ยประหยดัเวลาการทํางานไดแ้คไ่มก่ีน่าท ีในกรณีเชน่นีจ้ะถอืวา่คุม้คา่ไหม 

แตต่อ่มาถา้ตอ้งใชร้หสันัน้ซํ้าแลว้ซํ้าอกี เมือ่นับรวมเวลาทีป่ระหยดัไดแ้ลว้เกนิกวา่เวลา

ทีใ่ชส้รา้ง VBA อยา่งนีจ้งึเรยีกไดว้า่ คุม้ใชไ่หม.... ยงัหรอก คดิเทยีบแคน่ีง้า่ยเกนิไป 

กวา่จะใช ้VBA เป็น คณุตอ้งลงทนุลงแรงอะไรบา้ง 

1. เสยีเวลามาเขา้อบรม  

2. เสยีเงนิซือ้หนังสอื VBA มาอา่น  

3. เสยีเวลาลองผดิลองถกูตอนฝึกใช ้VBA  

4. เสยีเวลาเขยีนคูม่อื บนัทกึขัน้ตอนและวธิกีารทีใ่ช ้ 

5. เสยีเวลาประกาศตวัแปร เพือ่ทําใหร้หสัทํางานไดเ้ร็วขึน้  

6. เสยีเวลาปรับปรงุตดัรหสั VBA ทีไ่มจํ่าเป็น ทําใหส้ัน้กะทดัรัด  

7. เสยีเวลายอ้นกลบัมาแกะรหสัเดมิทีเ่ขยีนไวน้านแลว้ เพือ่ใชใ้หม ่ 

8. เสยีโอกาสใชเ้วลาใหก้บัชวีติสว่นตวั เสยีความสขุในชวีติไปบางสว่น  
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จากนีข้อยกเฉพาะประเด็นทีค่วรแกก่ารทําความเขา้ใจหรอือาจเขา้ใจไมต่รงกนั มา

อธบิาย 

เสยีเวลามาเขา้อบรม 

หลกัสตูรอบรมทีว่า่ดว้ยวธิใีช ้VBA ถา้จะใหส้มบรูณ์ จะตอ้งใชเ้วลาอบรมนานเป็นเดอืน 

เรยีนกนั ใหก้ารบา้นทํามาสง่อาจารยก์นั เหมอืนกบัสมยัทีเ่ราเรยีนวชิาหนึง่ๆสมยั

มหาวทิยาลยัน่ันแหละ จงึจะไดผ้ลสมบรูณ์ แตถ่า้ใหเ้วลาอบรมเพยีงไมก่ีช่ัว่โมง เรยีน

ตดิตอ่กนัเพยีงไมก่ีว่นั ถอืวา่ยากมากทีจ่ะเกดิผลตามตอ้งการ ไหนจะตอ้งแบง่เวลา

ใหก้บัภาคทฤษฎ ีตามดว้ยเวลาทีเ่หลอื มาใชป้ฏบิตัสิรา้งงานกนั  

ถา้เรยีนตดิตอ่กนั 3 วนั แลว้ใชเ้วลาใหก้บัการทดลองใช ้VBA แคต่วัอยา่งเดยีวหรอืไมก่ี่

ตวัอยา่ง พอจบอบรมออกมา แทบทกุคนจะนําความรูท้ีเ่พิง่อบรมจบไป นํามาใชไ้ดก้บั

งานทีต่รงกบัตวัอยา่งทีเ่รยีนมาเทา่นัน้ สว่นงานทีไ่มต่รงกบัตวัอยา่งทีอ่บรม ตอ้งปลอ่ย

ไวอ้ยา่งเดมิน่ันแหละ เพราะคดิตอ่เองไมเ่ป็น บางคนพออบรมเสร็จ ก็คนืความรูท้ีเ่รยีน

ไปคนืใหอ้าจารยท์นัท ีเพราะตวัอยา่งทีเ่รยีนไปนัน้ ไมเ่ห็นตรงกบังาน ไมต่รงกบัปัญหา

ของตนทีต่อ้งการเอาความรูท้ีเ่รยีนไปกลบัไปแกปั้ญหา 

ทีแ่ยก่วา่นัน้ ถา้ตดิปัญหาสงสยัในระหวา่งอบรม แลว้ไมก่ลา้ถาม ไมก่ลา้ยกมอืบอกวา่

ไมเ่ขา้ใจ ขอใหส้อนซํ้า ยิง่เรยีนตอ่นานเขา้ ปัญหาคา้งคาใจจะมมีากขึน้จนกลายเป็นดนิ

พอกหางหม ูสมองของผูเ้ขา้อบรมคนนัน้มกัจะปิดรับรูเ้รือ่งทีอ่บรมสว่นทีเ่หลอื ทีว่า่

อบรมกนั 3 วนั จงึกลายเป็นวา่ รูเ้รือ่ง ตามเนือ้หาทันแคว่นัแรกเทา่นัน้ สว่นความรูท้ี่

เหลอือกี 2 วนั หายสาบสญูไปในอากาศ 

ดงันัน้ถา้ตอ้งเสยีเวลาทํางานมาเขา้อบรม แลว้อยากไดผ้ลคุม้คา่กบัเวลาทีเ่สยีไป ตอ้ง

หาทางใชเ้วลาระหวา่งการอบรมใหย้ดืหยุน่ทีส่ดุ มุง่เนน้ใหค้ดิเองทําเองตอ่ใหเ้ป็น อยา่

เอาแตท่อ่งจํา ขอใหใ้ชเ้วลาทําตวัอยา่งหลายๆแบบ ปฏบิตัมิากๆ สว่นทฤษฎตีามมาที

หลงั หวัขอ้เนือ้หาหลกัสตูรควรมุง่ทีต่วัปัญหาในงานวา่ จะใช ้VBA อยา่งไรกลบัมาใช ้

กบัปัญหานัน้ อยา่เรยีนแบบไลต่ามเนือ้หาของ VBA วา่มอีะไรบา้ง 
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คณุควรถอืวา่ เวลาทีเ่สยีไปกบัการอบรมเพยีง 3 วนั เป็นเพยีงจดุเริม่ตน้ทีช่ว่ยใหค้ณุ

เองไดเ้รยีนรู ้เป็นแนวทางใหค้ณุสามารถยอ้นกลบัมาลองผดิลองถกู และคอ่ยๆเพิม่พนู

ความรูเ้รือ่ง VBA ใหล้กึขึน้เองในภายหลงั ซึง่ตอ้งใชเ้วลาศกึษาเองตอ่อกีนานนับปี

ทเีดยีว ถา้คณุตัง้หลกัคดิไดอ้ยา่งนี ้รับรองวา่ทีเ่สยีเวลามาอบรม VBA จะคุม้คา่ทเีดยีว 

เสยีเงนิซือ้หนงัสอื VBA มาอา่น 

เรือ่งหนังสอื VBA นีต้อ้งชว่ยทําใจกนัหน่อย เพราะจะหาหนังสอื VBA ทีใ่หคํ้าตอบทีเ่รา

ตอ้งการไมค่อ่ยไดห้รอก แมห้นังสอื VBA โดยทัว่ไปเป็นหนังสอืทีด่ ีแตท่ีว่า่ ด ีก็เพราะ

มเีนือ้หาใหร้ายละเอยีดไดด้มีาก ไลเ่รยีงจากทีไ่ปทีม่า วา่ดว้ย VBA คอือะไร มหีนา้ตา

ของรหสัเป็นอยา่งไร ตอ้งเขยีนโครงสรา้งรหสัอยา่งไร มกีฎเกณฑอ์ะไรทีต่อ้งระวงั 

จากนัน้มกัเป็นเนือ้หาขัน้ยาก ยากแบบทีเ่รยีกวา่ กระโดดขา้มขัน้ไปยากสดุๆกนัเลย 

และตวัอยา่งทีใ่ชก้็ไมค่อ่ยตรงกบัทีเ่ราตอ้งการ 

หนังสอื VBA ทีค่ณุควรหาซือ้มาเก็บไว ้ไมค่วรมเีนือ้หาแค ่VBA แตค่วรมเีนือ้หาอธบิาย

ครอบคลมุถงึความสมัพันธข์อง VBA กบั Excel ดว้ย โดยขอแนะนําหนังสอืของ John 

Walkenbach ซึง่มเีนือ้หาทีอ่า่นงา่ย ไลเ่รยีงตัง้แต ่Excel เรือ่ยไปจนถงึตวั VBA และมี

ตวัอยา่งประกอบไปตลอด ตา่งจากหนังสอืของผูแ้ตง่คนอืน่ทีช่อบเริม่บทแรกเป็น VBA 

และใชต้วัอยา่งยากๆ ทีค่นเกง่ๆเห็นแลว้ก็ยงังง  

อยา่งไรก็ตามคณุควรหาซือ้หนังสอื VBA ไวห้ลายๆเลม่ จากผูเ้ขยีนหลายๆคน เพราะ

หนังสอืแตล่ะเลม่ มกัไมไ่ดร้วบรวมคําตอบทีค่ณุตอ้งการทัง้หมดไวด้ว้ยกนั ขอใหเ้ก็บ

หนังสอืไวใ้ชค้น้หาคําตอบเมือ่คณุตดิปัญหา ลองนกึดวูา่ ถา้คณุใช ้VBA แลว้ตดิขดั

ขึน้มา งานไมเ่ดนินานเป็นชัว่โมงหรอืเป็นวนั ชว่งเวลาทีง่านหยดุนิง่นีแ้หละ คดิตน้ทนุที่

เสยีไปเป็นเงนิเป็นทองไดม้หาศาล แตถ่า้มหีนังสอืใหพ้ลกิคน้หาคําตอบ สามารถแกไ้ข

ปัญหาทีต่ดิคา้งอยูไ่ดท้ันท ีอยา่งนีจ้งึเรยีกวา่ ซือ้หนังสอืมาแลว้คุม้  

เสยีเวลาประกาศตวัแปร เพือ่ทําใหร้หสัทํางานไดเ้ร็วขึน้ 

การประกาศตวัแปร มาจากคําวา่ Declare Variables เป็นคําสัง่ทีกํ่าหนดใหเ้ขยีนขึน้ใน

บรรทดัแรกๆของรหสั VBA ทัง้หมด เพือ่กําหนดใหค้อมพวิเตอรใ์ชห้น่วยความจําเทา่ที่
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จําเป็น สําหรับเก็บคา่ไวใ้นตวัแปรแตล่ะประเภท ไดแ้ก ่Boolean, Byte, Integer, 

Long, Currency, Single, Double, Date, String แลว้จะสง่ผลใหร้หสัทํางานเร็วขึน้  

 

แมก้ารประกาศตวัแปรดงักลา่ว ตอ้งเขยีนไวบ้รรทดับนๆของแตล่ะชดุคําสัง่ แตม่ไิดม้ี

ความหมายวา่ เราจําเป็นตอ้งเสยีเวลากําหนดตวัแปรไวต้ัง้แตต่อนเริม่ตน้เขยีนรหสั หรอื

จําเป็นตอ้งประกาศตวัแปรกอ่นเสมอ มฉิะนัน้รหสั VBA จงึจะทํางาน อกีทัง้เมือ่ประกาศ

ตวัแปรไวแ้ลว้ ยงัไมแ่น่วา่รหสั VBA จะทํางานเร็วขึน้มาก จนเราสงัเกตเห็นไดว้า่เร็วขึน้

อยา่งชดัเจน 

แตเ่ดมินัน้เครือ่งคอมพวิเตอรทํ์างานชา้มาก ยิง่ตอ้งใชร้หสัยาวๆหลายๆบรรทดั ยิง่ทํา

ใหค้อมพวิเตอรทํ์างานชา้ลง และถา้เทยีบรหสั VBA ทีใ่ชก้บั Excel ทีว่า่ยาวกบัรหสัที่

ใชใ้นโปรแกรมอืน่แลว้ ถอืวา่รหสั VBA ทีใ่ชก้บั Excel นีส้ัน้กวา่มาก และคอมพวิเตอร์

ยคุนีท้ัง้เร็วและราคาถกู ราคาหน่วยความจําก็ไมแ่พงเหมอืนแตก่อ่น  

แทนทีจ่ะเสยีเวลาประกาศตวัแปรในตอนตน้ ขอแนะนําใหเ้ลอืกประกาศตวัแปรตอ่เมือ่

จําเป็นเทา่นัน้ และไมต่อ้งรบีรอ้นเสยีเวลาประกาศตวัแปรดว้ยซํ้า ควรรอจนกวา่เมือ่

ทดลองสัง่ใหร้หสั VBA ทํางานแลว้พบวา่ชา้ จงึคอ่ยหาทางปรับปรงุแกไ้ขใหร้หสั

ทํางานเร็วขึน้ ซึง่เมือ่ประกาศตวัแปรแลว้อาจพบวา่ ไมไ่ดช้ว่ยใหร้หสัทํางานเร็วขึน้แต่
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อยา่งใด เนือ่งจากรหสัจะทํางานไดเ้ร็วหรอืชา้นัน้ มไิดข้ึน้กบัการประกาศตวัแปรเพยีง

อยา่งเดยีว และการประกาศตวัแปรทีไ่มเ่หมาะสม อาจทําใหร้หัสไมทํ่างานตามทีค่ดิไว ้

แลว้กวา่จะหาคําตอบเจอวา่ตอ้งแกไ้ขในสว่นของการประกาศตวัแปร อาจตอ้งเสยีเวลา

คน้หาจดุผดิพลาด หาแลว้หาอกีก็ยงัไมพ่บเพราะคดิไมถ่งึวา่ ปัญหาเกดิจากตวัแปร

นีเ่อง  

นอกจากนีล้องพจิารณาวา่ ถา้ตอ้งเสยีเวลาหลายนาทคีดิเขยีนประกาศตวัแปร แลว้ทํา

ใหแ้ฟ้มงานทํางานเร็วขึน้เพยีงแคเ่สีย้ววนิาท ีอยา่งนีเ้รยีกวา่ คุม้หรอืไม ่ตอ่เมือ่คณุมี

ขอ้จํากดัวา่ เครือ่งคอมพวิเตอรท์ีใ่ชทํ้างานนัน้เป็นรุน่เกา่ ทํางานชา้ หรอืไมส่ามารถเพิม่

หน่วยความจําใหม้ากขึน้ตา่งหาก จงึควรพจิารณาหาทางใชก้ารประกาศตวัแปรใหเ้กดิ

ประโยชน ์ 

เสยีเวลาปรบัปรงุตดัรหสั VBA ทีไ่มจ่ําเป็น ทําใหส้ ัน้กะทดัรดั 

ประเด็นนีค้ลา้ยคลงึกบัการเขยีนประกาศตวัแปร แทนทีจ่ะเสยีเวลาเขยีนประกาศตวัแปร

ซึง่ทําใหร้หสัยาวขึน้ กลบัมาเสยีเวลาปรับปรงุรหสั ตดัรหสั VBA ทีไ่มจํ่าเป็น เพยีงแค่

ทําใหด้วูา่รหสัสัน้กะทดัรัดขึน้ โดยไมไ่ดช้ว่ยใหร้หัสทํางานเร็วขึน้จนถอืไดว้า่ ชดเชย

คุม้คา่กบัเวลาทีเ่สยีไปในการปรับปรงุรหสัใหส้ัน้ลง 

อยากใช ้VBA ใหคุ้ม้คา่ ตอ้งคดิตอ้งทําอยา่งไร  

กฎเกณฑต์อ่ไปนีเ้ป็นเพยีงความเห็นหนึง่ อยากใหถ้อืเป็นเพยีงคําแนะนํา ไมใ่ช่

กฎเกณฑต์ายตวั หรอืตอ้งบงัคบัใชก้บัทกุคน ทัง้นีข้ ึน้กบัสภาพแวดลอ้มและ

สถานการณ์ของผูใ้ช ้VBA ซึง่มคีวามแตกตา่งกนัไปอกีดว้ย  

 อยา่คดิทําอะไรเกนิตวั ตนมคีวามรูค้วามสามารถระดบัใด มเีวลาจํากดัแค่

ไหน ใหทํ้าแคนั่น้ เทา่ทีต่นทําได ้ 

 มุง่ทํางานใหเ้สร็จทนัเวลา โดยไมต่อ้งหว่งเรือ่งความสมบรูณ์ของตวัรหสั 

ขนาดหน่วยความจําวา่สิน้เปลอืงอยา่งไร หรอืความเร็วของรหสั ตอ่เมือ่มี

เวลาเหลอืพอ จงึยอ้นกลับมาปรับปรงุรหสัใหส้มบรูณ์  
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 เลอืกใชว้ธิหีาคําตอบทีเ่หมาะกบังานและผูใ้ช ้ถา้ผูใ้ชง้านรว่มกนั ไมม่ี

ความรูเ้รือ่ง VBA ก็ไมค่วรใช ้VBA ใหเ้ลอืกใชว้ธิอีืน่ทีอ่าจเสร็จชา้กวา่ มี

ขัน้ตอนยาวกวา่ แตไ่มม่ผีลเสยีหรอืความเสีย่งในระยะยาว  

 VBA เหมาะกบังานทีม่ขีัน้ตอนชดัเจนแน่นอนตายตวัแลว้เทา่นัน้  

 เรยีนรู ้VBA จากการทดลองใชง้านงา่ยๆ มรีหสัสัน้ๆ แตต่อ้งพยายามฝึกใช ้

บอ่ยๆ เรยีนรูจ้ากขอ้ผดิพลาดของตนเอง  

 ควรเลอืกใช ้VBA กบังานทีต่อ้งนํากลับมาใชซ้ํ้าแลว้ซํ้าอกี หรอืงานทีม่ี

ขัน้ตอนยุง่ยากสลบัซบัซอ้น จนผูป้ฏบิตังิานอาจเผลอทํางานผดิพลาด 

อยา่ใช ้VBA กบังานทีใ่ชเ้พยีงครัง้เดยีว  

 พยายามใช ้Macro Recorder ชว่ยสรา้งรหสั VBA ใหม้ากทีส่ดุแทนการ

เขยีนรหสัเอง  

 จดบนัทกึอธบิายการใช ้VBA ในแตล่ะแฟ้มงาน แสดงรายละเอยีดดว้ยวา่ 

ทําไมจงึเลอืกใชว้ธินัีน้ ทําไมจ่งึไมเ่ลอืกใชว้ธิอีืน่  

 ควรมผีูร้ว่มงานรว่มรับรูก้ารสรา้ง VBA เพือ่เป็นตวัตายตวัแทน  
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ทางออกทีด่กีวา่การใช ้VBA 

ขอ้ผดิพลาดทีร่า้ยแรงทีส่ดุในการใช ้VBA เกดิจากการตดัสนิใจใช ้VBA ทัง้ๆทีม่ี

ทางออกอืน่ทีด่กีวา่ งา่ยกวา่ สะดวกกวา่อยูแ่ลว้ ทําใหต้อ้งเสยีแรงเสยีเวลาสรา้ง รหสั 

VBA ขึน้มา พอสรา้งเสร็จ ยงัตอ้งเสยีเวลายอ้นกลบัมาแกไ้ขอยา่งยากเย็นเสยีอกี 

ในตวัโปรแกรม Excel มเีครือ่งมอืทีเ่ป็นเมนูคําสัง่และสตูรสําเร็จรปู ซึง่สามารถนํามา

ชว่ยควบคมุการทํางานไดเ้ชน่เดยีวกนักบัการใช ้VBA หรอืนํามาใชร้ว่มกบั VBA  

เครือ่งมอืชว่ยในการเปิดแฟ้มทีต่อ้งเปิดพรอ้มกนั 

เริม่จากจัดเปิดแฟ้มทีต่อ้งการทัง้หมดขึน้มาบนจอ จากนัน้สัง่ View > Save 

Workspace ซึง่จะเกดิแฟ้มใหมเ่พิม่อกีแฟ้มหนึง่มนีามสกลุ .xlw ตอ่มาหากตอ้งการ

เปิดแฟ้มชดุเดมิทัง้หมดพรอ้มกนัอกี ใหส้ัง่เปิดเฉพาะแฟ้ม .xlw นัน้แฟ้มเดยีว Excel จะ

ไลเ่ปิดแฟ้มทกุแฟ้มทีต่อ้งการตอ่ใหเ้อง  

แฟ้ม .xlw เป็นแฟ้มขนาดเล็กมาก ทําหนา้ทีเ่ก็บแคช่ือ่แฟ้มทีเ่คยเปิดขึน้มาทํางาน

พรอ้มกนั แฟ้มนีไ้มไ่ดเ้ก็บตวัแฟ้มอืน่ไวแ้บบ zip ดงันัน้ถา้ตอ้งการสง่แฟ้มใหผู้อ้ ืน่

นําไปใชง้านตอ่ ตอ้งสง่แฟ้ม .xlw นีไ้ปพรอ้มกบัแฟ้มอืน่ๆทีต่อ้งการเปิดพรอ้มกนัดว้ย 

เพยีงระบวุา่ เมือ่ตอ้งการเปิดแฟ้ม ใหเ้ปิดแฟ้ม .xlw เพยีงแฟ้มเดยีว แลว้จะพบวา่แฟ้ม

อืน่ๆจะถกูเปิดตอ่ใหเ้อง (แตน่่าเสยีดายที ่Excel 2013 ยกเลกิการสรา้ง xlw ไปแลว้) 

ถา้แฟ้มมหีลายชที อยากจะคลกิงา่ยๆใหไ้ปทีช่ทีทีต่อ้งการ 

คณุสามารถใช ้Hyperlink สรา้งรปูภาพสวยๆไวใ้นตารางเพือ่คลกิ link ไปยงัชทีที่

ตอ้งการ โดยเริม่จากวาดรปูใสล่งไปในตารางกอ่น แลว้คลกิขวาทีร่ปู สัง่ Hyperlink 

แลว้เลอืก Place in this document หรอื Existing File or Web Page เพือ่

กําหนดตําแหน่งปลายทางในแฟ้มเดมิหรอืในแฟ้มอืน่ตามลําดบั 
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นอกจากการใช ้Hyperlink ทีส่รา้งจากเมนู ยงัม ีHyperlink ทีส่รา้งจากสตูรไดอ้กี เชน่ 

หากตอ้งการสรา้ง link ในคําวา่ Click here ไปทีช่ทีชือ่ June เซลล ์E56 ใชส้ตูร

ตอ่ไปนี ้ 

=HYPERLINK("[Book1.xls]June!E56", "Click here")  

อยากไปทีช่ทีทีต่อ้งการ แลว้ใหป้รบัโครงสรา้งตารางในชทีน ัน้ดว้ย 

เป็นเรือ่งหนา้เบือ่อยา่งมาก หากแฟ้มทีใ่ชง้านมมีากมายหลายชที ชือ่ชทีดา้นลา่งจอจะ

เขยีนตอ่กนัเป็นแถบยาวออกหนา้จอ ตอ้งเสยีเวลาขยบัไลห่าชที จงึจะพบชทีทีต่อ้งการ 

และยงัอาจพบปัญหาตอ่เนือ่งไปอกีวา่ ชทีทีอ่ยากจะดนัูน้ ตอ้งคอยซอ่นแถว และปรับ

ขนาดแถวใหมจ่นกวา่จะไดโ้ครงสรา้งตารางตรงใจผูใ้ช ้ซึง่บางคนหาทางออกโดยสรา้ง

ชทีทีม่ขีอ้มลูเหมอืนกนัหลายๆชทีขึน้มา แลว้จัดโครงสรา้งใหต้า่งกนัไปแลว้แตว่า่ 

ตารางนัน้ชทีนัน้จัดไวใ้หใ้ครด ูถา้ทําอยา่งนีแ้ฟ้มจะใหญก่วา่เดมิขึน้เยอะทเีดยีว 

ปัญหาดงักลา่วจะหมดไปโดยเริม่จากจัดโครงสรา้งตารางใหต้รงความตอ้งการกอ่น แลว้

ใชคํ้าสัง่ View > Custom Views ตัง้ชือ่แบบชทีทีต่อ้งการตามทีเ่ห็นบนจอ ทํา

เชน่นีซ้ํ้าไปเรือ่ยๆ โดยไมจํ่าเป็นตอ้งสรา้งชทีซํ้ากนัขึน้อกี  

เมือ่ใดทีต่อ้งการไปทีช่ทีใด ใหค้ลกิที ่View > Custom Views แลว้คลกิชือ่แบบชที

ทีต่ัง้ชือ่ไว ้จะพบวา่ Excel พาคณุไปทีช่ทีนัน้แลว้ปรับโครงสรา้งตารางใหด้ว้ย และเมือ่

คณุสัง่พมิพย์งัสามารถปรับหวัตาราง ทา้ยตารางในหนา้กระดาษใหแ้ตกตา่งกนัไปไดอ้กี

ดว้ย เนือ่งจาก Custom Views บนัทกึ Page Setup ไปพรอ้มกนั 

นอกจากนีค้วรใชคํ้าสัง่ Data > Group รว่มกบั Custom View เพือ่ทําใหช้ทีหนึง่ๆ

สามารถจัดโครงสรา้งตารางใหเ้หมาะกบังานไดห้ลายๆแบบ และ Group ทีใ่ชจ้ะสรา้ง

ความยดืหยุน่ ชว่ยใหผู้ใ้ชส้ามารถเลอืกปรับโครงสรา้งตารางไดต้ามใจตอ่ไปไดอ้กี 

ดกีวา่การใช ้VBA จัดโครงสรา้งตารางแลว้ไมย่ดืหยุน่ เนือ่งจากจัดไดแ้บบเดยีวตามตวั

รหสัทีเ่ขยีนไวแ้ลว้เทา่นัน้ 

  



32 / 122 

 

 

 

www.ExcelExpertTraining.com 
© พ.ศ. 2558 โดย สมเกยีรต ิฟุ้ งเกยีรต ิ

ตอ้งการ Insert Row เพือ่ใหข้อ้มลูเดมิทีต่ดิกนั กลายเป็นเวน้
บรรทดั 

สมมตวิา่เซลล ์A1:A5 มขีอ้มลูเป็น A, B, C, D, E ตามลําดบั ลองคดิหาทางทําให ้

ขอ้มลูเดมิทีอ่ยูใ่น row ตดิกนักลายเป็นหา่งกนั row เวน้ row จะใชว้ธิใีดด ีซึง่มขีอ้แม ้

วา่ วธิทีีใ่ชนั้น้ตอ้งสามารถนํามาใชก้บัตารางทีม่ขีอ้มลูนับหมืน่ๆ row ไดท้นัทดีว้ย 

ปัญหานีไ้มจํ่าเป็นตอ้งใช ้VBA แมแ้ตน่อ้ย เพยีงแคใ่ชคํ้าสัง่ Data > Sort ก็เสร็จแลว้ 

ทําไมคําสัง่จัดเรยีงจะชว่ย Insert row ใหไ้ด ้ลองทําตามนี ้

ในเซลลด์า้นขวาของตาราง A1:A5 เดมิ คอืในเซลล ์B1:B10 ใหใ้สต่วัเลข 1, 2, 3, 4, 

5, 1, 2, 3, 4, 5 ตามลําดบั จากนัน้เลอืกพืน้ที ่A1:B10 แลว้สัง่ Data > Sort โดยจัด

เรยีงลําดบัตามตวัเลข จะพบวา่ ตารางเดมิ A1:A5 ถกูแทรก row ระหวา่งคา่เดมิให ้

ทนัท ีเนือ่งจากเซลลต์วัเลขเมือ่จัดเรยีงจากนอ้ยไปมากเป็น 1, 1, 2, 2, 3, 3, 4, 4, 5, 

5 จะพาเซลลช์อ่งวา่งใน Column A ตดิไปดว้ย จงึดเูหมอืน ตารางเดมิถกู Insert Row 

อยากควบคมุการกรอกคา่ลงไปในตาราง ใหบ้นัทกึไดเ้ฉพาะเซลลท์ี่
ตอ้งการ 

พอตารางขอ้มลูใหญข่ึน้ ซบัซอ้นมากขึน้ คณุคงอยากหาทางทําใหผู้ใ้ชแ้ฟ้ม เกดิความ

สะดวกในการกรอกคา่ลงไปในตาราง ซึง่บางคนอาจคดิไกลไปใช ้VBA สรา้งจอแสดง

แบบฟอรม์ขึน้มาใหผู้ใ้ชง้านกรอกขอ้มลู แลว้จงึสง่คา่ทีก่รอกในแบบฟอรม์ไปยงัเซลลท์ี่

ตอ้งการตอ่อกีท ี

ปัญหานีน้อกจากจะใช ้Custom Views ชว่ยปรับโครงสรา้งตารางใหง้า่ยขึน้แลว้ แนะนํา

ใหเ้ลอืกเซลลท์ีย่อมใหบ้นัทกึขอ้มลูทบัได ้แลว้สัง่ Format > Cells > Protection 

> ตดัเครือ่งหมายกาชอ่ง Locked ทิง้ไปแลว้ตามดว้ยคําสัง่ Tools > 

Protection > Protect Sheet จะพบวา่เมือ่กดปุ่ ม Tab บนแป้นพมิพ ์Excel จะยา้ย

ตําแหน่งเซลลก์ระโดดไปตามเซลลท์ีเ่ลอืกตดักาชอ่ง Lock ทิง้ใหไ้ปเรือ่ยๆ 

เมือ่ตอ้งการบนัทกึขอ้มลู ใหก้ดปุ่ ม Tab แลว้พมิพข์อ้มลูบนัทกึลงไป แลว้กดปุ่ ม Tab 

แลว้พมิพ ์ทําเชน่นีซ้ํ้าตอ่ไปจนบนัทกึขอ้มลูครบทกุเซลล ์
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อยากส ัง่ให ้Excel ทํางานซํา้ 

เพยีงแคก่ดปุ่ ม F4 จะพบวา่ Excel ทํางานทวนซ้ําคําสัง่ลา่สดุใหเ้องทกุครัง้ทีก่ดปุ่ ม F4 

  

ตวัอยา่งขา้งตน้นีเ้ป็นเพยีงบางสว่นทีแ่สดงใหเ้ห็นวา่ เราสามารถใชเ้พยีงคําสัง่บนเมนู 

หรอืใชส้ตูรคํานวณ หรอืใชท้ัง้คําสัง่บนเมนูมาใชร้ว่มกบัสตูร เพือ่ทําให ้Excel ทํางาน

ไดเ้กนิกวา่ทีค่ดิกนั จงึขอแนะนําวา่ กอ่นทีจ่ะคดิใช ้VBA ควรเรยีนรูส้กันดิวา่ บนเมนู

และสตูร Excel ยงัมอีะไรทีซ่อ่นไวอ้กีบา้ง  

คาํส ัง่บนเมน ู
 

 Data > Consolidate เพือ่สรา้งตารางยอดรวมจากหลายตาราง 

 Data > Filter เพือ่แสดงรายการขอ้มลูทีต่อ้งการ 

 Data > SubTotal เพือ่สรา้งตารางแบง่ยอดรวมเป็นยอดยอ่ย 

 Data > Validation > List เพือ่สรา้งปุ่ มใหค้ลกิเลอืกขอ้มลู 

 Data > What-If Analysis > Data Table เพือ่สรปุการคํานวณเมือ่ตวั

แปรมกีารเปลีย่นแปลง 

 Data > Text to Columns เพือ่แยกคําออกจากประโยค 

 Insert > PivotTable เพือ่สรปุขอ้มลูนํามาสรา้งตารางเปรยีบเทยีบ 

 Home  > Find & Select เพือ่คน้หาหรอืแกไ้ขขอ้มลู 

 Data > Edit Links เพือ่จัดการกบัสตูร link ขา้มแฟ้ม 

 F2 F3 F4 F5 F9 ปุ่ มลดั 

 Format > Cells เพือ่กําหนดรปูแบบ 

 Home > Conditional Formatting เพือ่กําหนดรปูแบบตามเงือ่นไข 

 Home > Style เพือ่กําหนดรปูแบบหลกัใหก้บัแฟ้ม 

 Formulas > Define Name เพือ่ตัง้ชือ่ใหก้บัตารางหรอืใหก้บัสตูร 
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 Data > What-If Analysis > Goal Seek เพือ่คํานวณยอ้นกลบัไปหาตวั

แปร หรอื Scenarios เพือ่เลอืกใชต้วัแปรคํานวณตามเหตกุารณ์ 

 

ปุ่ มบนแป้นพมิพ ์ 

 Ctrl+* เพือ่เลอืกพืน้ทีต่ารางทีต่ดิตอ่กนั (Current Region) 

 Ctrl+จดุ เพือ่ตรวจสอบหวัมมุตารางทีเ่ลอืก 

 Ctrl+Shift+ลกูศร เพือ่เลอืกพืน้ทีต่ารางตามแนวทีต่อ้งการ 

 Ctrl+PageUp เพือ่ไปยงัชทีกอ่น 

 Ctrl+PageDown เพือ่ไปยงัชทีถดัไป 

 Ctrl+c = Copy 

 Ctrl+x = Cut 

 Ctrl+v = Paste 

 Ctrl+z = Undo 

 Shift+End,ลกูศร เพือ่เลอืกพืน้ทีต่ารางตามแนวทีต่อ้งการ 

 

สตูรสําเร็จรปู 

 

If And Or Choose Vlookup Match Index CountIF SumIf SumArray 
Offset 

 

ตอ่เมือ่คณุรูจั้กคําสัง่บนเมนู วธิใีชแ้ป้นพมิพล์ดั และสตูรพอควรแลว้ ควรทดลองใช ้

รว่มกบั Macro Recorder จะชว่ยประหยดัเวลาไมต่อ้งเขยีนรหสั VBA ไดม้ากทเีดยีว 
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เคล็ดการใช ้Macro Recorder 

Macro Recorder เป็นเครือ่งมอืชว่ยสรา้งรหสั VBA ใหเ้อง ซึง่รหสั VBA ทีเ่กดิขึน้นัน้ 

บางครัง้เป็นรหสัทีแ่มแ้ตค่นทีเ่กง่ VBA มากก็ยงัคดิไมถ่งึ และยงัเป็นเครือ่งมอืชว่ยใน

การเรยีนรู ้VBA แตโ่ดยทั่วไปมกักลา่วกนัวา่ เราสามารถนํา Macro Recorder มาใชก้บั

งานงา่ยๆไดเ้ทา่นัน้ หากเป็นงานยากๆยงัไงๆก็ยงัตอ้งหนัมาเขยีนรหสัอยูด่ ีเนือ้หาใน

สว่นนีจ้ะแนะนําเคล็ดการใช ้Macro Recorder ใหเ้หนอืกวา่ทีค่ดิกนั  

คลกิ .... อนัตราย 

พยายามหลกีเลีย่งการใช ้Macro Recorder บนัทกึการใชเ้มาสค์ลกิ ไมว่า่จะคลกิเลอืก

เซลล ์คลกิเลอืกชที หรอืแมแ้ตก่ารคลกิเลอืกคําสัง่บนเมนู เพราะถา้คลกิพลาด ตวั 

Macro Recorder จะบนัทกึการทํางานพลาดของเราไปดว้ย 

ถา้คลกิพลาดไปแลว้ Macro Recorder ก็จะสรา้งรหสัซึง่ทําหนา้ทีต่ามทีพ่ลาดตาม 

แลว้ถา้คลกิตอ่ไปเพือ่คลกิแกใ้หถ้กู ชดุรหสัทีบ่นัทกึจงึมคีวามยาวกวา่จําเป็น เพราะ

บนัทกึตอนทีเ่ราทําพลาด และบนัทกึตอนทีแ่กไ้ขตอ่ไปดว้ย 

ดงันัน้กอ่นทีจ่ะเริม่บนัทกึ เราควรฝึกคลกิสิง่ทีต่อ้งการใหค้ลอ่งกอ่น เมือ่บนัทกึจรงิจะได ้

ไมพ่ลาด 

ยิง่กวา่นัน้ถา้ไมจํ่าเป็นแลว้ อยา่ใชว้ธิคีลกิ แตใ่หใ้ชว้ธิกีดปุ่ มบนแป้นพมิพแ์ทน เพือ่ลด

โอกาสทีอ่าจจะคลกิพลาด เพราะปุ่ มบนแป้นพมิพเ์ห็นชดั และมขีัน้ตอนเดยีวตรงกบั

คําสัง่ทีต่อ้งการ เชน่ 

 กดปุ่ ม Ctrl+c, Ctrl+x, หรอื Ctrl+v เพือ่สัง่ copy, cut, หรอื paste  

 กดปุ่ ม F5 เพือ่เลอืกไปที ่Range Name ทีต่ัง้ไว ้ 

 กดปุ่ ม Ctrl+PageUp เพือ่เลือ่นไปเลอืกชทีกอ่นหนา้  

 กดปุ่ ม Ctrl+PageDown เพือ่เลือ่นไปเลอืกชทีถดัไป  
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ตวัอยา่งเชน่ หากตอ้งการ copy ขอ้มลูจากตารางทีม่ ีRange Name ชือ่ Source ไป 

paste ลงไปในตารางชือ่ Target ซึง่มพีืน้ทีเ่ซลลข์นาดเทา่กนั ใหกํ้าหนดขัน้ตอนการ

บนัทกึ Macro ดงันี ้

1. กดปุ่ ม F5 เลอืกตารางชือ่ Source  

2. กดปุ่ ม Ctrl+c เพือ่สัง่ Copy  

3. กดปุ่ ม F5 เลอืกตารางชือ่ Target  

4. กดปุ่ ม Ctrl+v หรอืกด Enter เพือ่สัง่ Paste  

จะเกดิชดุคําสัง่ทีม่รีหสัตรงตามแตล่ะขัน้ ดงันี ้

Application.Goto Reference:="Source" 

Selection.Copy 

Application.Goto Reference:= "Target" 

ActiveSheet.Paste 

 

เมือ่ปรับปรงุรหสัเองใหส้ัน้ลง 

Range("Source").Copy Range("Target") 

เตรยีมทกุอยา่งใหต้รงขา้มกบัสิง่ทีอ่ยากคลกิ 

ขอใหเ้ตรยีมทําทกุอยา่งซึง่ตรงขา้มกบัคําสัง่ VBA ทีต่อ้งการไวก้อ่น เพือ่จะไดค้ลกิ

กลบัมาเป็นสิง่ทีต่อ้งการ เชน่ ถา้อยากบนัทกึ Macro การคลกิเลอืกเซลล ์A1 ดงันัน้

กอ่นทีจ่ะบนัทกึ Macro ตอ้งคลกิเลอืกเซลลอ์ืน่ทีไ่มใ่ชเ่ซลล ์A1 แลว้ตอนทีบ่นัทกึ 

Macro จะไดเ้ห็นไดช้ดัวา่ เราคลกิเขา้ไปทีเ่ซลล ์A1 จรงิ และจะเกดิรหสัขึน้ตามนัน้  

Range("A1").Select 

ถา้อยากได ้Macro บนัทกึการเลอืก Sheet3 ดงันัน้กอ่นทีจ่ะเริม่บนัทกึ Macro ใหเ้ลอืก

ชทีอืน่ไวก้อ่น 

Sheets("Sheet3").Select 

ถา้อยากได ้Macro บนัทกึการเลอืกแฟ้มชือ่ทีต่อ้งการ ดงันัน้กอ่นทีจ่ะเริม่บนัทกึ Macro 

ใหเ้ปิดแฟ้มแลว้เลอืกอยูใ่นแฟ้มอืน่ไวก้อ่น 
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Windows("Book1").Activate 

ถา้อยากได ้Macro บนัทกึการปรับระบบการคํานวณใหเ้ป็น Manual ดงันัน้กอ่นทีจ่ะ

บนัทกึ Macro ใหป้รับระบบใหเ้ป็น Automatic หรอืตวัเลอืกอืน่ไวก้อ่น 

With Application 

    .Calculation = xlManual 

    .MaxChange = 0.001 

End With 

 

เมือ่ปรับปรงุรหสัเองใหส้ัน้ลง 

Application.Calculation = xlManual 

คลกิเพือ่สรา้งรหสัทีจ่ํากดัตายตวั หรอืไมค่ลกิเพือ่สรา้งรหสัยดืหยุน่  

เมือ่ใดทีค่ลกิลงไปในชทีหรอืเซลล ์เมือ่นัน้ Macro Recorder จะสรา้งรหสั VBA ทีร่ะบุ

ชือ่ชทีหรอืตําแหน่งเซลลต์ายตวั เชน่ หากตอ้งการควบคมุใหบ้นัทกึเลข 123 ลงไปที่

เซลล ์A5 ของ Sheet3 ใหเ้ลอืกเซลลท์ีอ่ยูใ่นชทีอืน่กอ่น จากนัน้ใหเ้ริม่บนัทกึ Macro 

โดยคลกิเลอืก Sheet3 แลว้คลกิเซลล ์A5 พมิพเ์ลข 123 ลงไปแลว้กด Enter ซึง่จะ

เกดิรหสั VBA ซึง่จะทํางาน ณ ตําแหน่งเซลลเ์ดมิของชทีชือ่เดมิดว้ยเทา่นัน้  

Sheets("Sheet3").Select 

Range("A5").Select 

ActiveCell.FormulaR1C1 = "123"  

ตวัอยา่งนีห้ากใชว้ธิทีีไ่มค่ลกิ โดยใหค้ลกิเลอืกเซลล ์A5 ไวก้อ่น แลว้เริม่บนัทกึ Macro 

เพยีงขัน้เดยีว โดยพมิพเ์ลข 123 ลงไปแลว้กด Enter จะเกดิรหสัซึง่สามารถนําไปใช ้

ตอ่ไดก้บัทกุตําแหน่งเซลล ์ 

ActiveCell.FormulaR1C1 = "123" 
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ฝึกใชค้าํส ัง่ลดัจากแป้นพมิพ ์เพือ่สรา้งรหสัทีย่ดืหยุน่  

ดงัทีอ่ธบิายไวใ้นเบือ้งตน้แลว้วา่ วธิคีลกิเมนู คลกิเซลล ์หรอืคลกิเพือ่เลอืกสิง่ที่

ตอ้งการบนหนา้จอ จะสรา้งรหสัทีต่ายตวั ไมส่ามารถนํารหสัไปใชต้า่งทีต่า่งเวลา

แตกตา่งจากสถานการณ์เดมิ แทนทีจ่ะคลกิ ขอใหใ้ชแ้ป้นพมิพใ์นระหวา่งการบนัทกึ 

Macro ซึง่ทัง้นีว้ธิใีชแ้ป้นพมิพท์ีด่แูลว้วา่ ทํางานเหมอืนกนั ไมจํ่าเป็นวา่จะเกดิรหสัจาก

การบนัทกึทีย่ดืหยุน่เสมอไป 

สมมตวิา่ ในตารางมขีอ้มลูบนัทกึไวใ้นเซลล ์A1:D2 แลว้เราตอ้งการสรา้งรหสั VBA 

เพือ่เลอืกพืน้ทีท่ีเ่ก็บขอ้มลู จะสามารถใชแ้ป้นพมิพเ์ลอืกพืน้ทีเ่ดยีวกนันีไ้ดห้ลายแบบ 

และรหสัแตล่ะแบบจะมคีวามยดืหยุน่มากนอ้ยตา่งกนั  

 

กอ่นทีจ่ะเริม่บนัทกึ Macro ขอใหค้ลกิเลอืกเซลล ์A1 ไวก้อ่นจากนัน้จงึเริม่บนัทกึ 

Macro ตามการใชแ้ป้นพมิพไ์ดห้ลายวธิ ี

วธิที ี ่1 กดปุ่ ม Ctrl+* เพือ่เลอืก Current Region รหสั VBA ทีเ่กดิขึน้คอื 
 

Selection.CurrentRegion.Select  

วธิที ี ่2 ตอ้งบนัทกึ 2 ข ัน้ตอน 

1. กดปุ่ ม Ctrl+Shift+ลกูศรขวา พรอ้มกนั จากนัน้  

2. กดปุ่ ม Ctrl+Shift+ลกูศรชีล้ง พรอ้มกนั  

Range(Selection, Selection.End(xlToRight)).Select 

Range(Selection, Selection.End(xlDown)).Select 

วธิที ี ่3 ตอ้งใชแ้ป้นพมิพเ์ลอืกทลีะเซลลจ์ากขวามาซา้ย ตามดว้ยจากบนมาลา่ง 

1. กดปุ่ ม Shift พรอ้มกบักดปุ่ มลกูศรขวา 3 ครัง้  

2. กดปุ่ ม Shift พรอ้มกบักดปุ่ มลกูศรลง 1 ครัง้  
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Range("A1:D2").Select 

วธิที ี ่4 กดปุ่ ม Ctrl+Shift+End เพือ่เลอืกจนถงึเซลลข์วาลา่งสดุของตาราง 
 

Range(Selection, _ 

ActiveCell.SpecialCells(xlLastCell)).Select 

วธิที ี ่5 วธินี ีใ้ชห้ลกัเลอืกยอ้นจากลา่งขึน้บน  

1. กดปุ่ ม F5 ไปเลอืกเซลล ์D65536 บรรทดัลา่งสดุของตาราง  

2. กดปุ่ ม End แลว้ตามดว้ยปุ่ มลกูศรชีข้ ึน้ เพือ่เลอืกเซลล ์D2  

3. กดปุ่ ม Ctrl+Shift พรอ้มกบัปุ่ ม Home เพือ่เลอืกยอ้นกลบัมาเซลล ์A1  

Application.Goto Reference:="R65536C4" 

Selection.End(xlUp).Select 

Range(Selection, Cells(1)).Select 

ทัง้ 5 วธิสีามารถใชเ้ลอืกพืน้ทีต่ารางจากเซลล ์A1:D2 คอื เซลลท์ีม่เีลข 11 จนถงึ

เซลลท์ีม่เีลข 88 ไดเ้หมอืนกนั แตว่ธิทีีย่ดืหยุน่คอืวธิทีี ่5 วธิเีดยีวเทา่นัน้ เพราะสามารถ

นํามาใชเ้ลอืกพืน้ที ่จากเซลลท์ีม่เีลข 11 จนถงึเซลลท์ีม่เีลข 88 ไดเ้หมอืนเดมิ แมว้า่

ตารางจะมลีกัษณะเปลีย่นไป ไมไ่ดม้ขีอ้มลูในเซลลต์ดิตอ่กนัเชน่เดมิ 

 

ตวัอยา่งนีแ้สดงใหเ้ห็นวา่ เป็นหนา้ทีข่องผูใ้ช ้Excel ทีจ่ะตอ้งเลอืกใชว้ธิใีชแ้ป้นพมิพ์

อยา่งชาญฉลาดดว้ย จงึจะทําให ้Macro Recorder สรา้งรหสั VBA ทีย่ดืหยุน่ สามารถ

นํามาใชก้บังานทีม่โีครงสรา้งขอ้มลูแตกตา่งไปจากเดมิ โดยทีเ่ราไมต่อ้งเสยีเวลา

กลบัมาเขยีนปรับปรงุแกไ้ขรหสัในภายหลงั  
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ใช ้Range Name แทนตาํแหนง่อา้งองิโดยตรง 

รหสัทีถ่กูบนัทกึหรอืเขยีนไวใ้น VBE จะคงทีต่ามเดมิไปตลอด ไมม่กีารเปลีย่นแปลง

แกไ้ขสว่นหนึง่สว่นใดอกีตอ่ไป จนกวา่เราจะเขา้ไปแกไ้ขเอง ซึง่เป็นจดุออ่นทีสํ่าคญั

ของตวั VBE ทําใหเ้กดิปัญหาแทบทกุครัง้ทีโ่ครงสรา้งขอ้มลู ชือ่ชที หรอืตําแหน่งเซลล์

ในตารางเปลีย่นทีไ่ปจากเดมิ สง่ผลให ้VBA ทํางานผดิพลาด จนกวา่เราจะเขา้ไป

ปรับปรงุรหสัทีอ่า้งถงึตําแหน่งตา่งๆในตารางตามจรงิอกีครัง้ 

ตามตวัอยา่งขา้งตน้ หากตอ้งการใช ้VBA เลอืกพืน้ทีต่ัง้แตเ่ซลลท์ีม่เีลข 11 จนถงึ

เซลลท์ีม่เีลข 88 ใหใ้ชเ้มนู Formulas > Define Name ตัง้ชือ่ Range A1:D2 

สมมตวิา่ใชช้ือ่ Range Name วา่ MyData  

จากนัน้ใหใ้ช ้Macro Recorder บนัทกึการกดปุ่ ม F5 แลว้เลอืกชือ่ Range Name 

ชือ่ MyData ทีแ่สดงขึน้ จะทําใหเ้กดิรหสั VBA ดงันี ้

Application.Goto Reference:="MyData" 

ซึง่จะพบวา่รหสัเพยีงบรรทดัเดยีวนีส้ามารถใชง้านไดต้ลอดไป โดยไมต่อ้งเสยีแรง

เสยีเวลากลับมาแกไ้ขอะไรอกี ไมว่า่จะมกีารยา้ยตําแหน่งขอ้มลูจากเดมิ A1:D2 ไปอยู่

ทีเ่ซลลอ์ืน่ ชทีอืน่ หรอืแฟ้มอืน่ หรอืแมว้า่ตารางทีเ่ก็บขอ้มลูเดมินัน้ ไมไ่ดม้เีซลลเ์ก็บ

ขอ้มลูตอ่เนือ่งกนัเชน่เดมิแลว้ก็ตาม 

บนัทกึส ัน้ๆ แลว้นํามาตอ่กนัใหย้าวขึน้ 

ในการบนัทกึ Macro แตล่ะครัง้ ขอใหบ้นัทกึขัน้ตอนทํางานสัน้ๆ พยายามบนัทกึ

ขัน้ตอนใหส้ัน้ทีส่ดุ เพือ่ทําใหเ้กดิรหัสแตล่ะงานถกูบนัทกึเป็น Sub Procedure แยก

ออกจากกนั ชว่ยทําใหเ้ราสามารถเรยีนรูแ้ละแกไ้ขรหสัไดง้า่ย ตอ่เมือ่ผา่นการทดลอง

ทดสอบแลว้วา่ รหสัทัง้หมดสามารถทํางานไดต้ามตอ้งการ จงึนําชือ่ Sub Procedure 

ทีไ่ดนั้น้มาเขยีนตามลําดบัทีใ่ชง้าน รวมไวใ้น Sub Procedure ชดุใหม ่เพือ่ชว่ยทําให ้

เราสามารถสัง่งานเพยีงครัง้เดยีว แลว้รหสัทัง้หมดจะทํางานตอ่เนือ่งกนัใหเ้อง  

ตวัอยา่งเชน่ เดมิม ีSub Procedure ทีเ่กดิจากการบนัทกึ 3 ครัง้ ตัง้ชือ่ Macro Name 

ไวว้า่ MyWork1, MyWork2, และ MyWork3  
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ใหเ้ขยีน Sub Procedure ใหมเ่พือ่รวมคําสัง่เดมิทัง้ 3 ชดุมาไวท้ีเ่ดยีวกนั ตามแบบดงันี ้

Sub RunAllMyWorks() 

    MyWork1 

    MyWork2 

    MyWork3 

End Sub  
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วธิใีช ้Macro Recorder ชว่ยในการเรยีนรู ้VBA 

คนทีเ่พิง่เริม่ฝึกใช ้VBA หรอืแมแ้ตค่นทีใ่ช ้VBA มานาน มกัตดิปัญหาตรงทีไ่มรู่ว้า่ รหสั

คําสัง่ VBA ทีต่นตอ้งนํามาใชนั้น้เป็นอยา่งไร บางคนสามารถเปิดตําราคน้หารหสัไดแ้ลว้ 

แตไ่มรู่ว้า่จะดดัแปลงรหัสอยา่งไรไดบ้า้ง ครัน้ตดิปัญหา ไมส่ามารถแกไ้ขทําตอ่ดว้ย

ตนเอง ก็จะยกปัญหาขึน้ถามบนเว็บ พอไดคํ้าตอบไปใชง้านสกัพัก ตอ่มาไมน่านก็

กลบัมาถามหารหสัตอ่จากคําถามเดมิซํ้าแลว้ซํ้าอกี 

ขอย้ําอกีครัง้วา่ถา้อยากคดิใช ้VBA ตอ้งขอใหต้นเป็นทีพ่ึง่แหง่ตน เพราะ VBA มทีัง้คณุ

มทีัง้โทษ เป็นดาบสองคม หากคดิใช ้VBA แลว้ตอ้งใชใ้หเ้ป็น หาทางใชใ้หถ้กูวธิ ีทกุ

ครัง้ทีต่ดิปัญหา ตอ้งพยายามหาทางแกไ้ขดว้ยตนเองใหไ้ด ้ตอ่เมือ่หมดหนทางแลว้จงึ

สอบถามจากผูม้คีวามรู ้และทําความเขา้ใจกบัคําตอบทีไ่ดรั้บมา อยา่ทอ่ง อยา่ลอก 

อยา่เอาไปใชโ้ดยปราศจากความเขา้ใจ  

ในบทนีจ้ะแนะนําวธิใีช ้Macro Recorder ชว่ยในการเรยีนรู ้VBA จะไดทํ้าตนใหเ้ป็นที่

พึง่ของตนเสยีกอ่น 

ตวัอยา่งที ่1 : ตอ้งการเปลีย่นชือ่ชที ใหม้ชีือ่ใหมต่ามคา่ทีอ่ยูใ่น
เซลล ์A1 

สมมต ิเดมิชทีมชีือ่วา่ Sheet1 เราตอ้งการเปลีย่นชือ่ชทีตามคา่ทีเ่ก็บไวใ้นเซลล ์A1 

เชน่ ถา้ A1 มคํีาวา่ MyJan ก็ใหร้หสั VBA ทําหนา้ทีเ่ปลีย่นชือ่ชทีเป็น MyJan และถา้ 

A1 มคีา่ใหม ่ก็ใหช้ือ่ชทีถกูเปลีย่นชือ่ใหมต่ามคา่ในเซลล ์A1 ไดต้ามตอ้งการ 

ข ัน้ที ่1 : ใช ้Recorder บนัทกึการคลกิเลอืกเซลล ์A1 แลว้พมิพคํ์าวา่ MyJan ลงไป 

จะไดร้หสั VBA :  

 
Range("A1").Select 

ActiveCell.FormulaR1C1 = "MyJan" 

ข ัน้ที ่2 : ใช ้Recorder บนัทกึการสัง่ Home > Format > Rename Sheet แลว้

พมิพคํ์าวา่ MyJan ทบัคําวา่ Sheet1 จะไดร้หสั VBA : 
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Sheets("Sheet1").Name = "MyJan"  

สงัเกตวา่ผลทีไ่ดจ้ากการบนัทกึขัน้ตอนนี ้แสดงวา่การกําหนดคา่ใหก้บัสิง่ใด ใหใ้ช ้

เครือ่งหมายเทา่กบั โดยสิง่ทีอ่ยูด่า้นซา้ยของเครือ่งหมายเทา่กบั ถอืเป็นสิง่ทีถ่กู

กําหนดคา่ ใหม้คีา่ตาม คา่ทีอ่ยูด่า้นขวาของเครือ่งหมายเทา่กบั 

ข ัน้ที ่3 : ทดลองเขยีน VBA โดยผสมรหสัทัง้สองขัน้เขา้ดว้ยกนัเป็นดังนี ้

 
Sub RenameSheet() 

    Sheets("Sheet1").Name = Range("A1") 

End Sub 

ซึง่จะพบวา่รหสัใน Sub Procedure ชือ่ RenameSheet นีทํ้างานไดเ้พยีงครัง้เดยีว 

เนือ่งจากตวัรหสั Sheets("Sheet1").Name กําหนดไวว้า่ ใหเ้ปลีย่นชทีทีม่ชี ือ่วา่ 

Sheet1 ดงันัน้หากในแฟ้มไมม่ชีทีชือ่ Sheet1 เพราะถกูเปลีย่นชือ่ชทีเป็น MyJan ไป

แลว้ รหสัจงึไมส่ามารถทํางานตามตอ้งการ  

ขอใหส้งัเกตยอ้นกลบัไปดรูหสัทีไ่ดจ้ากขัน้แรก จะเห็นวา่มรีหสัคําวา่ ActiveCell ซึง่มี

หมายถงึเซลลตํ์าแหน่งใดก็ได ้ขอเพยีงแตกํ่าลงัถกูเลอืกใชง้านอยู ่จงึมคํีาวา่ Active 

นําหนา้ สงสยัไหมวา่ในเรือ่งของชทีนัน้ม ีActiveSheet ดว้ยไหม คราวนีใ้หล้องใชคํ้าวา่ 

ActiveSheet คน้หาใน Help ดจูะพบคําอธบิาย ดงันี ้

ActiveSheet Property  

Returns an object that represents the active sheet (the sheet on top) in the active 

workbook or in the specified window or workbook. Returns Nothing if no sheet is 

active. Read-only.  

Remarks  
If you don’t specify an object qualifier, this property returns the active sheet in the 

active workbook.  

If a workbook appears in more than one window, the ActiveSheet property may be 

different in different windows.  

Example  
This example displays the name of the active sheet.  

MsgBox "The name of the active sheet is " & ActiveSheet.Name  
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ถา้อยากอา่นคําอธบิายทลีะบรรทดัก็ตามใจ แตส่ว่นสําคญัทีส่ดุทีค่วรดเูป็นจดุแรกก็คอื

ตวัอยา่งทีแ่สดงไว ้จะเห็นวา่มคํีาสัง่ ActiveSheet.Name ซึง่แปลวา่ ชือ่ชทีของชทีที่

กําลงัเลอืกอยู ่และน่าจะนํามาใชแ้ทนคําวา่ Sheets("Sheet1").Name ได ้ 

ข ัน้ที ่4 : กลบัไปแกร้หัสทีเ่ขยีนเองใหม ่แลว้จะพบวา่รหสัชดุนีทํ้างานไดต้ลอด 

 
Sub RenameSheet() 

    ActiveSheet.Name = Range("A1") 

End Sub 

 

หมายเหต ุถา้คน้หาคําวา่ Active จาก Help จะพบวา่นอกจาก ActiveCell และ 
ActiveSheet แลว้ยงัม ีActiveWorkbook, ActiveWindow, ActiveChart, 
ActivePane, และ ActivePrinter ใหเ้ลอืกนํามาใชไ้ด ้ 

  

ตวัอยา่งที ่2 : ตอ้งการจดัเก็บแฟ้ม โดยใชช้ือ่แฟ้มตามคา่ทีอ่ยูใ่น
เซลล ์A1 

ตวัอยา่งนีต้อ้งการใหร้หสัทํางานคลา้ยกบัตวัอยา่งแรก เพยีงแตค่ราวนีใ้หเ้ปลีย่นชือ่

แฟ้มแทนทีจ่ะเป็นชือ่ชที  

ข ัน้ที ่1 : ขอใหล้องเขยีนรหสัเองขึน้มา โดยเลยีนแบบตวัอยา่งแรก  

 
Sub RenameWorkbook() 

    ActiveWorkbook.Name = Range("A1") 

End Sub 

 

เมือ่สัง่ Run จะพบวา่รหสัชดุนีไ้มทํ่างาน โดยมคํีาเตอืนวา่ Compile error ในขัน้นีไ้ม่

ตอ้งสนใจวา่ Compile error คอือะไร เพยีงขอใหส้งัเกตวา่ รหสัไมทํ่างาน แสดงวา่

ตอ้งมอีะไรทีผ่ดิพลาด และถา้สงัเกตตอ่ใหด้จีะพบวา่เมือ่คลกิ OK ออกจากคําเตอืน 

Compile error แลว้ VBE จะเลอืกคําวา่ .Name ไว ้เป็นอาการทีช่ ีใ้หเ้ราเห็นวา่ สว่นที่

ผดิพลาดน่าจะเป็นสว่นของคําวา่ .Name นีเ่อง 
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ทกุครัง้ทีร่หสัไมทํ่างาน ใหค้ลกิปุ่ ม Reset ซึง่เป็นปุ่ มสีเ่หลีย่มบนเมนูกอ่น มฉิะนัน้จะทํา

อยา่งอืน่ตอ่ไมไ่ดเ้ลย  

ข ัน้ที ่2 : ใช ้Recorder บนัทกึการสัง่ File > Save as เป็นชือ่แฟ้มใหม ่สมมตใิหใ้ช ้

ชือ่วา่ MyMonth.xls จะไดร้หสั VBA : 

 
ActiveWorkbook.SaveAs Filename:= _ 

"C:\MyMonth.xls", FileFormat:= _ 

xlNormal, Password:="", WriteResPassword:="", _ 

ReadOnlyRecommended:=False _ 

, CreateBackup:=False  

ข ัน้ที ่3 : ทดลองตดัรหัสในขัน้ที ่2 ใหส้ัน้ลงเหลอืเทา่ทีต่รงกบัการจัดเก็บแฟ้มตามชือ่

ทีต่อ้งการ แลว้ทดสอบวา่รหสัใหมน่ีทํ้างานไดห้รอืไม ่ซึง่จะพบวา่รหสัทํางาน เพยีงแต่

จะถกูถามวา่ ตอ้งการใหต้อ้งการจัดเก็บในชือ่นีห้รอืไม ่เพราะมแีฟ้มชือ่นีอ้ยูแ่ลว้  

 
ActiveWorkbook.SaveAs Filename:="MyMonth.xls"  

ข ัน้ที ่4 : ยอ้นกลบัไปแกร้หสัในขัน้ที ่1 แลว้จะพบวา่รหสัทํางานไดต้ามตอ้งการ  

Sub RenameWorkbook() 

    ActiveWorkbook.SaveAs Filename: = Range("A1") 

End Sub 
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ตวัอยา่งที ่3 : ตอ้งการจดัปิดแฟ้ม โดยไมต่อ้งจดัเก็บซํา้อกี 

ข ัน้ที ่1 : ตวัอยา่งนีต้อ้งเปิดแฟ้มใหมข่ึน้อกีแฟ้มหนึง่ เพือ่ใชเ้ก็บรหสัทีไ่ดจ้ากการ

บนัทกึการปิดแฟ้ม โดยมขีัน้ตอนใช ้Recorder บนัทกึ ดงันี ้

1. คลกิเมนู View > Switch Windows > เลอืกชือ่แฟ้มทีต่อ้งการปิด สมมติ

วา่ชือ่ MyMonth.xls  

2. คลกิเมนู File > Close  

จะเกดิรหสั VBA : 

Windows("MyMonth.xls").Activate 

ActiveWorkbook.Close  

ข ัน้ที ่2 : ให ้copy รหสัเฉพาะ ActiveWorkbook.Close มาสรา้ง Sub Procedure ลง

ใน MyMonth.xls  

 
Sub CloseMyFile() 

    ActiveWorkbook.Close 

End Sub 

เมือ่ทดสอบรหสันีห้ลายๆครัง้ จะพบวา่ถา้ในแฟ้มมขีอ้มลูใหม ่จะมคํีาเตอืนเปิดขึน้บนจอ

วา่ คณุตอ้งการจัดเก็บขอ้มลูทีเ่ปลีย่นแปลงหรอืไม ่ 

ข ัน้ที ่3 : ถา้อยากใชคํ้าสัง่ปิดแฟ้ม โดยไมต่อ้งถามเรือ่งการจัดเก็บขอ้มลูใหม ่คราวนี้

ตอ้งศกึษาจาก Help โดยใหค้ลกิทีร่หสัคําวา่ Close จากนัน้กดปุ่ ม F1 จะมตีวัอยา่ง

แสดงไวใ้นคําอธบิายของ Help ดงันี ้

Workbooks("BOOK1.XLS").Close SaveChanges:=False 

ข ัน้ที ่4 : กลบัไปแกไ้ขรหสัเดมิ โดยนําคําวา่ SaveChanges:=False ไปเพิม่ตอ่ทา้ย

รหสัเดมิ จะพบวา่คราวนีไ้มม่คํีาเตอืนเปิดขึน้บนจอวา่ คณุตอ้งการจัดเก็บขอ้มลูที่

เปลีย่นแปลงหรอืไม ่
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Sub CloseMyFile() 

    ActiveWorkbook.Close SaveChanges:=False 

End Sub 

หมายเหต ุ: หากศกึษาคําอธบิายจาก Help จะพบวา่ คําสัง่ Close นัน้ สามารถเขยีน

อกีรปูแบบหนึง่ คอื expression.Close(SaveChanges, Filename, 

RouteWorkbook) โดยใชว้งเล็บกําหนดตวัเลอืกตอ่ๆกนัไป ทําใหร้หสัสัน้ลงเป็น 

Sub CloseMyFile() 

    ActiveWorkbook.Close(False) 

End Sub  
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วธิสีรา้งชุดคาํส ัง่ควบคมุระบบเมือ่เปิดปิดแฟ้ม 

ปัญหาหนึง่ซึง่เกดิกบัทกุคนทีต่อ้งแบง่กนัใชเ้ครือ่งคอมพวิเตอรเ์ครือ่งเดยีวกนัทํางาน 

มกัพบวา่ เมือ่เปิดโปรแกรม Excel ขึน้มาแตล่ะครัง้ จะพบหนา้ตาของเมนู หรอืสภาพ

พืน้ทีข่องแฟ้มแรกวา่งๆทีเ่ห็นบนหนา้จอ ชอบเปลีย่นตําแหน่งหนา้ตาแตกตา่งไปจาก

เดมิทีต่นเคยใช ้เพราะเพือ่นคนทีใ่ช ้Excel คราวกอ่น อาจปรับตําแหน่งเมนู และระบบ

ตา่งๆของ Excel ใหถ้กูใจตน ... แตไ่มถ่กูใจคนอืน่เขา 

ดงันัน้แทนทีจ่ะตอ้งเสยีเวลาปรับระบบของ Excel ใหถ้กูใจ เรามาใช ้Macro Recorder 

บนัทกึรหสัเพือ่ทําหนา้ทีป่รับระบบใหท้นัทเีมือ่เปิดแฟ้มขึน้มาดกีวา่ พอเปิดแฟ้มขึน้มา 

ก็ใหร้ะบบปรับตวัเองทนัท ีและเมือ่ปิดแฟ้มก็ใหป้รับระบบกลบัสูส่ภาพแรกสดุ เหมอืน

สมยัทีเ่พิง่เปิดใช ้Excel เป็นครัง้แรก  

วธิใีช ้Macro Recorder ตอ่ไปนี ้มขีอ้สําคญัอยูท่ีช่ ือ่ของ Macro วา่ตอ้งตัง้ชือ่วา่ 

Auto_Open และ Auto_Close เทา่นัน้ หา้มตัง้ชือ่เป็นอยา่งอืน่ โดย Auto_Open 

จะถกูสัง่ใหทํ้างานเองทนัทเีมือ่แฟ้มทีเ่ก็บรหสันีถ้กูเปิดขึน้ และ Auto_Close จะถกูสัง่

ใหทํ้างานทันทเีมือ่แฟ้มทีเ่ก็บรหสันีถ้กูสัง่ปิด 

กอ่นทีจ่ะเริม่บนัทกึ Macro อยา่ลมืปรับระบบ Excel ใหเ้ป็นตรงกนัขา้มกบัทีต่อ้งการไว ้

กอ่น เพราะระหวา่งการบนัทกึ Macro นัน้ เราจะไดเ้ห็นวา่คําสัง่ทีต่อ้งการนัน้ถกูเลอืก

จรงิ และ Macro Recorder จะสรา้งรหสัตาม  

ข ัน้ตอนการบนัทกึ Macro ชือ่ Auto_Open 

สมมต ิเราตอ้งการปรับหนา้จอของแฟ้มทีเ่ปิดขึน้มาใหด้เูหมอืนกระดาษทําการ หาทาง

ทําใหไ้มม่ลีักษณะใดทีจ่ะบง่บอกวา่เป็นตารางพืน้ที ่Worksheet ทัง้นีอ้าจใชก้บัการ

เสนอผลงาน Presentation หรอืใชก้บังานทัว่ไปทีต่อ้งการปิดบงัไมใ่หผู้ใ้ช ้Excel 

สงสยัหรอืรูว้า่ หนา้จอทีเ่ปิดขึน้นัน้เป็นตาราง Excel  
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(หลกัการใช ้Excel ทีด่ ีเมือ่สรา้งงานเสร็จแลว้ ควรปรับสภาพหนา้จอใหด้เูหมอืน

กระดาษ เพือ่ทําใหผู้ใ้ชง้านรูส้กึเหมอืนวา่ ตนกําลงัทํางานอยูบ่นหนา้กระดาษทีต่นเอง

คุน้เคย ไมใ่ชต่าราง Excel เพือ่ทําใหผู้ใ้ชเ้กดิความสบายใจมากขึน้) 

เริม่ตน้บนัทกึ Macro โดยกําหนดชือ่ Macro Name : Auto_Open และเลอืกใช ้

Ctrl+q หรอืใชปุ้่ มอืน่ก็ไดเ้ป็น Shortcut Key แลว้บนัทกึขัน้ตอนคําสัง่ตอ่ไปนี ้

1. สัง่ Formulas > Calculation Options > กาชอ่ง Manual  

2. สัง่ View > ตดักาชอ่ง Gridlines เพือ่ตดัเสน้ตาราง  

3. สัง่ View > ตดักาชอ่ง Headings เพือ่ตดัหวัตารางทีบ่อกวา่เป็น row และ 

column ใด  

4. สัง่ View > ตดักาชอ่ง Formula Bar เพือ่ชอ่งใสส่ตูร 

5. สัง่ View > Full Screen เพือ่ตดัเมนูทิง้ ขยายพืน้ทีแ่สดงตาราง  

6. กดปุ่ ม Esc เพือ่ยอ้นกลบัมาสูจ่อตามขนาดเดมิจะไดก้ดปุ่ ม Stop ได ้

 ในชดุคําสัง่ทีเ่กดิขึน้ ใหต้ดัคําสัง่สดุทา้ยทิง้โดยทําใหเ้ป็น Comment  

Sub Auto_Open() 

' 

' Auto_Open Macro 

' 

' Keyboard Shortcut: Ctrl+q 

' 

    Application.Calculation = xlManual 

    Application.DisplayFormulaBar = False 

    ActiveWindow.DisplayHeadings = False 

    ActiveWindow.DisplayGridlines = False 

    Application.DisplayFullScreen = True 

‘    Application.DisplayFullScreen = False กําหนดคําสัง่นีใ้หเ้ป็น comment 

End Sub  

เมือ่สัง่ให ้Auto_Open ทํางาน จะปรับระบบการคํานวณเป็น Manual และหนา้จอใหดู้

เหมอืนกระดาษ  
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ข ัน้ตอนการบนัทกึ Macro ชือ่ Auto_Close 

ขัน้ตอนทีใ่ชบ้นัทกึ Macro ในชือ่ Auto_Close นัน้ จํางา่ยๆวา่ ทําตามขัน้ตอนของ 

Auto_Open เพยีงแตใ่หทํ้าตรงกนัขา้มใหห้มด (หรอืจะเพิม่คําสัง่อืน่ก็ไดท้ีเ่ห็นวา่ ควร

ปรับระบบของ Excel ใหเ้หมาะกบังานทัว่ไป)  

กอ่นจะเริม่บนัทกึ Macro ใหก้ดปุ่ ม Esc เพือ่แสดงเมนูใหเ้ห็น เมือ่บนัทกึใหกํ้าหนดชือ่ 

Macro Name : Auto_Close และเลอืกใช ้Ctrl+w หรอืใชปุ้่ มอืน่ก็ไดเ้ป็น Shortcut 

Key แลว้บนัทกึขัน้ตอนคําสัง่ตอ่ไปนี ้

1. สัง่ Formulas > Calculation Options > กาชอ่ง Automatic  

2. สัง่ View > กาชอ่ง Gridlines เพือ่ตดัเสน้ตาราง  

3. สัง่ View > กาชอ่ง Headings เพือ่ตดัหวัตารางทีบ่อกวา่เป็น row และ 

column ใด  

4. สัง่ View > กาชอ่ง Formula Bar เพือ่ชอ่งใสส่ตูร 

ใหแ้กช้ดุคําสัง่ทีเ่กดิขึน้ โดยลอกคําสัง่ Application.DisplayFullScreen = False มา

ใสเ่พิม่ 
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Sub Auto_Close() 

' 

' Auto_Close Macro 

' 

' Keyboard Shortcut: Ctrl+w 

' 

    Application.DisplayFullScreen = False   ‘ลอกมาใสเ่พิม่ 

    Application.Calculation = xlAutomatic 

    Application.DisplayFormulaBar = True 

    ActiveWindow.DisplayHeadings = True 

    ActiveWindow.DisplayGridlines = True     

End Sub 

เมือ่สัง่ให ้Auto_Close ทํางาน จะปรับระบบการคํานวณเป็น Automatic และหนา้จอ

กลบัสูส่ภาพเดมิ 
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ทดลองแกไ้ขรหสัใหท้ํางานกลบัไปกลบัมาทกุคร ัง้ทีส่ ัง่ใหท้ํางาน 

ขอใหส้งัเกตรหสัทีไ่ดจ้ากการบนัทกึ Macro ขา้งตน้ จะเห็นวา่ใชคํ้าสัง่ใหเ้ทา่กบั True 

หรอื False เพือ่สัง่ใหทํ้าหรอืไมทํ่าตาม ซึง่หมายถงึสัง่ใหทํ้าตรงกนัขา้มกบัสถานะเดมิ 

ดงันัน้เราจงึสามารถใชร้หสัคําสัง่ตอ่ไปนี ้เพือ่ปรับการแสดง Full Screen ใหก้ลบัไป

ซอ่นเมนูแลว้กลบัมาตามเดมิได ้โดยใชคํ้าสัง่บรรทดัเดยีวและใชร้หสั NOT ชว่ยให ้

ทํางานกลบักนั ดงันี ้

Sub ReverseFullScreen() 

Application.DisplayFullScreen = Not Application.DisplayFullScreen 

End Sub  

ทกุครัง้ทีร่หสัคําสัง่ชดุนีทํ้างาน จะปรับหนา้จอใหต้รงกนัขา้มกบัสถานะเดมิ เชน่ ถา้เดมิ

ไมไ่ดเ้ป็น Full Screen พอใชคํ้าสัง่นีจ้ะกลายเป็น Full Screen แตถ่า้สัง่ซํ้าอกีครัง้จะ

กลบัเป็นสภาพเดมิทีไ่มไ่ดเ้ป็น Full Screen  
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รหสั VBA ทีย่ดืหยุน่ตามการเปลีย่นแปลงใน Excel 

เมือ่เปรยีบเทยีบโปรแกรม Excel กบั VBE ในเรือ่งความยดืหยุน่แลว้จะพบวา่ รหสัทัว่ไป

ทีเ่ขยีนลงไปใน VBE จะไมป่รับตวัเองใหส้อดคลอ้งกบัโครงสรา้งตารางในชทีที่

เปลีย่นไป จงึถอืเป็นจดุออ่นสําคญั และสง่ผลเสยีทําใหเ้ราตอ้งเสยีเวลายอ้นกลบัมา

ตามแกไ้ขรหสัซํ้าแลว้ซํ้าอกีอยูเ่สมอ 

ลองพจิารณารหสัทีไ่ดจ้ากการใช ้Macro Recorder บนัทกึการไลค่ลกิหาแฟ้ม ตอ่ดว้ย

คลกิหาชที แลว้คลกิหาเซลลท์ีต่อ้งการพมิพเ์ลข 123 ลงไป  

Windows("Book1.xls").Activate 

Sheets("Sheet1").Select 

Range("A1").Select 

ActiveCell.FormulaR1C1 = "123" 

จะพบวา่ กวา่จะกําหนดตําแหน่งเซลล ์A1 ทีต่อ้งการ จะตอ้งระบชุือ่แฟ้มและชือ่ชทีลง

ไปในตวัรหสั แลว้ตอ่มาถา้เซลลเ์ก็บขอ้มลูถกูยา้ยไปเซลลอ์ืน่แทน A1 จะสง่ผลใหร้หัส

ชดุนีไ้มทํ่างานตามเดมิ 

นอกจากรหสัทีไ่ดจ้าก Recorder แลว้ รหสัทีเ่ขยีนขึน้เอง เพือ่ทําหนา้ทีเ่ชน่เดยีวกบัชดุ

รหสัขา้งตน้ แมม้รีหสัสัน้ลงเหลอืเพยีงบรรทดัเดยีว แตย่งัจําเป็นตอ้งระบชุือ่แฟ้ม ชือ่ชที 

และตําแหน่งเซลล ์ซึง่เป็นเหตใุหไ้มย่ดืหยุน่เชน่กนั  

Workbooks("Book1.xls"). 

Worksheets("Sheet1").Range("A1") = 123  

ขอใหส้งัเกตวา่ รหสัทีไ่ดจ้าก Recorder และรหสัทีเ่ขยีนเองนี ้แมจ้ะทําใหไ้ดค้า่ 123 

ใสล่งไปในเซลล ์A1 ไดเ้ชน่เดยีวกนัก็ตาม แตร่หสัทีเ่ขยีนเองจะชว่ยสง่เลข 123 ลงไป

ในเซลล ์A1 ใหโ้ดยไมจํ่าเป็นตอ้งยา้ยไปเลอืกเซลล ์A1 สง่ผลให ้Excel ทํางานไดเ้ร็ว

ขึน้ดว้ย เนือ่งจากไมต่อ้งเสยีเวลาเลอืกเซลลซ์ึง่เกดิจากคําสัง่ Select  
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วธิใีช ้Range Name เพือ่ทําใหร้หสั VBA เกดิความยดืหยุน่ 

Range Name เป็นชือ่ทีเ่ราตัง้ขึน้ใหก้บัเซลล ์โดยจะเป็นเซลลเ์ดยีว หรอืหลายเซลลก์็

ได ้ซึง่ชือ่ Range Name ทีต่ัง้ขึน้นีน้อกจากจะชว่ยทําใหส้ตูรมคีวามหมายชดัเจนในตวั 

มากกวา่การใชส้ตูรอา้งองิจากเซลลโ์ดยตรง (เชน่ เดมิใชส้ตูรหากําไร =A1-B1 แต่

ตอ่มาใช ้Range Name แทนจะเห็นสตูร =Income-Cost) เรายงัใช ้Range Name 

ชว่ยทําใหร้หสั VBA ทีม่อียูนั่น้ ไมจํ่าเป็นตอ้งถกูแกไ้ขเปลีย่นแปลงอกีตอ่ไป 

วธิตีัง้ชือ่ Range Name ใหก้บัเซลล ์สามารถใชว้ธิงีา่ยๆโดยคลกิเลอืกเซลลห์รอืพืน้ที่

ตารางทีต่อ้งการกอ่น จากนัน้ใหพ้มิพช์ือ่ลงในชอ่ง Name Box ซึง่อยูด่า้นซา้ยสดุของ 

Formula Bar หรอืจะใชเ้มนู Formulas > Define Name  ตัง้ชือ่แทนการใช ้Name 

Box ก็ได ้ 

สมมตวิา่ ตอ้งการตัง้ชือ่เซลล ์A1 วา่ Target ใหค้ลกิทีเ่ซลล ์A1 กอ่นจากนัน้พมิพคํ์าวา่ 

Target ลงไปในชอ่ง Name Box แลว้กด Enter รับชือ่ลงไป 
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หรอืใชว้ธิตีัง้ชือ่ผา่นเมนู Formulas > Define Name 

 

หลกัการต ัง้ชือ่ Range Name ทีด่ ีใหใ้ชต้วัอกัษรภาษาองักฤษตวัใหญผ่สมตวัเล็ก 

อยา่ใชต้วัใหญท่ัง้หมดหรอืตวัเล็กทัง้หมด ถา้อยากจะแทรกตวัเลขลงไปในชือ่ก็ได ้

เพยีงแตต่อ้งใชต้วัอกัษรเป็นตวัแรกในชือ่กอ่น สว่นชือ่ทีต่ัง้นัน้ควรตัง้ใหส้ือ่ถงึ

ความหมายตรงกบัเรือ่งทีเ่ราตอ้งการ และพยายามอยา่ตัง้ชือ่ทีอ่าจซํ้ากบัชือ่ทีใ่ชเ้รยีก

ภายใน Excel หรอื VBE เชน่ Sheet, Cell, Range, AB123 เป็นตน้ 

วธินํีาชือ่ Range Name มาใชใ้น VBE 

ถา้ใช ้Macro Recorder ใหบ้นัทกึเริม่จากคลกิเขา้ไปหาแฟ้มทีต่อ้งการใหไ้ดก้อ่น 

จากนัน้ใหก้ดปุ่ ม F5 แลว้ดบัเบลิคลกิชือ่ทีต่อ้งการ จะไดร้หสั VBA 

 
Windows("Book1.xls").Activate 

Application.Goto Reference:="Target" 

ActiveCell.FormulaR1C1 = "123"  

ถา้เขยีนรหสัเอง ใหใ้ช ้Target แทนลงไปในสว่นของชือ่ชทีและตําแหน่งเซลล ์ดงันี ้

Windows("Book1.xls").Activate 

Range("Target") = 123 

หมายเหต ุแมจ้ะใช ้Range Name ชว่ยทําใหร้หสั VBA ยดืหยุน่ตามการเปลีย่นแปลง

ใน Excel ไดแ้ลว้ก็ตาม แตย่งัจําเป็นตอ้งใชคํ้าสัง่ Windows("Book1.xls").Activate 
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พาไปยงัแฟ้มทีม่ ีRange Name ชือ่ Target กอ่นเสมอ หรอืถา้ไมต่อ้งการใสบ่รรทดันี ้

เราตอ้งเตรยีมใหแ้ฟ้ม Book1.xls เป็นแฟ้มทีกํ่าลงัถกูเลอืกใชง้านไวก้อ่น จากนัน้จงึจะ

ใชคํ้าสัง่เพยีง Range("Target") = 123 เพราะ VBE จะตามหา Range Name ชือ่ 

Target ไดจ้ากแฟ้มทีม่ชี ือ่ Target ตัง้ไวแ้ลว้เทา่นัน้ 

วธิยีอ่รหสั VBA ทีใ่ชช้ือ่ Range Name ใหส้ ัน้ลงโดยใช ้[ ] 

แทนทีจ่ะตอ้งเสยีเวลาพมิพตํ์าแหน่งเซลลท์ีต่อ้งการวา่ Range("Target") เราสามารถ

ใชว้ธิ ีEvaluate ผา่นเครือ่งหมาย [ ] ทําใหร้หสัสัน้ลงเหลอืเพยีง [Target] ดงันัน้หาก

เรากําลงัเปิดแฟ้มทีม่ ีRange Name ชือ่ Target อยูแ่ลว้ และตอ้งการสง่ตวัเลข 123 

ไปทีเ่ซลลช์ือ่ Target จงึใชร้หสั VBA ทีเ่ขยีนสัน้ๆงา่ยๆ ดงันี ้

[Target] = 123 

การ Evaluate เป็นการสัง่ใหต้วั VBE ประเมนิวา่ คําวา่ Target คอือะไร ซึง่เนือ่งจาก

แฟ้มทีกํ่าลงัใชง้านอยูม่ ีRange Name ชือ่ Target ดงันัน้ VBE จะทราบเองตอ่ไปวา่ 

ใหส้ง่เลข 123 ไปที ่Target ซึง่พบแลว้วา่เป็น Range Name คอืตําแหน่งเซลลท์ีต่ัง้

ชือ่ไวว้า่ Target น่ันเอง  

การ Evaluate ทําให ้VBE ทํางานชา้ลงไปบา้ง แตทํ่าใหเ้ราเขยีนรหสัอา้งถงึตําแหน่ง

อา้งองิไดง้า่ยกวา่เดมิมาก 
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VBA กบัการจดัการฐานขอ้มลู 

กอ่นจะเรง่รบีหาทางใช ้VBA มาจัดการกบัฐานขอ้มลู ยงัมคํีาสัง่บนเมนูหรอืสตูร

สําเร็จรปูของ Excel ทีนํ่ามาชว่ยงานจัดการฐานขอ้มลูไดอ้กี และเชือ่หรอืไมว่า่ ลกัษณะ

โครงสรา้งตารางทีใ่ชเ้ก็บขอ้มลูน่ันแหละเป็นสิง่สําคญัทีส่ดุ ถา้โครงสรา้งตารางจัดไวไ้ม่

ด ีออกแบบตารางไวผ้ดิ อยา่นกึเลยวา่จะใชคํ้าสัง่บนเมนู สตูร หรอืแมแ้ต ่VBA มาชว่ย

ในงานจัดการฐานขอ้มลูไดง้า่ยๆ 

โครงสรา้งตารางสําหรบัเก็บขอ้มลู 

 

ตารางฐานขอ้มลูทีด่ตีอ้งมลีกัษณะโครงสรา้ง ตามกฎ 3 ขอ้ดงันี ้

1. หวัตารางตอ้งใชพ้ืน้ทีเ่ซลล ์1 row เทา่น ัน้ จากภาพคอืพืน้ทีเ่ซลล ์B2, 

C2, D2 แตถ่า้อยากทําใหห้วัตารางมคํีาอธบิายเพิม่เตมิในอกีบรรทดั ใหใ้ช ้

วธิกีดปุ่ ม Alt+Enter เพือ่ขึน้บรรทดัใหมใ่นเซลลเ์ดมิตอ่ทา้ยขอ้ความเดมิ  

2. หา้มเวน้วา่ง row ท ัง้ row ของท ัง้รายการ เชน่ หา้มเวน้เซลล ์B3:D3 

หรอื B5:D5 เป็นตน้ และไมค่วรเวน้วา่งเซลลใ์ดเซลลห์นึง่โดยไมจํ่าเป็น 

โดยเฉพาะเซลลท์ีเ่ก็บขอ้มลูทีเ่ป็นรหสัหรอืชือ่สนิคา้ ซึง่ใชเ้ป็นขอ้มลู

สําหรับใชค้น้หาขอ้มลูอืน่ในแนวรายการเดยีวกนั  

3. หา้มนําตารางเก็บขอ้มลูไปตดิกบัเซลลข์อ้มลูอืน่ ทัง้ดา้นบน ดา้นลา่ง 

ดา้นซา้ย และดา้นขวาของตารางฐานขอ้มลู ตอ้งเวน้วา่งไวร้อบขา้งอยา่ง
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นอ้ย 1 เซลลโ์ดยตลอด เพือ่ทําให ้Excel รูจั้กวา่พืน้ทีเ่ซลลท์ีต่ดิตอ่กนันี้

เป็นตารางเดยีวกนั  

ตอ่เมือ่ออกแบบตารางฐานขอ้มลูไวถ้กูตอ้งแลว้ จะพบวา่เราสามารถใชคํ้าสัง่บนเมนู 

Data ตอ่ไปไดท้กุเมนู และใชง้านงา่ยขึน้ โดยไมจํ่าเป็นตอ้งเสยีเวลาเลอืกพืน้ทีต่าราง

ทัง้หมดกอ่นอกีตอ่ไป  

ใหเ้ริม่จากคลกิเซลลใ์ดเซลลห์นึง่ในพืน้ทีต่ารางเก็บขอ้มลู แลว้เมือ่คลกิเลอืกคําสัง่บน

เมนู Data จะพบวา่ Excel จะเลอืกพืน้ทีเ่ฉพาะสว่นทีต่อ้งการนํามาใชง้านกบัเมนูนัน้ๆ

ตอ่ใหเ้อง เชน่ ถา้สัง่ Data > Sort จะเลอืกพืน้ที ่B3:D7 เฉพาะสว่นทีเ่ป็นขอ้มลู

รายการ หรอืถา้สัง่ Data > Filter จะเกดิปุ่ ม Filter ขึน้เฉพาะหวัตารางดา้นบน B2:D2  

สตูรสําเร็จรปูทีใ่ชจ้ดัการฐานขอ้มลู 

หลงัจากจัดเก็บขอ้มลูไวใ้นตารางทีม่โีครงสรา้งถกูตอ้งตามทีกํ่าหนดไวข้า้งตน้แลว้ เรา

สามารถเลอืกใชส้ตูรตอ่ไปนีเ้พือ่คน้หาขอ้มลูหรอืคําตอบทีต่อ้งการตอ่ไป 

โครงสรา้งสตูร IF  
ใชห้าคาํตอบตามเงือ่นไข 

=IF(เงือ่นไข, ผลหากเงือ่นไขเป็นจรงิ, ผลหากเงือ่นไขเป็นเท็จ)  

ตวัอยา่ง ใหห้าคําตอบถา้ยอดรวมของ Amount ทัง้หมด มคีา่รวมแลว้มคีา่มากกวา่หรอื

เทา่กบั 100 ใหต้อบวา่ OK แตถ่า้ยอดรวมไมถ่งึ 100 ใหต้อบวา่ No จะตอ้งสรา้งสตูร

ตอ่ไปนี ้ 

=IF( Sum(D3:D7)>=100, "OK", "No")  

  คําตอบ คอื OK  
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โครงสรา้งสตูร VLookup  
ใชห้าคา่ในตาราง  

=VLookup(รหสัทีใ่ชห้า, ตารางเก็บขอ้มลู, เลข column ของคําตอบเรือ่งทีต่อ้งการ, 0) 

ตวัอยา่ง ตอ้งการหาวา่ รหสั Id a003 มชีือ่อะไร และมยีอดเป็นเทา่ใด ใหใ้ชส้ตูร

ตอ่ไปนีต้ามลําดบั 

=VLookup("a003", B3:D7 , 2, 0) 

   คําตอบ คอื C 

=VLookup("a003", B3:D7 , 3, 0)  

   คําตอบ คอื 30  

เลข 2 และ 3 ทีใ่สไ่วใ้นสตูร คอื เลขของ column ของ Name และ Amount ซึง่อยูใ่น 

column ที ่2 และ 3 ตามลําดบัในพืน้ทีต่าราง B2:D7 

เลข 0 ทีใ่สไ่วด้า้นหลงัสดุในสตูร เป็นการกําหนดใหใ้ชส้ตูร VLookup หาคา่แบบ 

Exact Match โดยจะหาคา่เฉพาะเมือ่มคีา่ตรงกบัรหสัทีใ่ชห้าเทา่นัน้ แตถ่า้ไมใ่สเ่ลข 0 

จะทําให ้VLookup ทํางานแบบ Approaching Match โดยจะหาคา่มาใหเ้สมอ แมว้า่

ไมม่รีหสัตรงกนัก็ตาม ซึง่โดยทัว่ไปถา้ใชร้หสัเป็นคา่ทีใ่ชค้น้หาคําตอบ ตอ้งใชแ้บบ 

Exact Match 

นอกจากนัน้ เลข 0 มคีวามหมายเทา่กบั False แปลวา่ ไม ่เพือ่ระบวุา่ ตารางทีใ่ชค้น้หา

ตําแหน่งนัน้ ไมต่อ้งเรยีงลําดบัก็ได ้แตถ่า้ไมใ่สเ่ลข 0 จะตอ้งเรยีงรหสัทีเ่ก็บไวจ้ากนอ้ย

ไปมากกอ่นจงึจะหาคําตอบไดถ้กูตอ้ง  
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โครงสรา้งสตูร Match  
ใชห้าตาํแหนง่ของคา่ในตาราง  

=Match(รหสัทีใ่ชห้า, พืน้ทีแ่นวตัง้ของรหสัทัง้หมด, 0)  

ตวัอยา่ง ตอ้งการหาวา่รหสั a003 เป็นรายการทีเ่ทา่ใด ใหใ้ชส้ตูรดงันี ้

=Match("a003", B3:B7, 0) 

   คําตอบ คอื 3  

นอกจากพืน้ทีแ่นวตัง้แลว้ ยงัใชก้บัพืน้ทีแ่นวนอนก็ได ้และโดยทัว่ไปใหใ้สเ่ลข 0 

ตอ่ทา้ยดา้นหลงัสดุในสตูรเสมอ ซึง่เลข 0 มคีวามหมายเทา่กบั False แปลวา่ ไม ่เพือ่

ระบวุา่ ตารางทีใ่ชค้น้หาตําแหน่งนัน้ ไมต่อ้งเรยีงลําดบัก็ได ้ 

โครงสรา้งสตูร Index  
ใชห้าคา่ ทีอ่ยูต่ามตาํแหนง่ของคา่ในตาราง 

=Index(ตารางเก็บขอ้มลู, เลขที ่Row, เลขที ่Column) 

ตวัอยา่ง ตอ้งการหาคา่จากพืน้ทีต่าราง B3:D7 ณ ตําแหน่ง row ที ่2 ตดักบั column 

ที ่3 ใหใ้ชส้ตูรดงันี ้

=Index(B3:D7, 2, 3) 

   คําตอบ คอื 20  

โครงสรา้งสตูร Offset แบบส ัน้ 
ใชห้าคา่ ทีอ่ยูต่ามตาํแหนง่ถดัไปจากตาํแหนง่เซลลอ์า้งองิทีก่าํหนด 

=Offset(เซลลอ์า้งองิ, จํานวน row ถัดไป, จํานวน column ถัดไป) 

ตวัอยา่ง ตอ้งการหาคา่ ทีอ่ยูถ่ดัจากเซลล ์B3 ลงไป 1 row และถดัไปจากเซลล ์B3 

ไปดา้นขวา 2 column ใหใ้ชส้ตูรดงันี ้

=Offset(B3, 1, 2) 

   คําตอบ คอื 20 
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โครงสรา้งสตูร Offset แบบเต็ม 
ใชห้าคา่หลายคา่ เสมอืนเป็นพืน้ทีต่าราง 

=Offset(เซลลอ์า้งองิ, จํานวน row ถัดไป, จํานวน column ถัดไป,  

ความสงูของตาราง, ความกวา้งของตาราง) 

ตวัอยา่ง ตอ้งการใชส้ตูรกําหนดพืน้ทีข่องตวัเลข Amount ซึง่จะเห็นไดว้า่มเีลข 10, 

20, 30, 40, 50 เก็บไว ้ใหใ้ชส้ตูรดงันี ้

=Offset(B3, 0, 2, 5, 1) 

   คําตอบ คอื {10;20;30;40;50} 

สาเหตทุีใ่สเ่ลข 0,2,5,1 นัน้ เนือ่งจากตารางขอ้มลู Amount D3:D7 มตํีาแหน่ง D3 อยู่

ในแนว row เดยีวกนักบั B3 จงึมจํีานวน row ถดัไปเทา่กบั 0 และตําแหน่ง D3 อยู่

ถดัไปจาก B3 อกี 2 column โดย D3:D7 มพีืน้ทีค่วามสงู 5 row และกวา้ง 1 column  

สตูรทีส่รา้งขึน้นี ้อาจไมเ่ห็นคําตอบครบตามตอ้งการ ขอใหก้ดปุ่ ม F2 แลว้ตามดว้ย F9 

จะพบตวัเลข {10;20;30;40;50} และสงัเกตวา่ ระหวา่งตวัเลขนัน้ มเีครือ่งหมาย 

semi-colon ; คัน่ ซึง่เครือ่งหมาย ; นีแ้สดงวา่ ตวัเลขเป็นแนวตัง้ (ถา้คัน่ดว้ย

เครือ่งหมาย comma , จะแสดงวา่เป็นแนวนอน) เมือ่เห็นตวัเลขแลว้ ใหก้ดปุ่ ม Esc 

เพือ่กลบัไปเป็นสตูรตามเดมิ 

โดยทัว่ไปจะไมค่อ่ยพบสตูร Offset แบบเต็มใชใ้นเซลลใ์ด แตจ่ะนําสตูร Offset แบบ

เต็ม ไปสรา้งตอ่เป็น Formula Name ผา่นเมนู Formula > Define Name  เพือ่ตัง้

เป็นชือ่ Formula Name นํามาใชแ้ทน Range Name 
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Offset ทําหนา้ทีก่ําหนดขนาดตารางไดเ้อง (Dynamic Range)  

สตูรชว่ยในการกําหนดพืน้ทีต่าราง ทีข่ยายหรอืหดไดต้ามจํานวนขอ้มลู เรยีกวา่ 

Dynamic Range เชน่ หากตอ้งการทําใหพ้ืน้ทีข่อง Amount ซึง่เดมิมาจากเซลล ์

D3:D7 นัน้ สามารถขยายหรอืหดพืน้ทีไ่ดต้ามขอ้มลูทีเ่พิม่หรอืลดไดเ้อง ใหส้ัง่ 

Formula > Define Name  ตัง้ชือ่ Formula Name วา่ Amount และกําหนดสตูร

ตอ่ไปนีล้งไปในชอ่ง Refers to  

=Offset($B$3, 0, 2, CountA($D:$D)-1, 1) 

สงัเกตวา่ ตําแหน่งของเซลลท์ีอ่า้งองิในสตูรเป็น Absolute Reference โดยมี

เครือ่งหมาย $ กํากบัตําแหน่งทัง้ row และ column ทัง้นีเ้ป็นการสรา้งตามหลกัของ 

Formula Name เพือ่ทําให ้Amount มตํีาแหน่งถกูตอ้งและมตํีาแหน่งแน่นอน  

สตูร CountA($D:$D)-1 ทําหนา้ทีคํ่านวณหาความสงู โดยนับจํานวนรายการขอ้มลู

ทัง้หมดจาก column D แตเ่นือ่งจากสตูร CountA นับหวัตารางเซลล ์D2 เกนิเขา้มา 1 

เซลล ์จงึตอ้งลบจํานวนทีนั่บไดท้ิง้ไป 1 เซลล ์

โครงสรา้งสตูร CountIF 
ใชน้บัจํานวนเซลล ์เทา่ทีม่คีา่ตามเงือ่นไข 

=CountIF(พืน้ทีต่าราง, "เงือ่นไข") 

ตวัอยา่ง ตอ้งการนับจํานวนรหสั a003 วา่มกีีเ่ซลล ์ใหใ้ชส้ตูรดงันี ้

=CountIF(B3:B7, "a003") 

   คําตอบ คอื 1 
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หลกัการใช ้VBA จดัการฐานขอ้มลู 

1. อยา่ใช ้VBA ถา้เราสามารถใชเ้มนูหรอืสตูรหาคําตอบทีต่อ้งการไดอ้ยูแ่ลว้ 

นอกจากชว่ยประหยดัเวลาของเรา ไมต่อ้งหาทางสรา้งรหสั VBA ขึน้เอง 

การใชเ้มนูหรอืสตูร ยงัทําให ้Excel ทํางานเร็วกวา่การใช ้VBA อยา่งมาก 

(คําสัง่บนเมนูและสตูรที ่Microsoft สรา้งไวใ้หนั้น้ จะทํางานไดเ้ร็วมาก 

เพราะไมต่อ้งเสยีเวลาแปลรหสัเป็นภาษาเครือ่ง ตา่งจาก VBA ทีเ่ราเขยีน

เอง ซึง่ยากจะเขยีนรหสัทีม่ปีระสทิธภิาพไดเ้ทยีบเทา่ Microsoft)  

2. ตอ้งออกแบบตารางใหถ้กูตอ้ง แลว้ทดลองใชคํ้าสัง่บนเมนู และใชส้ตูร จน

ไดข้ัน้ตอนทีล่ดัทีส่ดุทีทํ่าได ้ 

3. ใช ้Macro Recorder บนัทกึขัน้ตอนการใชคํ้าสัง่บนเมนู แทนการเขยีน

รหสัเองทัง้หมด  

4. รหสั VBA ทีส่รา้งไวนั้น้ ตอ้งสรา้งแบบยดืหยุน่ สามารถใชร้หสัเดมิทํางาน

ตอ่ไปไดต้ลอด ไมต่อ้งเสยีเวลายอ้นกลบัมาแกไ้ขรหสัอกีในภายหลงั ไม่

วา่โครงสรา้งตาราง ชือ่ชที ชือ่แฟ้ม ชือ่โฟลเดอรจ์ะตา่งไปจากเดมิหรอืไม่

อยา่งไร  

5. คา่คงทีห่รอืตวัแปรทัง้หมดทีใ่ชใ้นรหสั VBA ให ้link ตอ่มาจาก Excel โดย

ใช ้Range Name หรอื Formula Name เป็นสือ่กลาง  

6. ถา้จําเป็นตอ้งแกไ้ข ใหแ้กไ้ขเฉพาะสว่นทีอ่ยูใ่น Excel เนือ่งจากเป็นสิง่ที่

เราคุน้เคย ใชง้านทกุวัน สามารถแกไ้ขไดง้า่ยและสะดวกกวา่เขา้ไปแก ้

รหสัใน VBE  

7. หลกีเลีย่งการลบรายการทีเ่ลกิใชง้านทิง้ เพราะการลบขอ้มลูทิง้ ยอ่มเสยี

ขอ้มลูเกา่นัน้ไป แตใ่หใ้ชว้ธิเีขยีนกํากบัรายการทีเ่ลกิใชง้าน เชน่ ใชเ้ซลล์

ทีม่เีลข 99 กํากบัรายการใดเพือ่แสดงวา่ รายการนัน้เลกิใชไ้ปแลว้  

8. หลกีเลีย่งการแทรกรายการใหมเ่ขา้ไประหวา่งรายการเกา่ แตใ่หบ้นัทกึ

ขอ้มลูรายการใหม ่ตอ่ทา้ยรายการเกา่ทัง้หมดตอ่กนัไปเรือ่ยๆ แลว้จงึนํา

ขอ้มลูไปจัดเรยีงในพืน้ทีอ่ืน่ เป็นตารางใหมท่ีจั่ดเรยีงตามตอ้งการ  

9. ควรเลอืกใช ้VBA ลดขัน้ตอนทีจํ่าเป็นเทา่นัน้ อยา่พยายามเขยีน VBA เพือ่

หาทางทําใหง้านทกุขัน้ตอนทํางานเองโดยอตัโนมตั ิเพราะรหสัจะมคีวาม
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ซบัซอ้นและยากขึน้มาก ลองนกึเผือ่ไวด้ว้ยวา่ คนอืน่รุน่หลงัจะสามารถ

แกะรหสัเดมิ มาแกไ้ขหรอืพัฒนาตอ่ไหวหรอืไม ่  

 

 

 

ภาพแสดงการเลอืกใชส้ตูรเพือ่กาํหนดตาํแหนง่อา้งองิ 
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วธิใีชร้หสั VBA แบบ Evaluate ในการรบัสง่ขอ้มลู 

เดมิวธิทีีใ่ชใ้นการรับสง่ขอ้มลูใน Excel เป็นการใชส้ตูร link ขอ้มลูจากเซลลต์น้ทางมา

ใชต้อ่ทีเ่ซลลป์ลายทาง ถา้ตารางขอ้มลูมขีนาดตายตวั จะใชว้ธิสีรา้งสตูร link เตรยีมไว ้

ตัง้แตต่น้ใหรั้บสง่ขอ้มลูเซลลต์อ่เซลล ์แตถ่า้ตารางมจํีานวนรายการขอ้มลูทีไ่มแ่น่นอน 

จะตอ้งเป็นหนา้ทีข่องเราทีต่อ้งคอยสรา้งสตูรรับขอ้มลูตามจํานวนเซลลต์น้ทาง หรอื

บางคนอาจใชว้ธิสีรา้งสตูรเผือ่ไวเ้ต็มตารางปลายทางไวก้อ่น โดยไมส่นใจวา่ตารางตน้

ทางจะมขีอ้มลูมากนอ้ยเพยีงใด ยอมใหเ้ซลลใ์ดยังไมม่ขีอ้มลูสง่มา จะแสดงเลข 0 ไป

กอ่น  

เนือ้หาในบทนีจ้ะหาทางใช ้VBA ชว่ยในการรับสง่ขอ้มลูแทนการใชส้ตูร จะไดไ้มต่อ้ง

เสยีแรงเสยีเวลาวุน่วายกลบัมาสรา้งสตูร link และไมต่อ้งสรา้งสตูร link เตรยีมไวก้อ่น

เต็มตาราง ซึง่จะทําใหแ้ฟ้มทีม่ตีารางสตูรหลายๆเซลล ์กลายเป็นแฟ้มทีม่ขีนาดแฟ้ม

ใหญโ่ดยไมจํ่าเป็น 

ชดุคําสัง่ทีใ่ชรั้บสง่ขอ้มลู มเีพยีง 2 บรรทดั 

Sub SendData() 

    MyVar = [Source] 

    [Target] = MyVar 

End Sub 

ขอ้กาํหนดในการใชง้าน 

1. Source และ Target เป็น Range Name หรอื Formula Name ก็ได ้ 

2. Source คอื ตารางตน้ทางทีส่ง่ขอ้มลู  

3. Target คอื ตารางปลายทางทีรั่บขอ้มลู  

4. ขนาดตารางของทัง้ Source และ Target ตอ้งมขีนาดเทา่กนั เชน่ ถา้ 

Source เป็นเซลลเ์ดยีว ดงันัน้ Target ก็ตอ้งเป็นเซลลเ์ดยีวดว้ย แตถ่า้ 

Source เป็นตารางทีม่ขีนาดความสงู 2 row ความกวา้ง 3 column ดงันัน้ 

Target ตอ้งเป็นตารางทีม่ขีนาดความสงู 2 row ความกวา้ง 3 column 

เชน่กนั  
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5. ขณะทีส่ัง่ใหคํ้าสัง่ชดุนีทํ้างาน แฟ้มทีม่ตีารางทีต่ัง้ชือ่วา่ Source และ 

Target ตอ้งเปิดและกําลังใชง้านอยู ่ 

6. Source หรอื Target ไมจํ่าเป็นตอ้งเป็นตารางในชทีเดยีวกนั โดยจะเป็น

ตารางทีอ่ยูต่า่งชทีหรอืตา่งแฟ้มกนัก็ได ้เชน่ Target เป็นชือ่ Range 

Name ทีต่ัง้ไวใ้นแฟ้ม Book1.xls แตอ่าจกําหนดให ้Refers to พืน้ที่

ตารางใน Book2.xls (ในกรณีนี ้ขณะทีส่ัง่ใหช้ดุคําสัง่นีทํ้างาน ตอ้งเปิด

แฟ้ม Book1.xls และ Book2.xls และตอ้งเลอืกอยูใ่นแฟ้ม Book1.xls 

เพราะเป็นแฟ้มทีม่ชี ือ่ Range Name Source และ Target)  

7. สามารถตัง้ชือ่ตารางเป็นชือ่อืน่ไดต้ามตอ้งการ โดยแกช้ือ่ทีใ่ชใ้นรหสัให ้

ถกูตอ้งตามชือ่ทีต่ัง้ไว ้ตอ้งสะกดชือ่ตามใหถ้กูตอ้งตรงกนัทกุตวัอกัษร ชือ่

ในรหสัไมจํ่าเป็นตอ้งใชอ้กัษรตวัใหญต่วัเล็กตามชือ่ใน Excel แตถ่า้ตรงกนั

ไดท้กุตวัจะดกีวา่  

คาํอธบิายข ัน้ตอนการทํางานของชุดคําส ัง่ SendData  

1. MyVar เป็นชือ่ตวัแปรทีต่ัง้ขึน้ (Array Variable) ซึง่จะเปลีย่นเป็นชือ่อืน่

ใดก็ได ้สําหรับรับขอ้มลูทีม่าจาก Range Name ชือ่ Source  

2. จากนัน้ Range Name ชือ่ Target จะรับขอ้มลูทีเ่ก็บไวใ้น MyVar  

3. คําวา่ Source และ Target ทีพ่มิพไ์วใ้นระหวา่งเครือ่งหมาย [ ] เป็นการ

ใชแ้บบ Evaluate ทําให ้VBE คน้หาตอ่เองวา่ทัง้ Source และ Target 

เป็น Range Name  

4. เราใช ้MyVar เป็นสือ่กลางในการรับสง่ขอ้มลูระหวา่ง Source และ 

Target ซึง่เฉพาะตวัคา่ของขอ้มลูเทา่นัน้ทีจ่ะถกูสง่ไปเก็บไวท้ี ่Target ถา้

ใน Source มเีซลลส์ตูร =1+2 จะสง่ผลลพัธเ์ป็นเลข 3 ไปเก็บไวท้ี ่

Target สิง่อืน่นอกจากคา่ผลลพัธ ์เชน่ Format จะไมถ่กูสง่ออกไป  

5. ถา้ตดั MyVar ออกแลว้ใชคํ้าสัง่ [Target] = [Source] บรรทดัเดยีว จะใช ้

รับสง่ขอ้มลูไดเ้ฉพาะเซลลเ์ดยีวเทา่นัน้  

6. กรณีตอ้งการสัง่ใหร้หสัชดุนีทํ้างาน และในขณะนัน้มแีฟ้มหลายแฟ้มกําลงั

เปิดใชง้านรว่มกนัอยู ่ควรเพิม่รหสับรรทดัแรก ใหทํ้าหนา้ทีย่า้ยไปดแูฟ้มที่
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ม ีRange Name ชือ่ Source และ Target ตัง้ชือ่ไว ้เชน่ ถา้เป็น Range 

Name ทีอ่ยูใ่นแฟ้มชือ่ Book1.xls ใหแ้กไ้ขรหสัเป็น  

Sub SendData() 

    Windows("Book1.xls").Activate   ‘รหสัไมด่เีพราะ ชือ่ Book1.xls 

    MyVar = [Source] 

    [Target] = MyVar 

End Sub 

หรอื 

Sub SendData() 

    ThisWorkbook.Activate              ‘รหสันีด้ ีเพราะไมร่ะบชุือ่แฟ้ม 

    MyVar = [Source] 

    [Target] = MyVar 

End Sub 

หมายเหต ุThisWorkbook หมายถงึ ตวัแฟ้มทีม่ ีModule เก็บชดุคําสัง่ทีกํ่าลงัทํางาน 

ดงันัน้เมือ่ชดุคําสัง่ SendData ทํางาน แลว้พบคําสัง่ ThisWorkbook.Activate จะทํา

ใหแ้ฟ้มทีเ่ก็บชดุคําสัง่ SendData ถกูเลอืกขึน้ ซึง่ยอ่มเป็นแฟ้มเดยีวกนักบัแฟ้มทีม่ ี

Range Name ชือ่ Source และ Target น่ันเอง  

กรณีใช ้Macro Recorder ในการรบัสง่ขอ้มลู 

สมมตวิา่เรากําลงัอยูใ่นแฟ้มทีม่ ีRange Name ชือ่ Source และ Target และตอ้งการ

สรา้งชดุคําสัง่เพือ่ทําหนา้ทีส่ง่คา่รวมทัง้ Format จาก Source ไปยงั Target ใหใ้ช ้

Recorder บนัทกึตามขัน้ตอนตอ่ไปนี ้

1. กดปุ่ ม F5 เลอืกไปยงั Source  

2. กดปุ่ ม Ctrl+c เพือ่สัง่ Copy  

3. กดปุ่ ม F5 เลอืกไปยงั Target  

4. กดปุ่ ม Enter เพือ่ Paste  
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ชดุคําสัง่ทีไ่ดจ้ากการใช ้Macro Recorder 

Sub CopySource2Target() 

    Application.Goto Reference:="Source" 

    Selection.Copy 

    Application.Goto Reference:="Target" 

    ActiveSheet.Paste 

End Sub  

แตถ่า้ไมต่อ้งการนํา Format ตามไปที ่Target ดว้ย ใหเ้ปลีย่นการบนัทกึ Macro ขัน้ที ่

4 เป็น การคลกิขวาแลว้เลอืก Paste Special > Values จะทําใหเ้กดิชดุคําสัง่ตา่งจาก

เดมิเล็กนอ้ยเป็น 

Sub CopyDataSource2Target() 

     Application.Goto Reference:="Source" 

     Selection.Copy 

     Application.Goto Reference:="Target" 

     Selection.PasteSpecial Paste:=xlPasteValues, Operation:=xlNone, 

SkipBlanks:=False, Transpose:=False 

End Sub 

ซึง่จะพบวา่รหสัในขัน้ตอนการ Paste Special ทีไ่ดจ้ากการบนัทกึ Macro เป็นรหสัที่

ยาวเกนิตอ้งการ ขอใหต้ดัเหลอืเพยีง Selection.PasteSpecial 

Paste:=xlPasteValues ก็พอ กลายเป็นชดุคําสัง่ทีส่ัน้และอา่นไดค้วามตามทีต่อ้งการ

มากขึน้เป็น  

Sub CopyDataSource2Target() 

     Application.Goto Reference:="Source" 

     Selection.Copy 

     Application.Goto Reference:="Target" 

     Selection.PasteSpecial Paste:=xlPasteValues 

End Sub 
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วธิสีง่ขอ้มลูไปยงัเซลลภ์ายในตารางทีก่าํหนด 

หวัใจของเคล็ดการเพิม่ผลงาน ลดความซบัซอ้นของงานดว้ย Excel VBA มไิดอ้ยูท่ีก่าร

หาทางทําใหส้ามารถทํางานเสร็จเร็วขึน้ และทําใหง้านทีม่ขีัน้ตอนซบัซอ้น กลายเป็น

งานงา่ยขึน้เทา่นัน้ ยงัตอ้งหาทางทําใหต้วัรหสั VBA ทีใ่ช ้มคีวามซบัซอ้นลดลงไปดว้ย 

ซึง่ในบททีแ่ลว้ไดแ้นะนําชดุคําสัง่ชือ่ SendData และจากนีไ้ปเราจะมาดกูนัวา่ รหสั

คําสัง่เพยีงแค ่2 บรรทดัใน SendData จะนําไปใชใ้นการับสง่ขอ้มลูในแบบตา่งๆกนัได ้

อยา่งไร โดยมขีอ้แมสํ้าคญัวา่ เราจะไมแ่กไ้ขรหสั VBA 2 บรรทดันัน้อกีเลย  

กอ่นอืน่มาดกูนัอกีทวีา่ ชดุคําสัง่ SendData มหีนา้ตาอยา่งไรและทํางานไดอ้ยา่งไร 

Sub SendData() 

    MyVar = [Source] 

    [Target] = MyVar 

End Sub  

ชดุคําสัง่นี ้สัง่ใหข้อ้มลูทีอ่ยูใ่น Range Name ชือ่ Source สง่ไปพักไวใ้นตัวแปรชือ่ 

MyVar จากนัน้จงึสัง่ให ้MyVar สง่ขอ้มลูทีเ่ก็บไวต้อ่ไปยงั Range Name ชือ่ Target 

ตวัอยา่ง 

 

สิง่ทีต่อ้งการ  

สง่ตวัเลข 777 หรอืคา่ใดๆทีบ่นัทกึไวใ้นเซลล ์B4 ไปเก็บไวใ้นตารางชือ่ MyData ณ 

ตําแหน่ง row ที ่5 ตดักบั column ที ่2 หรอืตําแหน่งอืน่ใดก็ไดท้ีอ่ยูใ่น MyData  
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ข ัน้ตอนการสรา้งงาน 

1. สรา้ง Range Name ชือ่ Source ใหก้บัเซลล ์B4  

2. สรา้ง Range Name ชือ่ MyData ใหก้บัเซลล ์D2:F10  

3. สรา้ง Formula Name ชือ่ Target ใหเ้ป็นสตูร 

=INDEX( MyData, $B$2, $B$3)  

วเิคราะหส์ตูร 

 
Target 

=INDEX( MyData, $B$2, $B$3 ) 

เมือ่กําหนดตําแหน่ง Row และ Column ลงไปในเซลล ์B2 และ B3 ตามลําดบั จะ

สง่ผลใหข้อ้มลูจาก Source สง่ไปที ่MyVar ตอ่ไปยงั Target แลว้สตูร Index จะเป็น

ตวักําหนดตําแหน่ง Row และ Column ของเซลลท์ีรั่บคา่ในทีส่ดุ  

ตอ้งระวงัในการกําหนดตําแหน่ง Row และ Column เพราะสตูร Index สามารถรับคา่

ลงไปเฉพาะขอบเขตพืน้ทีข่อง MyData เทา่นัน้ ซึง่ MyData มขีนาดความสงู 9 row 

และมคีวามกวา้ง 3 column จงึทําใหเ้ลข Row และ Column ชว่งทีใ่ชไ้ด ้คอื Row ที ่

1 - 9 และ Column ที ่1 - 3  
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วธิสีง่ขอ้มลูไปยงัเซลลร์บัขอ้มลู ณ ตาํแหนง่ใดก็ได ้

ตวัอยา่งนีค้ลา้ยกบัตวัอยา่งทีใ่ชส้ตูร Index แตเ่ลอืกใชส้ตูร Offset แทน เพือ่ทําใหส้ง่

คา่ไปยงัเซลลใ์ดก็ได ้ไมต่อ้งจํากดัขอบเขต 

ชุดคาํส ัง่ : SendData 

 

สิง่ทีต่อ้งการ  

สง่ตวัเลข 777 หรอืคา่ใดๆทีบ่นัทกึไวใ้นเซลล ์B4 ไปเก็บไวใ้นตาราง โดยใชตํ้าแหน่ง

อา้งองิจากเซลล ์D1 วา่ เซลลท์ีต่อ้งการรับขอ้มลู อยูห่า่งจากเซลล ์D1 เป็นระยะทาง 5 

row และหา่ง 2 column  

ข ัน้ตอนการสรา้งงาน 

1. สรา้ง Range Name ชือ่ Source ใหก้บัเซลล ์B4  

2. สรา้ง Range Name ชือ่ Ref ใหก้บัเซลล ์D1  

3. สรา้ง Formula Name ชือ่ Target ใหเ้ป็นสตูร 

=OFFSET( Ref, $B$2, $B$3 )  

วเิคราะหส์ตูร 

 
Target 

=OFFSET( Ref, $B$2, $B$3 ) 

สตูรนีทํ้างานคลา้ยกบั Index เพยีงแตกํ่าหนดตําแหน่ง Row และ Column ถดัไปจาก

ตําแหน่งเซลลช์ือ่ Ref ซึง่ตําแหน่ง Row และ Column นีเ้ป็นไดท้ัง้คา่บวก ลบ และ
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ศนูย ์(ถา้ตําแหน่งอยูเ่หนอืเซลล ์Ref หรอือยูด่า้นซา้ยเซลล ์Ref ใหกํ้าหนดเป็นเลข

ลบ) 

เมือ่กําหนดตําแหน่ง Row และ Column ลงไปในเซลล ์B2 และ B3 ตามลําดบั จะ

สง่ผลใหข้อ้มลูจาก Source สง่ไปที ่MyVar ตอ่ไปยงั Target แลว้สตูร Offset จะเป็น

ตวักําหนดตําแหน่ง Row และ Column ของเซลลท์ีรั่บคา่ในทีส่ดุ 

ตวัอยา่งนี ้แมจ้ะไมจํ่ากดัขอบเขตวา่ตอ้งอยูภ่ายในตารางทีกํ่าหนด แตอ่ยา่งไรก็ตามยงั

ตอ้งอยูภ่ายในชที จงึตอ้งระวงัตวัเลขตําแหน่งเซลลว์า่ อยา่ใชตํ้าแหน่งทีเ่ป็นไปไมไ่ด ้

เชน่ กําหนดคา่ B2 เป็นเลข -100 ซึง่ยอ้นขึน้ไปดา้นบนเหนอื row ที ่1 เสยีอกี  
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วธิสีง่ขอ้มลูจากตารางทีม่ขีนาดไมแ่นน่อน 

ตวัอยา่งทีผ่า่นมาเป็นการรับสง่ขอ้มลูเพยีงเซลลเ์ดยีว ซึง่สามารถเลอืกใชส้ตูร Index 

หรอื Offset ก็ได ้แตถ่า้ตอ้งการรับสง่ขอ้มลูจากตารางทีม่ขีนาดตัง้แต ่2 เซลลข์ึน้ไป 

ตอ้งเลอืกใชส้ตูร Offset แบบเต็ม เพราะสตูร Offset นีเ้ทา่นัน้ทีส่ามารถกําหนดสว่น

ของความสงูและความกวา้งของตาราง 

เนือ่งจากตารางขอ้มลูโดยทัว่ไป มคีวามกวา้งคงทีเ่ทา่กบัจํานวน Field ซึง่แยกเป็น 

column เก็บขอ้มลูแตล่ะเรือ่ง แตค่วามสงูจะเพิม่หรอืลดตามจํานวนรายการ จงึทําให ้

เฉพาะความสงูของตารางเทา่นัน้ทีม่ขีนาดเปลีย่นแปลง จงึขอใหส้งัเกตวา่ เราจะใชส้ตูร 

CountA เพือ่คํานวณหาความสงูใหก้บัสตูร Offset  

ชุดคาํส ัง่ : SendData 

 

สิง่ทีต่อ้งการ  

สง่ขอ้มลูเทา่ทีม่อียูจ่ากตารางดา้นซา้ยไปเก็บไวใ้นตารางดา้นขวา ซึง่จํานวนรายการ

ขอ้มลูทีม่นัีน้อาจเพิม่หรอืลดก็ได ้ 

ข ัน้ตอนการสรา้งงาน 

1. สรา้ง Range Name ชือ่ Ref1 ใหก้บัเซลล ์B3  

2. สรา้ง Range Name ชือ่ Ref2 ใหก้บัเซลล ์G3  

3. สรา้ง Formula Name ชือ่ Source ใหเ้ป็นสตูร 

=OFFSET( Ref1, 0, 0, COUNTA($B:$B)-1, 3 )  

4. สรา้ง Formula Name ชือ่ Target ใหเ้ป็นสตูร 

=OFFSET( Ref2, 0, 0, COUNTA($B:$B)-1, 3 )  
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วเิคราะหส์ตูร 

 
Source 

=OFFSET( Ref1, 0, 0, COUNTA($B:$B)-1, 3 ) 

Target 

=OFFSET( Ref2, 0, 0, COUNTA($B:$B)-1, 3 ) 

เนือ่งจากตําแหน่งเซลลห์วัมมุของตารางทัง้คู ่อยูต่รงกบัตําแหน่งของ Ref1 และ Ref2 

ดงันัน้จงึกําหนดตําแหน่ง row และ column ถดัไป เทา่กบั 0 

สตูรทัง้คูกํ่าหนดคา่ความสงูเทา่กบั COUNTA($B:$B)-1 โดยใชข้อ้มลูใน column ของ 

Id เป็นหลกัในการนับ แตเ่นือ่งจากมเีซลลคํ์าวา่ Id อยูใ่น column นีด้ว้ย จงึตอ้งลบ 1 

ออกจาก COUNTA($B:$B) สว่นความกวา้งของตาราง กําหนดใหม้ขีนาดคงทีเ่ทา่กบั 3 

column 

ขอใหส้งัเกตวา่ ชดุคําสัง่ SendData จะสง่ขอ้มลูจากตารางดา้นซา้ย ไปทับขอ้มลูเดมิที่

มอียูแ่ลว้ในตารางดา้นขวา ซึง่เหมาะกบักรณีทีต่ารางซา้ยมจํีานวนรายการเพิม่ขึน้เรือ่ยๆ

เทา่นัน้ ไมเ่หมาะกบักรณีทีต่ารางซา้ยมจํีานวนรายการนอ้ยกวา่ตารางขวา หากตอ้งการ

ปรับปรงุชดุคําสัง่ใหทํ้างานไดถ้กูตอ้ง ควรเพิม่คําสัง่ลบขอ้มลูเดมิทีม่ใีนตารางขวาทิง้

ทัง้หมดกอ่น แลว้จงึสัง่ใหส้ง่ขอ้มลูไปเก็บ 

นอกจากนัน้ขอ้มลู Id ตอ้งบนัทกึในเซลลต์ดิตอ่กนัไป (หา้มเวน้เซลลว์า่งไว)้ และหา้ม

บนัทกึคา่อืน่ในเซลลใ์ดๆบน column B ทีไ่มเ่กีย่วขอ้งกบัรหสั เพราะจะทําใหส้ตูร 

CountA นับจํานวนรายการผดิ สง่ผลใหค้า่ความสงูทีส่ง่ตอ่ไปใชใ้นสตูร Offset 

ผดิพลาดตามไปดว้ย 
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วธิสีง่ขอ้มลูไปบนัทกึตอ่ทา้ยรายการทีม่อียูแ่ลว้ 

ตวัอยา่งนีน่้าจะชว่ยแกปั้ญหาใหก้บังานไดม้ากมายหลายประเภท ซึง่ตอ้งการกรอก

ขอ้มลูลงไปในเซลล ์แลว้ตอ้งการนําขอ้มลูทีก่รอกไวไ้ปเก็บตอ่ทา้ยขอ้มลูทีม่อียูแ่ลว้ 

ทําใหเ้กดิเป็นตารางฐานขอ้มลูในทีส่ดุ  

ชุดคาํส ัง่ : SendData 

 

สิง่ทีต่อ้งการ  

สง่ขอ้มลูทีก่รอกลงในเซลล ์B3:D3 ไปเก็บตอ่ทา้ยรายการในตารางดา้นขวา  

ข ัน้ตอนการสรา้งงาน 

1. สรา้ง Range Name ชือ่ Source ใหก้บัเซลล ์B3:D3  

2. สรา้ง Range Name ชือ่ Ref ใหก้บัเซลล ์G3  

3. สรา้ง Formula Name ชือ่ Target ใหเ้ป็นสตูร 

=OFFSET( Ref, COUNTA($G:$G)-1, 0, 1, 3 )  

วเิคราะหส์ตูร 

 
Target 

=OFFSET( Ref, COUNTA($G:$G)-1, 0, 1, 3 ) 

ขอใหส้งัเกตเลข 0, 1, 3 ทีอ่ยูด่า้นทา้ยของสตูร Offset กอ่น  

 เลข 0 กําหนดตําแหน่งของขอ้มลู ใหเ้ริม่ในแนว column เดยีวกนักบั Ref  

 เลข 1 คอื ความสงูของรายการขอ้มลู ซึง่ตอ้งมคีวามสงูคงที ่1 row เสมอ  
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 เลข 3 คอื ความกวา้งของรายการ ซึง่ประกอบดว้ย Id, Name, Amount 

จงึกําหนดใหก้วา้ง 3 column คงที ่ 

สว่นของสตูร COUNTA($G:$G)-1 เป็นตวัชว่ยกําหนดตําแหน่งรายการใหมต่อ่ทา้ย

รายการเดมิ โดย COUNTA($G:$G) จะนับจํานวนเซลลท์ีม่ขีอ้มลูใน column G 

ทัง้หมด แตเ่นือ่งจากนับเซลลคํ์าวา่ Id รวมเกนิมา 1 เซลล ์จงึตอ้งลบ 

COUNTA($G:$G) ออกเสยี 1 ตําแหน่ง ทัง้นีเ้พือ่ใหต้รงกบัจํานวน row ทีต่อ้งนับให ้

ถดัไปจากตําแหน่งของเซลล ์Ref 

ดงันัน้สตูร Offset นี ้จงึทําหนา้ทีส่ง่รายการขอ้มลูทีก่รอกไวใ้นตารางทีม่คีวามสงู 1 

rowและกวา้ง 3 column จาก Range Name ชือ่ Source ไปยงั Target ซึง่มขีนาด

ความสงูและความกวา้งเดยีวกนั เพยีงแต ่Target จะขยบัไปหาตําแหน่งรายการถดัไป

จาก Ref ตามทีนั่บไดด้ว้ยสตูร CountA-1  
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วธิสีง่ขอ้มลูกลบัไปแกร้ายการเดมิทีม่อียูแ่ลว้ 

แทนทีจ่ะสง่ขอ้มลูใหมไ่ปตอ่ทา้ยรายการทัง้หมดทีม่อียูเ่ดมิ คราวนีจ้ะหาทางสง่ขอ้มลู

ไปแกร้ายการเกา่ (ถา้ม)ี  

ชุดคาํส ัง่ : SendData 

 

สิง่ทีต่อ้งการ  

สง่ขอ้มลูทีก่รอกลงในเซลล ์B3:D3 กลบัไปแกไ้ขรายการเกา่ โดยใชค้า่ทีก่รอกนัน้ 

สง่ไปทบัรายการเดมิทีม่อียูแ่ลว้ในตารางดา้นขวา เชน่ จากภาพ ใหส้ง่รายการ a002 ที่

ใชช้ือ่ใหมว่า่ boy ไปแกไ้ขรายการ a002 เดมิซึง่ใชช้ือ่วา่ b ใหเ้ป็น boy  

ข ัน้ตอนการสรา้งงาน 

1. สรา้ง Range Name ชือ่ Source ใหก้บัเซลล ์B3:D3  

2. สรา้ง Range Name ชือ่ Ref ใหก้บัเซลล ์G3  

3. สรา้ง Range Name ชือ่ Id ใหก้บัเซลล ์G3:G10  

4. สรา้ง Formula Name ชือ่ Target ใหเ้ป็นสตูร 

=OFFSET( Ref, MATCH( $B$3, Id, 0)-1, 0, 1, 3)  

วเิคราะหส์ตูร 

 
Target 

=OFFSET( Ref, MATCH( $B$3, Id, 0)-1, 0, 1, 3) 

ขอใหส้งัเกตเลข 0, 1, 3 ทีอ่ยูด่า้นทา้ยของสตูร Offset กอ่น  
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 เลข 0 กําหนดตําแหน่งของขอ้มลู ใหเ้ริม่ในแนว column เดยีวกนักบั Ref  

 เลข 1 คอื ความสงูของรายการขอ้มลู ซึง่ตอ้งมคีวามสงูคงที ่1 row เสมอ  

 เลข 3 คอื ความกวา้งของรายการ ซึง่ประกอบดว้ย Id, Name, Amount 

จงึกําหนดใหก้วา้ง 3 column คงที ่ 

สว่นของสตูร MATCH( $B$3, Id, 0)-1 เป็นตวัชว่ยกําหนดตําแหน่งรายการเดมิวา่ Id 

ทีก่รอกในเซลล ์B3 เป็นตําแหน่งลําดบัทีเ่ทา่ใดใน Range ชือ่ Id สาเหตทุีต่อ้งลบผล

ทีไ่ดจ้ากสตูร Match ออกเสยี 1 ตําแหน่ง ทัง้นีเ้พือ่ใหต้รงกบัจํานวน row ทีต่อ้งนับ

ถดัไปจากตําแหน่งของเซลล ์Ref 

ดงันัน้สตูร Offset นี ้จงึทําหนา้ทีส่ง่รายการขอ้มลูทีก่รอกไวใ้นตารางทีม่คีวามสงู 1 

rowและกวา้ง 3 column จาก Range Name ชือ่ Source ไปยงั Target ซึง่มขีนาด

ความสงูและความกวา้งเดยีวกนั เพยีงแต ่Target จะขยบัไปหาตําแหน่งรายการเดมิซึง่

อยูถ่ดัไปจาก Ref ตามทีนั่บไดด้ว้ยสตูร Match-1  

ตวัอยา่งนีจ้ะเกดิ error ขึน้ทนัท ีถา้รหสัทีก่รอกลงไปในเซลล ์B3 ไมใ่ชร่หัส Id ที่

บนัทกึเก็บไวแ้ลว้ในตารางดา้นขวา ดงันัน้ถา้ตอ้งการป้องกนัไมใ่หช้ดุคําสัง่ SendData 

หยดุทํางานกลางคนั ใหแ้กช้ดุคําสัง่เล็กนอ้ยเป็นดงันี ้

Sub SendData() 

    On Error Resume Next 

    MyVar = [Source] 

    [Target] = MyVar 

End Sub  

On Error Resume Next ทีใ่สเ่พิม่เป็นบรรทดัแรก จะทําหนา้ทีต่รงกบัความหมาย ซึง่

แปลวา่ "เมือ่เกดิ error ขึน้ ใหก้ลบัไปทํางานตอ่" ทําใหช้ดุคําสัง่ SendData จะไม่

เตอืน error ใหเ้ห็นอกีเลยแมร้หสับรรทดัตอ่ๆไปจะไมทํ่างานก็ตาม 
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แทนทีจ่ะใช ้On Error Resume Next ซึง่ไมไ่ดช้ว่ยแกไ้ขขอ้มลูและไมไ่ดเ้ตอืนใหผู้ใ้ช ้

ทราบวา่เกดิปัญหาแตอ่ยา่งใด เราสามารถใช ้On Error Goto แทนดงันี ้

Sub SendData() 

    On Error GoTo ResetInput 

    MyVar = [Source] 

    [Target] = MyVar 

    End 

ResetInput: 

    [Source] = "Invalid" 

End Sub  

On Error Goto ทําหนา้ทีต่รงกบัคําแปล คอื "เมือ่เกดิ error ขึน้ใหไ้ปทํางานทีอ่ืน่ตอ่" 

ซึง่ในตวัอยา่งนี ้กําหนดใหข้า้มไปทํางานตอ่ทีบ่รรทดั ResetInput โดยทําหนา้ที่

เปลีย่นขอ้มลูใน Source เป็นคําวา่ Invalid เพือ่เตอืนใหท้ราบวา่ ขอ้มลูทีก่รอกนัน้ไม่

ถกูตอ้ง 

สงัเกตวา่บรรทดั ResetInput: ตอ้งมเีครือ่งหมาย colon : ตอ่ทา้ย และนยิมเขยีนโดย

ไมจั่ดยอ่หนา้ 

นอกจากนัน้ ในกรณีทีไ่มเ่กดิ error เราตอ้งป้องกนัไมใ่หช้ดุคําสัง่นี ้ทํางานในสว่น

ตัง้แตบ่รรทัด ResetInput: จงึตอ้งใชคํ้าสัง่ End ไวก้อ่น เพือ่ทําใหร้หสัคําสัง่ทํางาน

ตามปกต ิและจบไปเลย โดยไมส่นใจกบัรหสัคําสัง่บรรทดัทีเ่หลอื  
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วธิเีลอืกสง่ขอ้มลูตามลกัษณะรายการเกา่ใหม ่

จาก 2 ตวัอยา่งทีผ่า่นไป ตวัอยา่งหนึง่สัง่ใหร้ายการทีก่รอก ไปบนัทกึตอ่ทา้ย สว่นอกี

ตวัอยา่งสัง่ใหร้ายการทีก่รอก ไปบนัทกึแกไ้ขทบัรายการเดมิ จากนีจ้ะหาทางนําทัง้ 2 

ตวัอยา่งรวมเขา้ดว้ยกนั ถา้พบวา่รายการทีก่รอกเป็นรหสัใหม ่ใหส้ง่ขอ้มลูไปบนัทกึ

ตอ่ทา้ย แตถ่า้พบวา่เป็นรายการทีบ่นัทกึไวอ้ยูแ่ลว้แสดงวา่เป็นรหสัเกา่ ใหส้ง่ขอ้มลูที่

กรอกไปทบัรายการเกา่ ทัง้นีใ้หใ้ชช้ดุคําสัง่เดมิ ไมต่อ้งแกไ้ขอะไรใน VBE  

ชุดคาํส ัง่ : SendData 

 

สิง่ทีต่อ้งการ  

สง่ขอ้มลูทีก่รอกลงในเซลล ์B3:D3 ไปเก็บในตารางดา้นขวา โดยพจิารณาจากรหสั Id 

ทีก่รอกในเซลล ์B3 ถา้เป็นรหสั Id a002 ซึง่เป็นรหสัเกา่ ใหจั้ดสง่ขอ้มลูไปบนัทกึทบั

รายการเดมิของรหสั a002 แตถ่า้เป็นรหสัใหมท่ีไ่มเ่คยมอียูใ่นตารางดา้นขวา เชน่ รหสั 

Id a004 ใหจั้ดสง่ขอ้มลูไปบนัทกึตอ่ทา้ยรายการในตารางขวา  

ข ัน้ตอนการสรา้งงาน 

1. สรา้ง Range Name ชือ่ Source ใหก้บัเซลล ์B3:D3  

2. สรา้ง Range Name ชือ่ Ref ใหก้บัเซลล ์G3  

3. สรา้ง Range Name ชือ่ Id ใหก้บัเซลล ์G3:G10  

4. สรา้ง Formula Name ชือ่ Target ใหเ้ป็นสตูร 

=OFFSET( Ref,  

   IF( COUNTIF( Id, $B$3 )>=1,  

        MATCH( $B$3, Id, 0 )-1,  
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        COUNTA( $G:$G )-1),  

   0, 1, 3 )  

วเิคราะหส์ตูร 

 
Target 

=OFFSET( Ref,  

   IF( COUNTIF( Id, $B$3 )>=1,  

        MATCH( $B$3, Id, 0 )-1,  

        COUNTA( $G:$G )-1),  

   0, 1, 3 ) 

ขอใหส้งัเกตเลข 0, 1, 3 ทีอ่ยูด่า้นทา้ยของสตูร Offset กอ่น  

 เลข 0 กําหนดตําแหน่งของขอ้มลู ใหเ้ริม่ในแนว column เดยีวกนักบั Ref  

 เลข 1 คอื ความสงูของรายการขอ้มลู ซึง่ตอ้งมคีวามสงูคงที ่1 row เสมอ  

 เลข 3 คอื ความกวา้งของรายการ ซึง่ประกอบดว้ย Id, Name, Amount 

จงึกําหนดใหก้วา้ง 3 column คงที ่ 

สว่นของสตูร IF( COUNTIF(Id,$B$3)>=1, MATCH($B$3,Id,0)-1, 

COUNTA($G:$G)-1) 

 COUNTIF(Id,$B$3) ทําหนา้ทีนั่บจํานวนรายการทีม่ ีId ทีก่รอกใน B3  

 ถา้ COUNTIF(Id,$B$3)>=1 เป็นจรงิ แสดงวา่มรีหสัรายการบนัทกึอยู่

แลว้ จงึใหส้ง่ขอ้มลูไปบนัทกึทบัรายการเดมิ ณ ตําแหน่งทีคํ่านวณจาก 

MATCH($B$3,Id,0)-1  

 ถา้ COUNTIF(Id,$B$3)>=1 เป็นเท็จ แสดงวา่เป็นรหสั Id ของรายการ

ใหม ่จงึใหส้ง่ขอ้มลูไปบนัทกึตอ่ทา้ยรายการเดมิ ณ ตําแหน่งทีคํ่านวณ

จาก COUNTA($G:$G)-1  

โปรดสงัเกตวา่ สตูร IF ทีใ่ชน้ีเ้ป็นสตูรทีอ่ยูใ่น Excel จงึชว่ยใหไ้มต่อ้งเสยีเวลากลบัไป

แกไ้ขรหสั VBA เลยแมแ้ตน่อ้ย   
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วธิเีรยีกใชร้หสัเกีย่วกบัตาราง Excel 

รหสั VBA ทีใ่ชก้นัมากทีส่ดุ เห็นจะเป็นรหสัทีเ่กีย่วขอ้งกบัการเรยีกใชพ้ืน้ทีใ่นตาราง 

Excel นีแ่หละ ทัง้นีเ้พือ่ทําใหเ้ราสามารถจัดการกบัตวัแฟ้ม ชที row column หรอื

เซลล ์ไดต้ามตอ้งการ และแทนทีจ่ะพึง่รหสัซึง่เกดิขึน้จากการใช ้Macro Recorder 

ทางเดยีว เราควรฝึกเขยีนรหสั VBA ขึน้มาใชเ้องบา้ง เพราะแทนทีจ่ะตอ้งใชร้หสัทีไ่ด ้

จากการบนัทกึ เพือ่เลอืกแฟ้ม แลว้เลอืกชที แลว้เลอืกเซลลท์ลีะขัน้ เราสามารถใชร้หสั

ทีเ่ขยีนขึน้ พาลดัไปยงัเซลลท์ีต่อ้งการไดโ้ดยตรง  

ในรหสั VBA บรรทดัหนึง่ๆ จะไลเ่รยีงเนือ้หาจากซา้ยไปขวาโดยใชเ้ครือ่งหมายจดุเป็น

ตวัแบง่ ซึง่เครือ่งหมายจดุนี ้จะแปลวา่ ของ ก็ได ้โดยจะไลเ่รยีงจากของใหญไ่ปของ

ยอ่ย เชน่ 

 
Worksheets("Sheet1").Range("A1").Select 

หรอื 

Sheets("Sheet1").Range("A1").Select 

รหสับรรทดันีม้คีวามหมายวา่ "ใหเ้ลอืกเซลล ์A1 ของตารางทีอ่ยูใ่นชทีชือ่ Sheet1" 

และถา้ดลํูาดบัคําจากซา้ยไปขวา เวลาเขยีนจะเรยีงจากใหญไ่ปยอ่ย จากชทีไปยงั

เซลล ์โดยสิง่ตา่งๆใน Excel ซึง่เห็นไดบ้นจอและถกูเรยีกชือ่ได ้ถอืวา่เป็น Object 

เชน่ 

 รหสัคําวา่ Worksheets หมายถงึ ตวัชทีทัง้หมดหรอืกลุม่ของชที ซึง่ตอ้ง

ลงทา้ยดว้ย s (เรยีกวา่เป็น Collection ของชที) โดยคําวา่ Worksheets 

ยงัหมายถงึ ชทีทีเ่ป็นตารางเทา่นัน้ (ถา้อยากเรยีกชทีทัว่ไป จะใชคํ้าวา่ 

Sheets ซึง่หมายรวมทัง้ Worksheet และ Chart sheet)  

 คําวา่ "Sheet1" เป็นชือ่ชที ทีเ่ราตอ้งการเลอืกออกมาจากชทีทัง้หมดใน 

Worksheets ซึง่ในกลุม่ของชทีอาจมหีลายชที ดงันัน้ เราตอ้งระบชุือ่ชทีที่

ตอ้งการใหถ้กูตอ้งชดัเจน  
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 Worksheets("Sheet1") จงึหมายถงึ ชทีชือ่ Sheet1 ซึง่เป็นชทีหนึง่ใน

ชทีทัง้หมดทีเ่ป็นตาราง แตถ่า้ใช ้Sheets("Sheet1") จะหมายถงึ ชทีชือ่ 

Sheet1 ซึง่ไมจํ่าเป็นตอ้งเป็นชทีทีเ่ป็นตารางก็ได ้ 

สว่นคําวา่ Select ทา้ยสดุ ถอืวา่เป็น Method หมายถงึลกัษณะอาการทีเ่ราตอ้งการ

กระทําตอ่ตวั Object ดงันัน้ Method Select จงึเทา่กบั สัง่ใหค้ลกิเลอืก  

โดยทัว่ไปในรหสับรรทดัหนึง่ๆ รหสัเกีย่วขอ้งกบั Object จะถกูเขยีนไวซ้า้ยสดุ ตอ่ดว้ย

เครือ่งหมายจดุ แลว้ตอ่ดว้ย Method แตถ่า้ตอ้งการระบถุงึสภาพลกัษณะของ Object 

ทีต่อ้งการ จะใช ้Property เขยีนเรยีงตอ่จาก Object เชน่ 

Columns("B:B").ColumnWidth = 15.5  

 Columns("B:B") เป็น Object ประเภท Column ซึง่ในทีน่ีห้มายถงึตวั 

Column B  

 ColumnWidth เป็น Property หมายถงึ ความกวา้งของตวั Column ซึง่ใน

คําสัง่บรรทดันี ้ทําให ้Column B มคีวามกวา้ง 15.5 pixel  

Property ตา่งจาก Object ตรงที ่Property ไมม่ตีวัตนใหม้องเห็นหรอืคลกิไดบ้นจอ 

แตจ่ะมลีกัษณะเป็นสภาพ เชน่ ขนาดความสงู ความกวา้ง ความยาว ความหนา ส ีหรอื

สภาวะการป้องกนั  

หมายเหต ุเรือ่ง Object, Property, และ Method นีเ้ป็นเพยีงชือ่เรยีกศพัทเ์ทคนคิที่

ยกขึน้มา เพือ่แนะนําใหทํ้าความรูจั้กกนัไวเ้ทา่นัน้ ในขัน้นีย้งัไมจํ่าเป็นตอ้งสนใจ

เสยีเวลาคน้หาวา่ สิง่ใดบา้งเป็น Property ก็ได ้ขอเพยีงระลกึไวว้า่ โครงสรา้งรหสั

คําสัง่แตล่ะบรรทดั กําหนดความสําคญัจากซา้ยไปขวา เรยีงจากสิง่ใหญไ่ปยอ่ยตอ่ไป

เรือ่ยๆ และถา้อยากจะรูว้า่ VBA มรีหสัเป็นอยา่งไร ขอใหท้ดลองใช ้Recorder น่ัน

แหละ เมือ่คลกิเลอืกลงไปในตาราง แลว้คลกิสัง่บนเมนู ก็จะเกดิบรรทดัคําสัง่ เรยีง 

Object, Property, Method ขึน้จากซา้ยไปขวาใหเ้อง  
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วธิใีชร้หสัจดัการกบัพืน้ทีต่าราง 

ตวัอยา่งรหสัตอ่ไปนีแ้ทบทัง้หมด เป็นตวัอยา่งซึง่ไดจ้าก VBE Help โดยใชคํ้าวา่ 

Name ในการคน้หา 

 Worksheets(1).Visible = False 

ซอ่นชทีแรก 

   

 Worksheets("Sheet1").Protect password:="forall" 

ป้องกนัชทีชือ่ Sheet1 โดยใชร้หสัวา่ forall  

   

 Worksheets("Sheet1").Activate 

เลอืกชทีชือ่ Sheet1  

   

 ActiveSheet.PrintOut 

สัง่พมิพช์ทีทีกํ่าลงัใชง้านอยู ่

   

 Worksheets("Sheet1").Range("A1").Value = 100 

สง่เลข 100 ลงไปในเซลล ์A1 ของชทีชือ่ Sheet1 

   

 Range("A1:H8").Formula = "=Rand()" 

สรา้งสตูร =Rand() ลงไปในเซลล ์A1:H8 ของชทีทีกํ่าลงัใชง้านอยู ่

   

 Worksheets(1).Range("Criteria").ClearContents 

ลบขอ้มลูในพืน้ทีท่ีม่ชี ือ่ Range Name วา่ Criteria 

   

 Worksheets(1).Cells(1, 1).Value = 24 

สง่เลข 24 ลงไปในชทีแรก ณ ตําแหน่งเซลลท์ีอ่ยูท่ี ่row ที ่1 ตดักบั 
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column ที ่1 ของพืน้ทีใ่นชทีแรก ซึง่หมายถงึเซลล ์A1 

   

 ActiveSheet.Cells(2, 1).Formula = "=Sum(B1:B5)" 

สรา้งสตูร =Sum(B1:B5) ลงไปในเซลล ์A2 ของชทีทีกํ่าลงัใชง้านอยู ่

   

 Worksheets(1).Range("C5:C10").Cells(1, 1).Formula = "=Rand()"  

สรา้งสตูร =Rand() ลงไปในเซลล ์C5 ของชทีแรก (C5 คอื เซลลท์ีอ่ยูใ่น

ตําแหน่ง row ที ่1 ตดักบั column ที ่1 ของพืน้ที ่C5:C10) 

   

 Selection.Offset(3, 1).Range("A1").Select 

เลอืกเซลลท์ีอ่ยูถ่ดัจากเซลลท์ีกํ่าลงัเลอืกอยู ่หา่งลงไป 3 row และ 

ถดัไปดา้นขวา 1 column (รหสัแบบ Offset นีจ้ะเรยีกเซลลท์ีต่อ้งการวา่ 

Range("A1") เสมอ) ดงันัน้ถา้เดมิอยูใ่นเซลล ์A1 พอสัง่ใหร้หสับรรทดันี้

ทํางาน จะเลอืกเซลล ์B4  

   

 Range("MyData")(4)=100 

สง่เลข 100 ลงไปในเซลลท์ี ่4 ในพืน้ทีต่ารางทีม่ ีRange Name ชือ่ 

MyData โดยเซลลท์ี ่4 นีจ้ะนับจากซา้ยไปขวาแลว้นับตอ่ลงไปยงั row 

ถดัลงไป แลว้นับตอ่จากซา้ยไปขวาในพืน้ที ่MyData  

   

 Range("MyData")(1,3)=100  

สง่เลข 100 ลงไปในเซลลท์ีอ่ยู ่ณ ตําแหน่ง row ที ่1 ตดักบั column ที ่

3 ในพืน้ทีต่ารางทีม่ ีRange Name ชือ่ MyData  
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VBA กบัการตดัสนิใจ 

ถา้เราตอ้งคอยควบคมุการทํางานของชดุคําสัง่ทัง้หมด ตัง้แตต่น้จนจบดว้ยตนเอง คง

เสยีเวลาและเป็นเรือ่งน่าเบือ่มใิชน่อ้ย ยิง่มขีัน้ตอนสลบัซบัซอ้นมากขึน้เทา่ใด ยิง่ตอ้ง

คอยใหค้วามใสใ่จ ใชค้วามระมดัระวงัในการตดัสนิใจเลอืกสัง่ run macro ชดุคําสัง่ที่

ถกูตอ้ง เพราะเมือ่สัง่ให ้macro ทํางานไปแลว้ ไมม่ทีางทีจ่ะสัง่ undo เหมอืนกบัทีใ่ช ้

คําสัง่บนเมนู ใหง้านทีทํ่าไปแลว้คนืกลบัสูส่ภาพเดมิไดอ้กี 

แทนทีจ่ะตอ้งคอยตดัสนิใจควบคมุการทํางานของ macro ในทกุขัน้ตอนดว้ยตนเอง เรา

สามารถใชร้หสั VBA ตอ่ไปนีช้ว่ยตดัสนิใจเลอืกสัง่งานแทน 

1. If...Then...Else Statements เหมาะสําหรับใชต้ดัสนิใจเลอืกขัน้ตอน

งา่ยๆ หรอืมเีงือ่นไขและใชต้วัแปรซบัซอ้นตอ่เนือ่งกนัหลายชัน้  

2. Select Case Statements เหมาะสําหรับใชต้ดัสนิใจไดแ้ทนแบบ If 

เพยีงแตแ่บบ Select Case มโีครงสรา้งทีง่า่ยตอ่การนําตวัแปรตวัเดมิไปใช ้

เปรยีบเทยีบ  

ขอ้ควรระวงั 

ในชดุคําสัง่แบบ Sub Procedure โปรดเลอืกใชร้หสั If...Then...Else หรอื Select 

Case ชว่ยเฉพาะการตดัสนิใจควบคมุการสัง่งานของชดุคําสัง่ โดยพยายามหลกีเลีย่ง 

อยา่นําไปใชใ้นการเขยีนรหสัคํานวณ หรอืกําหนดคา่คงทีใ่ดๆลงไปใน VBE ทัง้นีเ้พือ่

ชว่ยใหไ้มต่อ้งยอ้นกลบัมาแกไ้ขในตัวรหสัอกีในภายหลงั 

ถา้จําเป็นตอ้งใชผ้ลลพัธจ์ากการคํานวณ ควรใช ้Excel คํานวณแทน แลว้ใช ้Range 

Name สง่ผลลพัธท์ีคํ่านวณไดก้ลบัมาใชต้ดัสนิใจตอ่ใน VBE  
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If...Then...Else Statements 

 โครงสรา้งแบบส ัน้บรรทดัเดยีว  

If condition Then [statements] [Else elsestatements] 

 โครงสรา้งแบบหลายบรรทดั  

If condition Then  

    [statements] 

    [ElseIf condition-n Then  

        [elseifstatements] ... 

        [Else  

        [elsestatements]] 

End If 

โครงสรา้งทีเ่ห็นนีนํ้ามาจาก VBA Help โดยพมิพคํ์าวา่ If ลงไปในพืน้ทีท่ีใ่ชพ้มิพร์หสั

ตามปกต ิแลว้กดปุ่ ม F1 จะพบคําอธบิายวธิใีช ้If โดยขอใหส้งัเกตจากโครงสรา้งวา่ 

สว่นใดทีเ่ขยีนไวภ้ายในเครือ่งหมายวงเล็บ [ ] ถอืวา่ เป็นสว่นทีจ่ะเขยีนหรอืไมก่็ได ้

สว่นทีเ่ขยีนดว้ยตวัเขม้หนา เป็นสว่นทีต่อ้งเขยีนเสมอ ดงันัน้โครงสรา้งขา้งตน้ จงึมสีว่น

ทีจํ่าเป็นตอ้งใชท้ัว่ไปเพยีงดงันี ้

 กรณีใชต้ดัสนิใจเฉพาะ True  

 

If condition Then statements 

หรอื 

If condition Then  

    statements  

End If 

 

 กรณีใชต้ดัสนิใจท ัง้ True และ False  

 

If condition Then statements Else elsestatements 
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หรอื 

If condition Then  

    statements  

    else 

    elsestatements 

End If 

Select Case Statement 

Select Case testexpression  

    [Case expressionlist-n  

        [statements-n]] ...  

    [Case Else  

        [elsestatements]] 

End Select 

ตวัอยา่งที ่1  

สมมต ิในแฟ้มมเีซลลห์นึง่ทีต่ัง้ชือ่วา่ Source ไวแ้ลว้ โดยเราอยากใหใ้ชค้า่ใน Source 

เป็นตวัควบคมุการตดัสนิใจเลอืกใหช้ดุคําสัง่ทีต่อ้งการทํางานตอ่ไป 

 ถา้ Source มคีา่เทา่กบั 100 พอด ีใหเ้ลอืกชดุคําสัง่ชือ่ SendData1 

ทํางาน  

 ถา้ Source มคีา่ไมเ่ทา่กบั 100 ใหเ้ลอืกชดุคําสัง่ชือ่ SendData2 ทํางาน  

 

If [Source] = 100 Then SendData1 Else SendData2 

หรอื 

If [Source] = 100 Then  

    SendData1  

Else  

    SendData2  
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End If 

หรอื 

Select Case [Source]  

    Case 100  

        SendData1  

    Case Else  

        SendData2  

End Select 

ตวัอยา่งที ่2 

ขอใชค้า่จาก Source เชน่เดยีวกบัตวัอยา่งแรก เพยีงแตแ่ทนทีจ่ะตรวจสอบวา่ Source 

มคีา่เทา่กบั 100 หรอืไมเ่ทา่นัน้ คราวนีใ้หเ้ปรยีบเทยีบคา่ Source ตอ่ไปอยา่งละเอยีด

ดงันี ้

 ถา้ Source มคีา่มากกวา่ 100 ใหเ้ลอืกชดุคําสัง่ชือ่ SendData1a ทํางาน  

 ถา้ Source มคีา่มากกวา่ 80 ใหเ้ลอืกชดุคําสัง่ชือ่ SendData1b ทํางาน  

 ถา้ Source มคีา่มากกวา่ 60 ใหเ้ลอืกชดุคําสัง่ชือ่ SendData1c ทํางาน  

 ถา้ Source มคีา่มากกวา่ 40 ใหเ้ลอืกชดุคําสัง่ชือ่ SendData1d ทํางาน  

 ถา้ Source มคีา่มากกวา่ 20 ใหเ้ลอืกชดุคําสัง่ชือ่ SendData1e ทํางาน  

 ถา้ Source มคีา่อืน่ๆ ใหเ้ลอืกชดุคําสัง่ชือ่ SendData2 ทํางาน  

ในกรณีทีม่เีงือ่นไขซบัซอ้นมากขึน้นี ้ถา้จะใช ้If...Then...Else Statements จะตอ้ง

เขยีน ElseIf ซอ้นกนัหลายชัน้ แตเ่นือ่งจากทกุเงือ่นไขทีใ่ชนั้น้ ใชค้า่จาก Source 

เดยีวกนัตลอด จงึน่าเลอืกใช ้Select Case Statement จะเขยีนไดง้า่ย มโีครงสรา้งที่

ชดัเจน และชว่ยใหย้อ้นกลบัมาแกไ้ขไดส้ะดวกกวา่  

Select Case [Source] 

    Case Is > 100 

        SendData1a 

    Case Is > 80 

        SendData1b 

    Case Is > 60 
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        SendData1c 

    Case Is > 40 

        SendData1d 

    Case Is > 20 

        SendData1e 

    Case Else 

        SendData2 

End Select 

IIf Function 

ในกรณีทีต่อ้งการใชส้ตูร IF ในโครงสรา้งสตูรแบบเดยีวกนักบัทีใ่ชส้ตูรใน Excel เรา

สามารถใชส้ตูร IIF ใน VBA โดยมโีครงสรา้งสตูร ดงันี ้

IIf(expr, truepart, falsepart) 

 

ตวัอยา่ง 

ถา้ Source มคีา่มากกวา่ 1000 ใหป้รับคา่เหลอืเทา่กบั 100 

[Source] = IIF([Source] > 1000, 100, [Source]) 

โปรดสงัเกตวา่ เราใช ้IIF แบบสตูรเพือ่คํานวณหาผลลพัธ ์แตไ่มไ่ดใ้ชเ้พือ่สัง่ใหร้หสั

คําสัง่อืน่ทํางานโดยตรง ดงันัน้ฝ่ังซา้ยของ IIF จงึใชเ้ครือ่งหมายเทา่กบัเซลลห์รอืตวั

แปรทีต่อ้งการรับคา่ 

Choose Function 

Choose(index, choice-1[, choice-2, ... [, choice-n]])  

Choose ใชคํ้านวณหาผลลพัธไ์ดเ้ชน่เดยีวกบั IIF แต ่Choose ใชเ้ลข index ซึง่เป็น

เลขจํานวนเต็ม ชว่ยในการตดัสนิใจหาคําตอบทีเ่ขยีนตอ่ไวใ้นสตูร 

ตวัอยา่ง 

ถา้ Source มคีา่เป็นเลข 1-5 ใหเ้ปลีย่นคา่ใน Source เป็นตวัอกัษร a, b, c, d, e 

ตามลําดบั 
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[Source] = Choose([Source], "a", "b", "c", "d", "e") 

วธินํีาสตูรของ Excel มาใชก้บั VBA 

แทนทีจ่ะตอ้งเริม่ตน้เรยีนรูโ้ครงสรา้งสตูรของ VBA ขอแนะนําใหนํ้าสตูร Excel ทีเ่รา

คุน้เคยดอียูแ่ลว้มาใชแ้ทนกนัดกีวา่ โดยพมิพคํ์าวา่ Application.WorksheetFunction 

ตามดว้ยจดุ นําหนา้สตูร Excel เชน่ 

 
[Source] = Application.WorksheetFunction.Round([Source], 2) 

ปรับตวัเลขใน Source โดยปัดขึน้เป็นเลขทศนยิม 2 หลกั 

เ◌ด้มิ 12.345 จะปัดขึน้เป็น 12.35  

แตถ่า้ใชส้ตูร Round ใน VBA 

[Source] = Round([Source], 2)  

เดมิ 12.345 จะปัดเป็น 12.34 

จะเห็นวา่ สตูร Round ของ VBA คํานวณใหคํ้าตอบตา่งจาก Round ของ Excel โดย

สตูร Round ของ VBA จะมหีลกัพจิารณาเพิม่เตมิวา่ ถา้เลขหลักทีต่อ้งการเป็นเลขคูอ่ยู่

แลว้จะไมปั่ดขึน้  

หากตอ้งการคน้หาวา่มสีตูร Excel ใดทีส่ามารถนํามาใชใ้น VBA ไดบ้า้ง ใหค้น้หาจาก 

VBA Help โดยคน้หาจากคําวา่ List of Worksheet Functions Available to Visual 

Basic แลว้ขอใหส้งัเกตวา่ไมม่สีตูร If (โดยใหห้นัมาใช ้IIF ของ VBA แทน) หรอืคน้หา

จากพืน้ทีท่ีใ่ชเ้ขยีนรหสั ใหพ้มิพคํ์าวา่ Application.WorksheetFunction แลว้พอพมิพ์

เครือ่งหมายจดุตอ่ทา้ยคํา จะพบวา่ VBE เปิดจอเล็กๆไลลํ่าดับชือ่สตูรทีม่อียู ่เพือ่ให ้

เลอืกไดโ้ดยตรงในขณะทีพ่มิพใ์หท้นัท ี
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วธิสีรา้งสญัญาณเตอืน...ภยั 

สญัญาณเตอืน ถอืเป็นสิง่สําคญัอยา่งยิง่ทีจ่ะทําใหเ้ราสบายใจมากขึน้ เพราะหากรหสั 

VBA ทีกํ่าลงัทํางานอยูนั่น้ มหีลายขัน้ตอน หรอืกําลงัจะทําขัน้ตอนทีสํ่าคญัหา้ม

ผดิพลาด ซึง่กอ่นทีจ่ะเขา้สูข่ัน้ตอนดงักลา่ว ควรมสีญัญาณเตอืนแสดงขึน้บนจอ เพือ่

บอกใหเ้ราทราบวา่ ทีผ่า่นไปนัน้เป็นขัน้ตอนใดทีทํ่าเสร็จไปแลว้ ขณะนีกํ้าลงัจะทํา

ขัน้ตอนใดตอ่ไป หรอืเมือ่พบวา่ จากขัน้ตอนทีทํ่าไปแลว้นัน้ ทําใหส้ถานการณ์ตา่งไป

จากเดมิ เราจะยอมใหร้หสัทํางานตอ่ไปอกีหรอืไม ่ 

MsgBox Function 

MsgBox(prompt[, buttons] [, title]) 

ตวัอยา่งการใชง้าน 

1. MsgBox "Value is : " & [Source] 

แสดงคา่ในเซลลช์ือ่ Source 

 

 

2. MyVar = MsgBox("Value is : " & [Source], vbOKCancel)  

If MyVar = vbOK Then [Target] = [Source] 

 

แสดงคา่ในเซลลช์ือ่ Source แลว้ถา้กดปุ่ ม OK 
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จะสง่คา่จาก Source ไปเก็บไวท้ี ่Target  

สงัเกตวา่ หลงั MsgBox มวีงเล็บเพือ่ทํางานแบบสตูร  

3. ถา้แกไ้ขเพิม่เตมิรหสับรรทดัแรกในขอ้ 2 เป็น 

MyVar = MsgBox("Value is : " & [Source], vbOKCancel  

+ vbDefaultButton2, "Expert") 

 

สงัเกตวา่ คราวนีปุ้่ ม Cancel เป็นปุ่ มทีพ่รอ้มใชแ้ทน และมคํีา◌าํวา่ Expert 

แทน คําวา่ Microsoft Excel ในสว่นทีเ่ป็น Title ดา้นบน 

เราสามารถเลอืกใชปุ้่ มไดห้ลายประเภท โดยใชร้หสัตอ่ไปนีแ้ทนลงไปในสว่นของ 

buttons  

 vbOKOnly  

 vbOKCancel  

 vbAbortRetryIgnore  

 vbYesNoCancel  

 vbYesNo  

 vbRetryCancel  

 vbCritical  

 vbQuestion  

 vbExclamation  

 vbInformation   

ในกรณีทีใ่ชปุ้่ มหลายปุ่ ม ใหใ้ชร้หสัตอ่ไปนีบ้วกตอ่ทา้ยรหสัปุ่ ม เพือ่เลอืกใหเ้ป็นปุ่ มที่

พรอ้มใชง้านเมือ่กดปุ่ ม Enter  
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 vbDefaultButton1  

 vbDefaultButton2  

 vbDefaultButton3  

InputBox Function 

InputBox(prompt[, title] [, default]) 

 

ตวัอยา่งการใชง้าน 

 
[Source] = InputBox("Value is : ", "Expert", [Source]) 

 

InputBox แสดงคา่ทีบ่นัทกึไวใ้นเซลล ์Source และเปิดใหบ้นัทกึคา่ใหมแ่ทนคา่เดมิ 

InputBox Method 

นอกจากจะใช ้InputBox แบบทีเ่ป็นสตูรแลว้ ยงัม ีInputBox แบบ Method อกีดว้ย 

ซึง่สามารถใชเ้ลอืกบนัทกึเป็นตวัเลข ตวัอกัษร หรอืสตูร โดยมโีครงสรา้งดงันี ้

InputBox(Prompt, Title, Default,,,,, Type)  

 

ตวัอยา่งการใชง้าน 

 
[Source] = Application.InputBox("Value is : ", "Expert", [Source], , , , , 1) 
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 ตอ้งพมิพคํ์าวา่ Application. นําหนา้ InputBox  

 สงัเกตวา่ ตําแหน่งของปุ่ ม OK Cancel จะวางไวแ้นวนอน  

 คา่ของ Type เพือ่ควบคมุคา่ทีใ่ชใ้นการบนัทกึ  

0 A formula

1 A number

2 Text (a string)

4 A logical value (True or False)

8 
A cell reference, as a Range 

object 

16 An error value, such as #N/A

64 An array of values

 ถา้ตอ้งการใช ้Type 2 อยา่งพรอ้มกนั ใหนํ้าเลข Type มาบวกกนั เชน่ ถา้

ตอ้งการเปิดรับคา่ทีเ่ป็นตัวเลขหรอืตวัอกัษร ใหใ้สเ่ลข 3 (=1+2)  

รหสัอืน่ๆทีเ่ก ีย่วขอ้งกบัสญัญาณเตอืน 

 Application.DisplayAlerts = False  

Workbooks("BOOK1.XLS").Close  

Application.DisplayAlerts = True  

ยกเลกิการเตอืนให ้save changes เมือ่ปิดแฟ้ม 

   

 Application.ScreenUpdating = False 

.... 

Application.ScreenUpdating = True 
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ยกเลกิการปรับภาพทีแ่สดงการทํางานใดๆใหเ้ห็นบนจอ 

   

 Application.StatusBar = "Please be patient..."  

Workbooks.Open filename:="LARGE.XLS"  

Application.StatusBar = False 

ในระหวา่งทีกํ่าลงัเปิดแฟ้ม ใหแ้สดงขอ้ความใหเ้ห็นบน Status Bar 

ดา้นซา้ยลา่งของจอ และเมือ่เปิดแฟ้มเสร็จแลว้ใหล้บขอ้ความออก   
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วธิสี ัง่ให ้VBA ทาํงานทวนซํา้หลายรอบ 

คอมพวิเตอรจ์ะทําหนา้ทีส่มกบัทีเ่ป็นคอมพวิเตอร ์ตอ่เมือ่เราสามารถสัง่ใหค้อมพวิเตอร์

ทํางานเองตัง้แตต่น้จนจบ และสามารถทํางานซํ้าแลว้ซํ้าอกีไดต้ามตอ้งการ โดย

ลกัษณะการทํางานทวนซ้ํา (Looping) นีม้หีลายแบบ ไดแ้ก ่

1. การทวนซํ้าตามจํานวนรอบทีเ่รากําหนด  

2. การทวนซํ้าตามจํานวนขอ้มลู  

3. การทวนซํ้าจนสมบรูณ์ตามเงือ่นไข  

การทวนซํา้ตามจํานวนรอบทีเ่รากาํหนด 

For...Next Statements เป็นรหสัทีใ่ชส้ัง่ใหทํ้างานทวนซํ้าตามจํานวนรอบทีเ่รากําหนด 

โดยมโีครงสรา้งการเขยีนดงันี ้

For counter = start To end [Step step]  

    [statements]  

    [Exit For]  

    [statements]  

Next [counter]  

 counter เป็นตวัแปรทีกํ่าหนดขึน้ สว่นมากจะกําหนดชือ่ตวัแปรเป็น i, j, k  

 start เป็นเลขเริม่ตน้ของรอบแรก  

 end เป็นเลขสดุทา้ยของรอบสดุทา้ย  

 step เป็นชว่งของเลขทีต่อ้งการใหบ้วกเพิม่ใหก้บั counter ในรอบถดัไป 

ถา้ละสว่นของ step ไมกํ่าหนดลงไป จะถอืวา่ step=1  

 statements เป็นรหสัคําสัง่ทีต่อ้งการใหทํ้างานซํ้า  

 Exit For ใชก้บักรณีทีต่อ้งการใชเ้งือ่นไขใหเ้ลกิทํางานวนซํ้า  
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ตวัอยา่ง 

ตอ้งการสัง่พมิพส์ลปิเงนิเดอืนใหก้บัพนักงานทกุคน 

 

For i = 1 To [Total] 

    [Choice] = i 

    ActiveWindow.SelectedSheets.PrintPreview 

    ActiveWindow.SelectedSheets.PrintOut 

Next i 

 Total เป็น Range Name ในตารางทีเ่ก็บรายละเอยีดเงนิเดอืนพนักงาน 

โดยมสีตูร =CountA(ตารางชือ่พนักงานทัง้หมด) เพือ่หายอดจํานวน

พนักงานทัง้หมด  

 For i = 1 To [Total] 

ทําหนา้ทีส่ัง่ใหเ้ริม่ทํางานทวนซํ้า ตัง้แตร่อบที ่1 ถงึ รอบสดุทา้ยเทา่

จํานวนพนักงานทัง้หมด  

 Choice เป็น Range Name ใชสํ้าหรับรับเลขทีพ่นักงาน เพือ่ใชเ้ลขที่

พนักงานนีไ้ปคน้หาขอ้มลูของพนักงานเลขทีนั่น้ๆ นํามาแสดงในใบสลปิ

เงนิเดอืน  

 ในตารางทีเ่ตรยีมไวเ้ป็นแบบสลปิเงนิเดอืน ใหใ้ชส้ตูร Index เพือ่ดงึขอ้มลู

ของพนักงานตามเลขทีแ่สดงไวใ้น Choice เชน่ ถา้ตอ้งการชือ่พนักงานที่
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เก็บไวใ้น column แรก ใหค้น้หาขอ้มลูมาแสดงในสลปิโดยใชส้ตูร 

=Index(MyData,Choice,1)  

 [Choice] = i 

ทําหนา้ทีส่ง่คา่ i ไปทีเ่ซลล ์Choice จงึทําใหส้ตูร Index คํานวณตาม 

แลว้สตูร Index จะดงึขอ้มลูของพนักงานตามเลขทีข่อง i มาแสดงใน

ใบสลปิ ทัง้นีร้ะบบการคํานวณตอ้งเป็น Automatic อยูแ่ลว้ดว้ย (แนะนําให ้

เพิม่รหสัวา่ Calculate ตอ่ทา้ยบรรทดันี ้เพือ่สัง่ใหแ้ฟ้มคํานวณ โดยไม่

ตอ้งหว่งวา่แฟ้มเป็น Automatic หรอืไม)่  

 ActiveWindow.SelectedSheets.PrintPreview 

ActiveWindow.SelectedSheets.PrintOut  

ทําหนา้ทีแ่สดงภาพสลปิบนหนา้จอใหเ้ห็นกอ่น รอใหเ้ราคลกิสัง่ปิด Print 

Preview จากนัน้จงึสัง่ใหพ้มิพส์ลปิโดยอตัโนมตั ิ

(ถา้ตอ้งการใหพ้มิพส์ลปิทนัทโีดยไมต่อ้งหยดุแสดงภาพทีจ่ะพมิพบ์นจอ 

ใหใ้ชร้หสัคําสัง่บรรทดั PrintOut เพยีงบรรทดัเดยีว)  

 Next i 

ทําหนา้ทีส่ัง่ใหว้นกลบัไปเพิม่ i = i+1 เป็นรายการถดัไป ขอแนะนําให ้

เขยีนตวั i ตอ่ทา้ย Next ไวเ้สมอ เพือ่แสดงวา่ Next ตวันีเ้ป็นชดุของ i  

 หากตอ้งการปรับปรงุรหสัใหด้ขี ึน้ แทนทีจ่ะใหเ้ริม่จากเลข 1 ไปจนถงึคน

สดุทา้ยตามคา่ทีส่ง่มาจากตาราง ควรใช ้InputBox กําหนดคา่ i และ 

Total เพือ่จะไดเ้ลอืกสัง่พมิพจ์ากรายการใดก็ได ้และเมือ่พมิพเ์สร็จแลว้ 

ควรยอ้นคา่ใน Choice กลบัเป็นเลขเริม่ตน้เดมิ หรอืเป็นเลข 1 เพือ่แสดง

รายการแรก ดกีวา่ปลอ่ยใหต้ารางแสดงขอ้มลูรายการสดุทา้ยคา้งไว ้ 
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การทวนซํา้ตามจํานวนขอ้มลู 

For Each element In group  

    [statements]  

    [Exit For]  

    [statements] 

Next [element] 

 element เป็นตวัแปรทีเ่รากําหนดใหแ้ทนแตล่ะสว่นของ group โดยจะตัง้

ชือ่ตวัแปรนีเ้ป็นคําวา่อะไรก็ได ้ 

 group เป็นกลุม่ของ Object เชน่ พืน้ทีต่ารางทีม่หีลายเซลล ์หรอืแฟ้มทีม่ี

หลายชที  

ตวัอยา่ง 

ตอ้งการปรับคา่ในตารางทีต่ัง้ชือ่วา่ Source ถา้เซลลใ์ดในตารางนี ้มคีา่นอ้ยกวา่ 0 ให ้

ปรับคา่ใหเ้ป็น 0 

For Each c In [Source] 

    c.Select 

    If c.Value < 0 Then c.Value = 0 

Next c  

c เป็นตวัแปรทีเ่ราตัง้ขึน้เพือ่ใชแ้ทน แตล่ะเซลลใ์นตารางทีม่ชี ือ่วา่ Source  

การทวนซํา้จนสมบรูณ์ตามเงือ่นไข 

โครงสรา้งรหสัซึง่สามารถนํามาใชทํ้างานทวนซํ้าจนเงือ่นไขสมบรูณ์มหีลายแบบ เชน่ 

Do [{While | Until} condition]  
    [statements]  
    [Exit Do]  
    [statements] 
Loop 
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Do  
    [statements]  
    [Exit Do]  
    [statements] 
Loop [{While | Until} condition] 

 

ตวัอยา่ง 

ตอ้งการปรับเพิม่คา่ของเลขทีบ่นัทกึไวใ้น column โดยใหทํ้างานเฉพาะพืน้ทีเ่ซลลท์ีท่ี่

มคีา่บนัทกึไว ้เป็นตารางตดิตอ่กนัไปเริม่จากเซลล ์A1  

Range("A1").Select  

Do Until Selection.Value = ""  

    Selection.Value = Selection.Value + 1  

    Selection.Offset(1, 0).Select  

Loop  

 Do Until Selection.Value = "" 

สัง่ใหท้วนซํ้าไปจนกวา่จะพบวา่เซลลเ์ป็นชอ่งวา่ง  

 Selection.Value = Selection.Value + 1 

ปรับคา่ในเซลลท์ีเ่ลอืกใหม้คีา่เพิม่อกี 1  

 Selection.Offset(1, 0).Select 

เลอืกเซลล ์row ถดัไปขา้งลา่ง ใน column เดมิ  

 ถา้ใช ้Do While Selection.Value <> "" 

สัง่ใหท้วนซํ้าไปเรือ่ยๆ ตราบใดทีเ่ซลลท์ีเ่ลอืกไมเ่ป็นเซลลว์า่ง  

นอกจากนีย้ังมรีหสัแบบ While...Wend แตไ่มแ่นะนําใหใ้ช ้เพราะไมย่ดืหยุน่เทา่ 

Do...Loop  
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วธิ ีExit 

หากตอ้งการออกจากวงจรการทํางานซํ้าใหใ้ชร้หสั If ชว่ยตามแบบตอ่ไปนี ้

 If Selection.Value > 10 Then Exit For  

 If Selection.Value > 10 Then Exit Do  

 If Selection.Value > 10 Then Exit Sub  

หมายเหต ุExit Sub เป็นการสัง่ใหอ้อกจากชดุคําสัง่ทีกํ่าลงัทํางานอยู ่แลว้กลบัไป

ทํางานตามคําสัง่ถดัไปในชดุคําสัง่ทีเ่ป็นตวัสัง่เรยีกชดุคําสัง่อืน่ทํางาน (ถา้ใช ้End จะ

หยดุการทํางานทัง้หมด) 

เมนคูาํส ัง่ใน Excel ซึง่ทํางานทวนซํา้โดยไมต่อ้งใช ้VBA  

ถา้งานใดสามารถใชเ้มนูคําสัง่ของ Excel ไดโ้ดยตรง ควรใชคํ้าสัง่ของ Excel ทีม่อียู่

แลว้ดกีวา่ เพราะนอกจากจะสะดวกกวา่การใช ้VBA แลว้ ยงัทํางานรวดเร็วกวา่มาก 

 F5 > Special 

ใชใ้นการคน้หาเซลลล์กัษณะตา่งๆในตาราง  

 Home > Find and Select 

ใชค้น้หาคา่และเปลีย่นแปลงคา่ในเซลล ์ 

 Data > What-If Analysis > Goal Seek 

ใชคํ้านวณยอ้นกลบั เพือ่หาคา่ตวัแปรใหม ่จนไดผ้ลลพัธต์ามตอ้งการ  

 Data > What-If Analysis > Data Table 

ใชส้ง่คา่ตวัแปรไปคํานวณซํ้า  

 ปุ่ ม F4 

สัง่ให ้Excel ทํางานตามคําสัง่ลา่สดุซํ้าอกีครัง้   
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วธิสีรา้งสตูรเพือ่นํามาใชใ้นงานเฉพาะดา้น 

ลองคดิถงึขอ้เสยีของการสรา้งสตูรยากๆยาวๆลงไปในตาราง ยิง่ตารางสตูรมขีนาดใหญ่

มากขึน้เทา่ใด จะยิง่ทําใหแ้ฟ้มมขีนาดใหญข่ึน้มากเทา่นัน้ แลว้ถา้ตอ่มาตอ้งสรา้งชทีที่

มตีารางสตูรซํ้ากนัอกีหลายๆชที ไมใ่ชแ่คแ่ฟ้มจะใหญข่ึน้เพยีงอยา่งเดยีว แตย่งัทําให ้

จําเป็นตอ้งคอยตดิตามแกไ้ขสตูร ทีพ่มิพไ์วใ้นทกุชทีใหเ้หมอืนตามกนัไปดว้ย 

ถา้ตอ้งการยอ่สตูรยากๆยาวๆใหส้ัน้ลง โดยหาทางใช ้VBA สรา้งสตูรขึน้มาใช ้จะมแีนว

ทางการใชส้ตูรทีส่รา้งดว้ย VBA (Function VBA หรอื User Defined Function - 

UDF) 2 แบบ คอื 

1. สรา้งสตูรเพือ่ใชก้บัแฟ้มใดแฟ้มหนึง่โดยเฉพาะ  

2. สรา้งสตูรเพือ่ใชก้บัแฟ้มใดก็ได ้(Add-in)  

หมายเหต ุแทนทีจ่ะคดิใช ้Function VBA ขอใหพ้ยายามใชส้ตูรสําเร็จรปูของ Excel 

หรอืนําสตูรสําเร็จรปูมาใชคํ้านวณรว่มกนั เพือ่คํานวณหาคําตอบทีต่อ้งการใหไ้ดก้อ่น 

เพราะสตูรสําเร็จรปูจะคํานวณเร็วกวา่มาก  

Function VBA มไิดส้รา้งใน Sub Procedure แตใ่หส้รา้งไวใ้น Function Procedure 

ซึง่มโีครงสรา้งของชดุคําสัง่ทีเ่ป็นสตูร ดงันี ้

Function ชือ่สตูร(ชือ่ตวัแปร1,ชือ่ตวัแปร2,,,,ชือ่ตวัแปรn) 

    รหสัทีใ่ชใ้นการคํานวณ 

End Function  

วธิสีรา้งสตูรเพือ่ใชก้บัแฟ้มใดแฟ้มหนึง่โดยเฉพาะ 

1. ใหเ้ปิด VBE ขึน้มาแลว้ Insert > Module  

2. พมิพคํ์าวา่ function ตามดว้ยชือ่สตูร และวงเล็บของชือ่ตวัแปร  

3. กดปุ่ ม Enter จะพบคําวา่ End Function พมิพเ์ป็นบรรทดัสดุทา้ยใหเ้อง  

4. ใหพ้มิพร์หสัทีต่อ้งการใชคํ้านวณลงไปในบรรทดัระหวา่ง Function...End 

Function  
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ตวัอยา่งที ่1 : สตูรทีจ่ะแสดงสตูรของเซลลท์ีต่อ้งการ 

Function FML(cell)  

    FML = cell.Formula  

End Function 

เมือ่ตอ้งการใชส้ตูรในตาราง เชน่ ตอ้งการแสดงสตูรจากเซลล ์A1 ใหพ้มิพ ์=FML(A1)  

ตวัอยา่งที ่2 : สตูรทีใ่ชต้รวจสอบวา่มสีตูรในเซลลน์ ัน้ๆหรอืไม ่ 

Function HasFML(cell)  

    HasFML = cell.HasFormula  

End Function 

เมือ่ตอ้งการใชส้ตูรในตาราง เชน่ ตอ้งการตรวจสอบวา่เซลล ์A1 มสีตูรสรา้งไวห้รอืไม ่

ใหพ้มิพ ์=HasFML(A1) จะไดคํ้าตอบเป็น True/False 

ตวัอยา่งที ่3 : สตูรหายอดรวมเฉพาะเซลลท์ีเ่ป็นตวั Bold 

Function BoldSum(rngCells)  

    BoldSum = 0  

    For Each c In rngCells  

       If c.Font.Bold Then BoldSum = BoldSum + c.Value  

    Next c  

End Function  

เมือ่ตอ้งการหายอดรวมของตวัเลขในตาราง A1:B10 โดยใหร้วมเลขจากเซลลท์ีใ่ชต้วั

เขม้หนาเทา่นัน้ ใหส้รา้งสตูร =BoldSum(A1:B10)*Now()/Now() 

สาเหตทุีต่อ้งนํา Now()/Now() คณูเขา้ไป เพือ่ทําใหส้ตูรนีคํ้านวณใหมท่กุครัง้เมือ่เรา

กดปุ่ ม F9  
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วธิสีรา้งสตูรเพือ่ใชก้บัแฟ้มใดก็ได ้(Add-in) 

Add-in มไิดม้รีหสัอืน่ใดทีแ่ตกตา่งจากตวัอยา่งขา้งตน้ เพยีงแคส่ัง่ save แฟ้มโดย

เลอืก Save as type เป็น Microsoft Office Excel Add-In (*.xla) จะไดแ้ฟ้มใหมใ่น

ชือ่เดยีวกบัแฟ้มเดมิ โดยแฟ้มใหมท่ีเ่กดิขึน้นีม้นีามสกลุ xla 

กอ่นทีจ่ะ save เป็น xla ควรปรับปรงุแฟ้มในสว่นตอ่ไปนี ้ 

 เนือ่งจากแฟ้ม xla ทีจ่ะนํามาใชง้านตอ่ไปนัน้ ใชเ้ป็นแฟ้มทีนํ่าสตูร 

Function VBA ทีเ่ราสรา้งขึน้มาใชง้าน โดยไมไ่ดใ้ชเ้นือ้ทีช่ทีแสดงขึน้บน

จอ ดงันัน้เพือ่ทําใหป้ระหยดัหน่วยความจํา ควรลบชทีทิง้ใหห้มดจนเหลอื

เพยีงชทีเดยีว เพือ่ทําใหแ้ฟ้ม xla มขีนาดเล็กทีส่ดุเทา่ทีจ่ะทําได ้ 

 ควรทําคําอธบิายประกอบสตูรแตล่ะสตูร โดยสัง่ Developer > Macros  

ซึง่จะไมพ่บชือ่ Macro ทีเ่ป็น Function VBA แสดงไว ้ใหพ้มิพช์ือ่สตูร

ตามทีต่ัง้ชือ่ไวล้งไปในชอ่ง Macro name จะพบวา่ปุ่ ม Options แสดงขึน้ 

ใหค้ลกิเขา้ไปแลว้พมิพคํ์าอธบิายสตูรลงในชอ่ง Description (คําอธบิาย

สตูรนีจ้ะแสดงประกอบตวัสตูร เมือ่ใชคํ้าสัง่ Formulas > Insert Function 

จะพบสตูรแสดงไวใ้นสว่นของ User Defined)  

 ควรใชต้ารางในชทีเดยีวทีเ่หลอือยู ่สรา้งตวัอยา่งวธิกีารใชส้ตูร และบนัทกึ

ชือ่ผูส้รา้งไวด้ว้ย แลว้สัง่ Protect Sheet  

 ควรใชคํ้าสัง่ File > Info > Properties บนัทกึรายละเอยีดโดยยอ่สัน้ๆ

ของแฟ้มสตูรลงในชอ่ง Title และบนัทกึรายละเอยีดเพิม่เตมิ โดยเฉพาะ

ขอ้มลูเรือ่งลขิสทิธิ ์ลงในชอ่ง Comments (เมือ่นํา Add-in มาใชง้าน จะ

พบขอ้ความทีบ่นัทกึใน Properties นีแ้สดงใหเ้ห็นในชอ่ง Add-Ins 

Available แทนทีจ่ะแสดงแคช่ือ่แฟ้มใหเ้ห็นเทา่นัน้)  

 ควรสัง่ Protect Workbook เพือ่ป้องกนัไมใ่หแ้กไ้ข Properties ที่

บนัทกึรายละเอยีดไว ้ 

 ในสว่นของรหสัทีส่รา้งไวใ้น VBE ควรสัง่ Tools > VBAProject 

Properties > Protection แลว้กาชอ่ง Lock project for 
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viewing (เพือ่กนัไมใ่หเ้ห็นโครงสรา้งภายในแฟ้มวา่มชีทีอยา่งไร) และ

ใสร่หสัป้องกนัไวด้ว้ย  

วธิตีดิต ัง้และขอ้ควรระวงัในการใช ้Add-in 

1. copy แฟ้ม Add-in ทีต่อ้งการไปเก็บไวใ้น folder ใดก็ได ้ 

2. เปิด Excel แลว้สัง่ Developer > Add-ins > Browse หาแฟ้ม xla ทีเ่ก็บ

ไว ้จะพบวา่มชีือ่ Add-in ทีต่อ้งการถกูกาเครือ่งหมายถกูไว ้ 

3. เปิดแฟ้มทีม่สีตูร Add-in สรา้งไว ้จะพบวา่สตูรทํางานตามตอ้งการ (แตถ่า้

เปิดแฟ้มไวก้อ่นทีจ่ะ Browse ในขอ้ 2 จะพบวา่สตูร error ตอ้งเขา้ไปกด 

F2 ทีเ่ซลลส์ตูรแลว้กด Enter เพือ่กระตุน้ใหส้ตูรทํางาน)  

ถา้ในแฟ้ม ไมไ่ดใ้ชส้ตูร Add-in ควรเลกิใช ้Add-in เพือ่ทําใหไ้มเ่ปลอืงหน่วยความจํา 

โดยสัง่ Developer > Add-ins > ตดักาเครือ่งหมายถกูทิง้ ตอ่เมือ่ตอ้งการใช ้

Add-in จงึกลบัมากาถกูดา้นหนา้เฉพาะ Add-in ทีต่อ้งการใชง้าน  

ถา้จําโครงสรา้งสตูรไมไ่ด ้ใหด้ไูดจ้าก Insert Function แลว้เลอืกสตูรแบบ User 

defined พอคลกิชือ่สตูรจะพบคําอธบิายแสดงไวด้า้นลา่งสดุ  
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รหสั VBA ทีน่า่สนใจจาก www.Excel-VBA.com 

Calculation 

Application.Calculation = xlManual 

ปรับระบบการคํานวณเป็น Manual เพือ่หยดุการคํานวณชัว่คราว  

Application.Calculation = xlAutomatic 

ปรับระบบการคํานวณเป็น Automatic  

Activesheet.Calculate 

สัง่คํานวณเฉพาะชทีทีกํ่าลงัใชง้านอยู ่ 

CutCopyMode  

Application.CutCopyMode=False  

ลา้งหน่วยความจําใน clipboard เพือ่ลดภาระของเครือ่ง  

GoTo  

Application.Goto Reference:=Range("V300")  

หรอื  

Range("V300").Select  

หรอื 

Application.Goto Reference:=Range("V300"), Scroll=True 

เพือ่ทําใหเ้ซลลท์ีถ่กูเลอืกเป็นเซลลแ์รกซา้ยบนสดุของจอ  

Quit : ปิดโปรแกรม Excel  

Application.Quit  
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ScreenUpdating  

Application.ScreenUpdating = False  

Application.ScreenUpdating = True 

ควบคมุไมใ่หร้หสัทีอ่ยูร่ะหวา่งคําสัง่ 2 บรรทดันี ้แสดงการเปลีย่นแปลงใดๆใหเ้ห็นบน

หนา้จอ  

Workbook 

Workbooks.Open "suchAndSuch.xls" 

เปิดแฟ้มชือ่ suchAndSuch.xls  

Workbooks.Open Sheets("sheet1").Range("A1").Value 

เปิดแฟ้มทีม่ชี ือ่ตามทีบ่นัทกึชือ่ไวใ้นเซลล ์A1 ของ Sheet1  

ThisWorkbook.Close  

ปิดแฟ้มทีเ่ก็บรหสัทีทํ่างานนี ้ 

ThisWorkbook.Saved = True 

ThisWorkbook.Close  

ปิดแฟ้มทีเ่ก็บรหสัทีทํ่างานนีโ้ดยไมต่อ้ง save  

ActiveWorkbook.Close 

ปิดแฟ้มทีกํ่าลงัใชง้านนี ้ 

ActiveWorkbook.Saved = True  

ActiveWorkbook.Close  

ปิดแฟ้มทีกํ่าลงัใชง้านนีโ้ดยไมต่อ้ง save  

Workbooks("Book1.xls").Close 

ปิดแฟ้มชือ่ Book1.xls  
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Workbooks(Range("A1").Value).Close 

ปิดแฟ้มชือ่ตามทีร่ะบไุวใ้นเซลล ์A1  

ActiveWorkbook.Save 

save แฟ้มทีกํ่าลงัใชง้าน  

Workbooks("Book1.xls").Save 

save แฟ้มชือ่ Book1.xls  

Workbooks(Range("A1").Value).Save  

save แฟ้มทีม่ชี ือ่ตามทีร่ะบไุวใ้นเซลล ์A1  

ActiveWorkbook.SaveAs "C:/suchAndSuch.xls" 

save แฟ้มทีกํ่าลงัใชง้านตามชือ่และสถานทีเ่ก็บตามตอ้งการ  

Workbooks("Book1.xls").SaveAs "C:/suchAndSuch.xls"  

save แฟ้มชือ่ Book1.xls ตามชือ่และสถานทีเ่ก็บตามตอ้งการ  

Kill "C:\myFile.xls" 

ลบแฟ้มชือ่ myfile.xls ทีเ่ก็บอยูใ่น Drive C  

Worksheet 

Sheets("Sheet1").Visible= xlVeryHidden 

hide ชทีแรกแบบพเิศษ เพือ่ทําใหห้าจากเมนู Format > Sheet ไมพ่บ  

Sheets(Array("Sheet1", "Sheet2")).Select 

เลอืกชทีหลายชทีตามชือ่ทีกํ่าหนดพรอ้มกนั  

ActiveWindow.SelectedSheets.Visible = False 

ซอ่นชทีทีเ่ลอืกไวท้ัง้หมดพรอ้มกนั  

Sheets("Balance").Delete 

ลบชทีชือ่ Balance  



110 / 122 

 

 

 

www.ExcelExpertTraining.com 
© พ.ศ. 2558 โดย สมเกยีรต ิฟุ้ งเกยีรต ิ

Sheets.Add 

insert ชที 1 ชที  

Sheets.Add before:=Sheets("Balance") 

insert ชที 1 ชที ไวก้อ่นชทีชือ่ Balance  

Sheets.Add after:=Sheets(1)  

insert ชที 1 ชที ไวห้ลงัชทีแรก  

Sheets.Add After:=Sheets(Sheets.Count) 

insert ชที 1 ชที ไวห้ลงัชทีสดุทา้ย  

Cell และ Range 

Cells.Select 

เลอืกทกุเซลลใ์นตาราง  

Selection.CurrentRegion.Select 

เลอืกพืน้ทีต่ารางทีต่ดิตอ่กนักบัเซลลท์ีเ่ลอืกอยู ่ 

Activecell.Row 

Activecell.Column 

คนืคา่เป็นเลขทีข่อง row/column ของเซลลท์ีใ่ชง้านอยู ่ 

Selection.Rows.Count 

Selection.Columns.Count 

คนืคา่เป็นจํานวน row/column ของตารางทีเ่ลอืก  

Selection.CurrentRegion.Rows.Count  

คนืคา่เป็นจํานวน row ของพืน้ทีต่ารางทีต่ดิตอ่กนักบัเซลลท์ีเ่ลอืกอยู ่ 

Range("A1:A8").Formula = "=C8+C9" 

สรา้งสตูร =C8+C9, =C9+C10 และตอ่ไป ลงไปในเซลล ์A1:A8  
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Range("A1:A8").Formula = "=$C$8+$C$9" 

สรา้งสตูร =$C$8+$C$9 ลงไปในทกุเซลลข์อง A1:A8  

Range("A8:G8").Select  

เลอืกพืน้ทีต่าราง A8:G8 โดย A8 เป็นเซลลเ์ดยีวที ่active  
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รหสั VBA ทีน่า่สนใจจาก www.MindSpring.com 

http://www.mindspring.com/~tflynn/excelvba.html  

Selecting 

Sub SelectDown() 

    Range(ActiveCell, ActiveCell.End(xlDown)).Select 

End Sub 

 

Sub Select_from_ActiveCell_to_Last_Cell_in_Column() 

    Dim topCel As Range 

    Dim bottomCel As Range 

    On Error GoTo errorHandler 

    Set topCel = ActiveCell 

    Set bottomCel = Cells((65536), topCel.Column).End(xlUp) 

       If bottomCel.Row >= topCel.Row Then 

           Range(topCel, bottomCel).Select 

       End If 

    Exit Sub 

    errorHandler: 

    MsgBox "Error no. " & Err & " - " & Error 

End Sub 

 

Sub SelectUp() 

    Range(ActiveCell, ActiveCell.End(xlUp)).Select 

End Sub 

 

Sub SelectToRight() 

    Range(ActiveCell, ActiveCell.End(xlToRight)).Select 

End Sub 

 

Sub SelectToLeft() 

    Range(ActiveCell, ActiveCell.End(xlToLeft)).Select 

End Sub 
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Sub SelectCurrentRegion() 

    ActiveCell.CurrentRegion.Select 

End Sub 

 

Sub SelectActiveArea() 

    Range(Range("A1"), ActiveCell.SpecialCells(xlLastCell)).Select 

End Sub 

 

Sub SelectActiveColumn() 

    If IsEmpty(ActiveCell) Then Exit Sub 

    On Error Resume Next 

    If IsEmpty(ActiveCell.Offset(-1, 0)) Then Set TopCell = _ 

       ActiveCell Else Set TopCell = ActiveCell.End(xlUp) 

    If IsEmpty(ActiveCell.Offset(1, 0)) Then Set BottomCell = _ 

       ActiveCell Else Set BottomCell = ActiveCell.End(xlDown) 

    Range(TopCell, BottomCell).Select 

End Sub 

 

Sub SelectActiveRow() 

    If IsEmpty(ActiveCell) Then Exit Sub 

    On Error Resume Next 

    If IsEmpty(ActiveCell.Offset(0, -1)) Then Set LeftCell = _ 

       ActiveCell Else Set LeftCell = ActiveCell.End(xlToLeft) 

    If IsEmpty(ActiveCell.Offset(0, 1)) Then Set RightCell = _ 

       ActiveCell Else Set RightCell = ActiveCell.End(xlToRight) 

    Range(LeftCell, RightCell).Select 

End Sub 

 

Sub SelectEntireColumn() 

    Selection.EntireColumn.Select 

End Sub 

 

Sub SelectEntireRow() 

    Selection.EntireRow.Select 
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End Sub 

 

Sub SelectEntireSheet() 

    Cells.Select 

End Sub 

 

Sub ActivateNextBlankDown() 

    ActiveCell.Offset(1, 0).Select 

    Do While Not IsEmpty(ActiveCell) 

        ActiveCell.Offset(1, 0).Select 

    Loop 

End Sub 

 

Sub ActivateNextBlankToRight() 

    ActiveCell.Offset(0, 1).Select 

    Do While Not IsEmpty(ActiveCell) 

        ActiveCell.Offset(0, 1).Select 

    Loop 

End Sub 

 

Sub SelectFirstToLastInRow() 

    Set LeftCell = Cells(ActiveCell.Row, 1) 

    Set RightCell = Cells(ActiveCell.Row, 256) 

    If IsEmpty(LeftCell) Then _ 

        Set LeftCell = LeftCell.End(xlToRight) 

    If IsEmpty(RightCell) Then _ 

        Set RightCell = RightCell.End(xlToLeft) 

    If LeftCell.Column = 256 And RightCell.Column = 1 Then _ 

        ActiveCell.Select Else Range(LeftCell, RightCell).Select 

End Sub 

 

Sub SelectFirstToLastInColumn() 

    Set TopCell = Cells(1, ActiveCell.Column) 

    Set BottomCell = Cells(16384, ActiveCell.Column) 

    If IsEmpty(TopCell) Then Set TopCell = TopCell.End(xlDown) 
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    If IsEmpty(BottomCell) Then _ 

         Set BottomCell = BottomCell.End(xlUp) 

    If TopCell.Row = 16384 And BottomCell.Row = 1 Then _ 

         ActiveCell.Select Else Range(TopCell, BottomCell).Select 

End Sub 

 

Sub SelCurRegCopy() 

    Selection.CurrentRegion.Select 

    Selection.Copy 

    Range("A17").Select ' Substitute your range here 

    ActiveSheet.Paste 

    Application.CutCopyMode = False 

End Sub 

Check Values 

Sub ResetValuesToZero2() 

    For Each n In Worksheets("Sheet1").Range("WorkArea1")     

        If n.Value <> 0 Then 

            n.Value = 0 

        End If 

    Next n 

End Sub 

 

Sub ResetTest1() 

    For Each n In Range("B1:G13") 

        If n.Value <> 0 Then 

            n.Value = 0 

        End If 

    Next n 

End Sub 

 

Sub ResetTest2() 

    For Each n In Range("A16:G28") 

        If IsNumeric(n) Then 
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            n.Value = 0 

        End If 

    Next n 

End Sub 

 

Sub ResetTest3() 

    For Each amount In Range("I1:I13")  

        If amount.Value <> 0 Then 

            amount.Value = 0 

        End If 

    Next amount 

End Sub 

 

Sub ResetTest4() 

    For Each n In ActiveSheet.UsedRange 

        If n.Value <> 0 Then 

            n.Value = 0 

        End If 

    Next n 

End Sub 

 

Sub ResetValues() 

    On Error GoTo ErrorHandler 

    For Each n In ActiveSheet.UsedRange 

        If n.Value <> 0 Then 

            n.Value = 0 

        End If 

TypeMismatch: 

    Next n 

ErrorHandler: 

    If Err = 13 Then        'Type Mismatch 

        Resume TypeMismatch 

    End If 

End Sub 
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Sub ResetValues2() 

    For i = 1 To Worksheets.Count 

    On Error GoTo ErrorHandler 

        For Each n In Worksheets(i).UsedRange 

            If IsNumeric(n) Then 

                If n.Value <> 0 Then 

                     n.Value = 0 

ProtectedCell: 

                End If 

            End If 

        Next n 

ErrorHandler: 

        If Err = 1005 Then 

             Resume ProtectedCell 

        End If 

    Next i 

End Sub 

On Entry 

Sub Auto_Open() 

   ActiveSheet.OnEntry = "Action" 

End Sub 

 

Sub Action() 

   If IsNumeric(ActiveCell) Then 

     ActiveCell.Font.Bold = ActiveCell.Value >= 500 

   End If 

End Sub 

 

Sub Auto_Close() 

   ActiveSheet.OnEntry = "" 

End Sub 
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Looping 

'You might want to step through this using the "Watch" feature 

Sub Accumulate() 

Dim n As Integer 

Dim t As Integer 

    For n = 1 To 10 

        t = t + n 

    Next n 

    MsgBox "        The total is " & t 

End Sub 

 

'This sub checks values in a range 10 rows by 5 columns 

'moving left to right, top to bottom----- 

Sub CheckValues1() 

Dim rwIndex As Integer 

Dim colIndex As Integer 

    For rwIndex = 1 To 10 

            For colIndex = 1 To 5 

                If Cells(rwIndex, colIndex).Value <> 0 Then _ 

                    Cells(rwIndex, colIndex).Value = 0 

            Next colIndex 

    Next rwIndex 

End Sub 

 

'Same as above using the "With" statement instead of "If" 

Sub CheckValues2() 

Dim rwIndex As Integer 

Dim colIndex As Integer 

    For rwIndex = 1 To 10 

         For colIndex = 1 To 5 

             With Cells(rwIndex, colIndex) 

                 If Not (.Value = 0) Then _ 

                   Cells(rwIndex, colIndex).Value = 0 

             End With 
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         Next colIndex 

    Next rwIndex 

End Sub 

 

'Same as CheckValues1 except moving top to bottom, left to right 

Sub CheckValues3() 

Dim colIndex As Integer 

Dim rwIndex As Integer 

    For colIndex = 1 To 5 

            For rwIndex = 1 To 10 

                If Cells(rwIndex, colIndex).Value <> 0 Then _ 

                    Cells(rwIndex, colIndex).Value = 0 

            Next rwIndex 

    Next colIndex 

End Sub 

 

'Enters a value in 10 cells in a column and then sums the values 

Sub EnterInfo() 

Dim i As Integer 

Dim cel As Range 

Set cel = ActiveCell 

    For i = 1 To 10 

        cel(i).Value = 100 

    Next i 

cel(i).Value = "=SUM(R[-10]C:R[-1]C)" 

End Sub 

 

' Loop through all worksheets in workbook and reset values 

' in a specific range on each sheet. 

Sub Reset_Values_All_WSheets() 

Dim wSht As Worksheet 

Dim myRng As Range 

Dim allwShts As Sheets 

Dim cel As Range 

Set allwShts = Worksheets 
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For Each wSht In allwShts 

Set myRng = wSht.Range("A1:A5, B6:B10, C1:C5, D4:D10") 

    For Each cel In myRng 

        If Not cel.HasFormula And cel.Value <> 0 Then 

            cel.Value = 0 

        End If 

    Next cel 

Next wSht 

End Sub 

Test Values 

' Tests the value in each cell of a column and if it is greater 

' than a given number, places it in another column.  This is just 

' an example so the source range, target range and test value may 

' be adjusted to fit different requirements. 

Sub Test_Values() 

Dim topCel As Range, bottomCel As Range, _ 

    sourceRange As Range, targetRange As Range 

Dim x As Integer, i As Integer, numofRows As Integer 

Set topCel = Range("A2") 

Set bottomCel = Range("A65536").End(xlUp) 

If topCel.Row > bottomCel.Row Then End      

' test if source range is empty 

Set sourceRange = Range(topCel, bottomCel) 

Set targetRange = Range("D2") 

numofRows = sourceRange.Rows.Count 

x = 1 

For i = 1 To numofRows 

    If Application.IsNumber(sourceRange(i)) Then 

        If sourceRange(i) > 1300000 Then 

            targetRange(x) = sourceRange(i) 

            x = x + 1 

        End If 

    End If 
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Next 

End Sub 
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วธิปีรบั Excel ใหพ้รอ้มตอ่การใช ้VBA 

การจดัเตรยีมท ัว่ไป 

1. ปรับใหใ้ชง้านแฟ้มทีม่รีหสั VBA ได ้โดยสัง่ File > Excel Options > Trust 

Center > Trust Center Settings > Macro Settings > กาชอ่ง Disable all 

macro with notifications (เป็น Default ของ Excel 2007/2010) 

2. ตอนเปิดแฟ้มจะมคํีาถามขึน้มาบนหนา้จอ ใหเ้ลอืก Enable Macros (ถา้ไมไ่วใ้จ

แฟ้มนัน้ ใหเ้ลอืก Disable Macros) 

3. Excel 2007/2010 สามารถกําหนด Trust Locations เพือ่ระบชุือ่ Folder ทีเ่ก็บ

แฟ้มทีต่อ้งการให ้Enable Macro เองทนัทเีมือ่เปิดแฟ้ม 

4. Excel 2010 สามารถกําหนด Trust Document เพือ่สัง่ให ้Excel จดจําวา่แฟ้มที่

เคยเปิดนัน้ถกูสัง่ใหใ้ช ้Macro อยา่งไร 

5. อยา่ลมื Save แฟ้มทีม่รีหสั VBA เป็นนามสกลุ xlsm 

 

การเตรยีมพรอ้มสาํหรบัใช ้VBA 

 

Excel 2007 สัง่ Office Button > Excel Options > Popular > กาชอ่ง Show 

Developer tab in the Ribbon 

 

Excel 2010 สัง่ File > Options > Customize Ribbon > กา Developer ทีแ่สดง

ในรายชือ่ในจอดา้นขวา 

 

 

การปรบัระบบแสดงผลภาษาไทยใน Visual Basic Editor (VBE) 

 

ใหก้ดปุ่ ม ALT+F11 เพือ่เปิด VBE ขึน้มา แลว้สัง่ Tools > Options > Editor Format 

แลว้เลอืก Font ภาษาไทย 

 


